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To reduce the risk of fire or 
electric shock, do not 
expose this apparatus to 
rain or moisture.

To avoid electrical shock, 
do not open the cabinet.
Refer servicing to qualified 
personnel only.

Important Safety Instructions
• Read these instructions.

• Keep these instructions.

• Heed all warnings.

• Follow all instructions.

• Do not use this apparatus near water.

• Clean only with dry cloth.

• Do not block any ventilation openings. 

Install in accordance with the 

manufacturer’s instructions.

• Do not install near any heat sources such 

as radiators, heat registers, stoves, or 

other apparatus (including amplifiers) that 

produce heat.

• Do not defeat the safety purpose of the 

polarized or grounding-type plug. A 

polarized plug has two blades with one 

wider than the other. A grounding-type 

plug has two blades and a third grounding 

prong. The wide blade or the third prong 

are provided for your safety. If the 

provided plug does not fit into your outlet, 

consult an electrician for replacement of 

the obsolete outlet.

• Protect the power cord from being walked 

on or pinched particularly at plugs, 

convenience receptacles, and the point 

where they exit from the apparatus.

• Only use attachments/accessories 

specified by the manufacturer.

• Refer all servicing to qualified service 

personnel. Servicing is required when the 

apparatus has been damaged in any way, 

such as power-supply cord or plug is 

damaged, liquid has been spilled or 

objects have fallen into the apparatus, the 

apparatus has been exposed to rain or 

moisture, does not operate normally, or 

has been dropped.

WARNING
Excessive sound pressure from earphones 

and headphones can cause hearing loss.

In order to use this product safely, avoid 

prolonged listening at excessive sound 

pressure levels.

For the customers in the U.S.A.
This equipment has been tested and found 

to comply with the limits for a Class A digital 

device, pursuant to Part 15 of the FCC 

Rules. These limits are designed to provide 

reasonable protection against harmful 

interference when the equipment is operated 

in a commercial environment. This 

equipment generates, uses, and can radiate 

radio frequency energy and, if not installed 

and used in accordance with the instruction 

manual, may cause harmful interference to 

radio communications. Operation of this 

equipment in a residential area is likely to 

cause harmful interference in which case the 

user will be required to correct the 

interference at his own expense.

You are cautioned that any changes or 

modifications not expressly approved in this 

manual could void your authority to operate 

this equipment.

All interface cables used to connect 

peripherals must be shielded in order to 

comply with the limits for a digital device 

pursuant to Subpart B of Part 15 of FCC 

Rules.

This device complies with Part 15 of the FCC 

Rules. Operation is subject to the following 

two conditions: (1) this device may not cause 

harmful interference, and (2) this device 

must accept any interference received, 

including interference that may cause 

undesired operation.

WARNING
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For the customers in Canada
This Class A digital apparatus complies with 

Canadian ICES-003.

For the customers in Europe
This product with the CE marking complies 

with the EMC Directive issued by the 

Commission of the European Community.

Compliance with this directive implies 

conformity to the following European 

standards:

• EN55103-1: Electromagnetic 

Interference(Emission)

• EN55103-2: Electromagnetic 

Susceptibility(Immunity)

This product is intended for use in the 

following Electromagnetic Environments: E1 

(residential), E2 (commercial and light 

industrial), E3 (urban outdoors), E4 

(controlled EMC environment, ex. TV 

studio).

The manufacturer of this product is Sony 

Corporation, 1-7-1 Konan, Minato-ku, 

Tokyo, Japan.

The Authorized Representative for EMC and 

product safety is Sony Deutschland GmbH, 

Hedelfinger Strasse 61, 70327 Stuttgart, 

Germany.

For the State of California, USA only
Perchlorate Material - special handling may 

apply, See

www.dtsc.ca.gov/hazardouswaste/

perchlorate

Perchlorate Material : Lithium battery 

contains perchlorate.

For the customers in Taiwan only

Afin de réduire les risques 
d’incendie ou 
d’électrocution, ne pas 
exposer cet appareil à la 
pluie ou à l’humidité.

Afin d’écarter tout risque 
d’électrocution, garder le 
coffret fermé. Ne confier 
l’entretien de l’appareil 
qu’à un personnel qualifié.

AVERTISSEMENT
Une pression acoustique excessive en 

provenance des écouteurs ou du casque 

peut provoquer une baisse de l’acuité 

auditive.

Pour utiliser ce produit en toute sécurité, 

évitez l’écoute prolongée à des pressions 

sonores excessi

Pour les clients au Canada
Cet appareil numérique de la classe A est 

conforme à la norme NMB-003 du Canada.

Pour les clients en Europe
Ce produit portant la marque CE est 

conforme à la Directive sur la compatibilité 

électromagnétique (EMC) émise par la 

Commission de la Communauté 

européenne.

La conformité à cette directive implique la 

conformité aux normes européennes 

suivantes :

• EN55103-1 : Interférences 

électromagnétiques (émission)

• EN55103-2 : Sensibilité 

électromagnétique (immunité)

Ce produit est prévu pour être utilisé dans 

les environnements électromagnétiques 

suivants : E1 (résidentiel), E2 (commercial et 

industrie légère), E3 (urbain extérieur) et E4 

(environnement EMC contrôlé, ex. studio de 

télévision).

AVERTISSEMENT
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Le fabricant de ce produit est Sony 

Corporation, 1-7-1 Konan, Minato-ku, 

Tokyo, Japon.

Le représentant autorisé pour EMC et la 

sécurité des produits est Sony Deutschland 

GmbH, Hedelfinger Strasse 61, 70327 

Stuttgart, Allemagne.

Um die Gefahr von Bränden 
oder elektrischen Schlägen 
zu verringern, darf dieses 
Gerät nicht Regen oder 
Feuchtigkeit ausgesetzt 
werden.

Um einen elektrischen 
Schlag zu vermeiden, darf 
das Gehäuse nicht geöffnet 
werden. Überlassen Sie 
Wartungsarbeiten stets nur 
qualifiziertem 
Fachpersonal.

WARNUNG
Zu hoher Schalldruck von Ohrhörern und 

Kopfhörern kann Gehörschäden 

verursachen.

Um dieses Produkt sicher zu verwenden, 

vermeiden Sie längeres Hören bei sehr 

hohen Schalldruckpegeln.

Für Kunden in Europa
Dieses Produkt besitzt die CE-

Kennzeichnung und erfüllt die EMV-

Richtlinie der EG-Kommission.

Angewandte Normen:

• EN55103-1: Elektromagnetische 

Verträglichkeit (Störaussendung)

• EN55103-2: Elektromagnetische 

Verträglichkeit (Störfestigkeit)

Für die folgenden elektromagnetischen 

Umgebungen: E1 (Wohnbereich), E2 

(kommerzieller und in beschränktem Maße 

industrieller Bereich), E3 (Stadtbereich im 

Freien) und E4 (kontrollierter EMV-Bereich, 

z.B. Fernsehstudio).

Der Hersteller dieses Produkts ist Sony 

Corporation, 1-7-1 Konan, Minato-ku, 

Tokyo, Japan.

Der autorisierte Repräsentant für EMV und 

Produktsicherheit ist Sony Deutschland 

GmbH, Hedelfinger Strasse 61, 70327 

Stuttgart, Deutschland.WARNUNG
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After purchasing the PMW-350K/350L Solid-

State Memory Camcorder, before operating, it is 

necessary to set the area of use.

(Unless this setting is made, the camcorder will 

not operate.)

For details of these settings, see “Setting the Area of 

Use” (page 40).

Note

Before attaching/removing optional components or 

accessories to/from the PMW-350K/350L (referred to as 

“the camcorder”), be sure to turn the power of the 

camcorder off.

Foreword

Before Use
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2/3-type full-HD (1920 × 1080) CMOS 
image sensors

The PMW-350K/350L Solid-State Memory 

Camcorder is provided with three newly 

developed 2/3-type “Exmor” CMOS image 

sensors with approximately 207 million effective 

pixels, for full HD resolution (1920 × 1080). The 

new image sensor technology enables the capture 

of very high-quality images, with a sensitivity of 

F12 (59.94i) / F13 (50i) and an SN ratio of 59 dB.

S×S memory cards as recording media

Using S×S memory cards, the camcorder offers 

nonlinear capabilities such as instant random 

access and file-based operation.

Light weight, low power consumption

Design features such as CMOS image sensors, 

custom video signal processing ICs, and S×S 

memory card recording enable fanless operation 

and power consumption of 15 W or less. The 

camcorder’s light weight (3.2 kg (7 lb 0.88 oz)) 

and low center of gravity make it easy to carry on 

the shoulder while ensuring superior stability.

HD recording using the “MPEG-2 Long 
GOP” codec

The camcorder records 1920 × 1080, 1440 × 

1080, and 1280 × 720 HD images using “MPEG-

2 Long GOP” codec compression. It offers a 

choice of bit rates: either 35 Mbps (HQ mode) or 

25 Mbps (SP mode).

By utilizing an efficient compression format, the 

camcorder records high-quality HD images for 

long recording time of approx. 100 minutes at 35 

Mbps (HQ mode) or approx. 140 minutes at 25 

Mbps (SP mode) on a single 32-GB S×S memory 

card.

Multi-format support

The camcorder supports interlace format 

recording (1080/59.94i or 1080/50i), progressive 

format recording (1080/29.97P, 1080/23.98P, 

720/59.94P, 720/29.97P, 720/23.98P, or 1080/

25P, 720/50P, 720/25P), thus offering the 

flexibility needed for worldwide HD recording. 

(For 23.98P, native frequency recording is 

possible.)

It also supports recording and playback of SD 

signals (both NTSC and PAL). The camcorder 

has an optional capability to record and play back 

SD signals in DVCAM-AVI format (option 1)), 

and can output HD signals down-converted to 

SD.

1) CBK-DV01

A special auto focus lens

The camcorder is provided with the 2/3-type auto 

focus lens, which ensures high-quality shooting 

in all situations from wide angle to telephoto 

(PMW-350K only).

A variety of functions for improved 
performance under various shooting 
conditions

• Picture Cache function

• Optical ND filters and electrical CC filters

• Hyper gamma

• Slow shutter function

• Frame Recording function

• Time lapse function (interval recording)

• Slow & quick motion function

• Freeze mix function

• Focus magnification function

• Image inversion function

• Assignable switches

• 3.5-inch high-resolutin color LCD viewfinder

• Remote control

Chapter1 Overview

Features
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Inherits unique features of XDCAM EX 
series

The camcorder inherits the workflow features of 

the XDCAM EX series, including thumbnail 

display and metadata management, and improves 

them by introducing an improved man-machine 

interface.

XDCAM EX web sites

For information on XDCAM EX, visit the 

following web sites:

United States

http://www.sony.com/xdcamex

Canada

http://www.sony.ca/xdcamex

Europe, Middle East, Africa, and Russia

http://www.sonybiz.net/xdcamex

Latin America

http://www.sonypro-latin.com/xdcamex

Australia

http://www.sony.com.au/xdcamex

Asia (except Korea, China, and Japan)

http://pro.sony-asia.com

Korea

http://bp.sony.co.kr/xdcamex

China

http://pro.sony.com.cn/minisite/XDCAMEX

Japan

http://www.sony.co.jp/XDCAMEX

Two CD-ROMs are supplied with the camcorder.

The CD-ROM labeled “Manuals for Solid-State 

Memory Camcorder” contains the PDF files of 

the Operating Instructions and Supplement for 

the camcorder (Japanese, English, French, 

German, Italian, Spanish and Chinese).

The CD-ROM labeled “Utility Software for 

Solid-State Memory Camcorder and Recorder” 

contains the following software:

S×S Device Driver Software

Driver for using S×S memory cards with a 

computer having an ExpressCard slot.

Information on installation of the software is 

included in the ReadMe (Japanese, English, 

French, German, Italian, Spanish, and Chinese) in 

PDF format.

XDCAM EX Clip Browsing Software

Application program for operating clips recorded 

with XDCAM EX-series models on a computer.

Information on installation and operations of the 

software is included in the User’s Guide 

(Japanese, English, French, German, Italian, 

Spanish, and Chinese) in PDF format.

Preparations

The following program must be installed on your 

computer in order to read the operation manuals 

contained on the CD-ROM.

Adobe Reader Version 6.0 or higher

Memo

If Adobe Reader is not installed, you can download it 

from the following URL: 

http://www.adobe.com/

Adobe and Adobe Reader are trademarks of Adobe 

Systems Incorporated in the United States and/or other 

countries.

Using the CD-ROM

Reading the CD-ROM Manuals
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To read the documents

Do the following:

1 Insert the CD-ROM in your CD-ROM 

drive.

A cover page appears automatically in your 

browser.

If it does not appear automatically in the 

browser, double-click on the index.htm file 

on the CD-ROM.

2 Select and click on the manual that you 

wish to read.

This opens the PDF file.

Memo

The files may not be displayed properly, depending on 

the version of Adobe Reader. In such a case, install the 

latest version you can download from the URL 

mentioned in “Preparations” above.

Note

If you have lost or damaged the CD-ROM, you can 

purchase a new one to replace it. Contact a Sony service 

representative.

The following operating conditions are 

recommended for using the software recorded on 

the CD-ROM: 

S×S Device Driver Software

Applicable hardware

Computer conforming to ExpressCard/34 or 

ExpressCard/54

OS

Microsoft Windows XP SP2 or later, Microsoft 

Windows Vista, Microsoft Windows 7, or Mac 

OS X v10.4.9 or later

For support information on the driver, refer to the 

following URL:

http://www.sony.net/S×S-Support/

XDCAM EX Clip Browsing Software

For the operating requirements, visit the web sites 

shown in “XDCAM EX web sites” (page 12) or 

refer to the User’s Guide contained in the 

CD-ROM.

Do the following to install the software on the 

CD-ROM on your computer: 

1 Insert the CD-ROM in your CD-ROM 

drive.

A cover page appears automatically in your 

browser.

If it does not appear automatically in the 

browser, double-click on the index.htm file 

on the CD-ROM.

2 Select and click on the software that you 

wish to install.

The installer for the software starts up. 

Follow the displayed instructions:

For details, refer to the User’s Guide or ReadMe of 

the software.

Uninstalling an application program

Windows computer

Choose “Start,” “Control Panel” then “Add or 

Remove Programs” and specify the program to be 

deleted.

Macintosh computer

Drop the folder of the software (default: 

/Application/XDCAM EX Clip Browser) into 

Trash.

System Requirements for Using 
the Applications

Software Installation
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a LIGHT switch

Determines how a video light connected to the 

LIGHT connector (see page 15) is turned on and 

off.

AUTO: When the POWER switch of the video 

light is in the on position, the video light is 

turned on automatically while the camcorder 

is recording.

MANUAL: You can turn the video light on or off 

manually, using its own switch.

Note

When the camcorder is set for recording in Picture Cache 

mode, it is not possible to turn on the light before 

operation to start recording is carried out (or while data 

is being stored in memory).

b POWER switch

Turns the main power supply on and off.

c DC IN (DC power input) connector 

(XLR type, 4-pin, male)

To operate the camcorder from an AC power 

supply, connect an optional DC power cord to this 

terminal and then connect the cord to the DC 

output terminal of the BC-L70, BC-M150, or 

another battery charger.

d DC OUT 12V (DC power output) 

connector (4-pin, female)

Supplies power for an optional WRR-860A/861/

862 UHF Synthesized Diversity Tuner 

(maximum 0.5 A).

Do not connect any equipment other than the 

UHF synthesized diversity tuner.

e Battery attachment shoe

Attach a BP-GL95/GL65/L80S/L60S Battery 

Pack. Alternatively, you can attach an AC-

DN2B/DN10 AC Adaptor to operate the 

camcorder on AC power supply.

For details, see “Preparing a Power Supply” 

(page 33). 

For details, see “Attaching a UHF Portable Tuner 

(for a UHF Wireless Microphone System)” 

(page 45).

Note

For your safety, and to ensure proper operation of the 

camcorder, Sony recommends the use of the following 

battery packs: BP-GL95, BP-GL65, BP-L60S, and 

BP-L80S.

a Shoulder strap fitting

Attach the supplied shoulder strap (see page 48).

b Light fitting shoe

Attach an optional accessory such as a video light 

(see page 47).

Locations and Functions 
of Parts and Controls

Power Supply

2 31 54

Accessory Attachments
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c Viewfinder front-to-back positioning 

lever

To adjust the viewfinder position in the front-to-

back direction, loosen this lever and the LOCK 

knob. After adjustment, retighten this lever and 

the LOCK knob.

d Viewfinder left-to-right positioning ring

Loosen this ring to adjust the left-to-right position 

of the viewfinder (see page 35).

e Viewfinder fitting shoe

Attach the viewfinder.

f VF (viewfinder) connector (26-pin, 

rectangular)

Connect the cable of the supplied viewfinder.

g VF (viewfinder) connector (20-pin, 

round)

Connect the cable of the optional DXF-51 or 

DXF-20W viewfinder.

For connecting the DXF-51, optional parts are 

required. Consult a Sony service representative for 

information about connecting the DXF-51.

h Lens mount securing rubber

After locking the lens in position using the lens 

locking lever, fit this rubber over the lower of the 

two projections. This fixes the lens mount, 

preventing it from coming loose.

i Viewfinder front-to-back positioning 

knob (LOCK knob)

Loosen this knob to adjust the front-to-back 

position of the viewfinder (see page 35).

j Fitting for optional microphone holder

Fit an optional CAC-12 Microphone Holder (see 

page 44).

k Shoulder pad

Raise the shoulder pad fixing lever to adjust the 

position in the front-to-rear direction. Adjust the 

position for maximum convenience when 

operating the camcorder on your shoulder (see 

page 49).

l LIGHT (video light) connector (2-pin, 

female)

A video light with a maximum power 

consumption of 50 W, such as the Anton Bauer 

Ultralight 2 or equivalent can be connected (see 

page 47).

m Lens cable clamp

Clamp a lens cable.

n MIC IN (microphone input) (+48 V) 

connector (XLR type, 5-pin, female)

Connect a stereo microphone to this connector. 

The power (+48 V) is supplied via this connector.

o LENS connector (12-pin)

Connect a lens cable to this connector.

Note

When connecting or disconnnecting the lens 

cable to this connector, power off the camcorder 

first.

p Tripod mount

When using the camcorder on a tripod, attach the 

tripod adaptor (optional).

q Lens mount (special bayonet mount)

Attach the lens.

Consult a Sony service representative for 

information about available lenses.

r Lens locking lever

After inserting the lens in the lens mount, rotate 

the lens mount ring with this lever to lock the lens 

in position.

After locking the lens, be sure to use the lens 

mount securing rubber to prevent the lens from 

becoming detached.

s Lens mount cap

Remove by pushing up the lens locking lever. 

When no lens is mounted, keep this cap fitted for 

protection from dust.
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Front

a REC START (recording start) button

Press to start recording. Press it again to stop 

recording. The effect is the same as that of the 

REC button on the lens.

b SHUTTER selector

Set to ON to use the electronic shutter. Push to 

SELECT to switch the shutter speed or shutter 

mode setting. When this switch is operated, the 

new setting appears on the viewfinder screen for 

about three seconds.

For details, see “Setting the Electronic Shutter” 

(page 55).

c FILTER selector

Switches between four ND filters built into this 

camcorder.

When this selector is used, the new setting 

appears on the viewfinder screen for about three 

seconds.

You can change a MAINTENANCE menu 

setting so that different white balance settings can 

be stored for different FILTER selector positions. 

This allows you to automatically obtain optimum 

white balance for the current shooting conditions 

in linkage with the filter selection.

For details, see “Adjusting the White Balance” 

(page 52).

d MENU knob

Changes the item selection or a setting within the 

menu (see page 94).

e AUTO W/B BAL (automatic white/

black balance adjustment) switch

Activates the automatic white/black balance 

adjustment functions.

WHITE: Adjust the white balance automatically. 

If the WHITE BAL switch (see page 18) is 

set to A or B, the white balance setting is 

stored in the corresponding memory. If the 

WHITE BAL switch is set to PRST, the 

automatic white balance adjustment function 

does not operate.

BLACK: Adjust the black set and black balance 

automatically.

You can use the AUTO W/B BAL switch even 

when the ATW (Auto Tracing White Balance) 

function is operating.

If you push the switch to the WHITE side once 

more during the automatic white balance 

adjustment, the adjustment is cancelled and the 

white balance setting returns to the original 

setting.

If you push the switch to the BLACK side once 

more during the automatic black balance 

adjustment, the adjustment is cancelled and the 

black balance setting returns to the original 

setting.

f MIC (microphone) LEVEL control

Adjusts the input level of audio channels 1, 2, 3 

and 4 (see page 60).

Operating and Connectors Section

FILTER selector 

setting

ND filter

1 CLEAR

2 1/4 ND (attenuates light to 

approximately 1/4)

3 1/16 ND (attenuates light to 

approximately 1/16)

4 1/64 ND (attenuates light to 

approximately 1/64)

FILTER selector 

setting

ND filter



Locations and Functions of Parts and Controls 17

C
h

a
p

te
r 1

  O
ve

rv
ie

w

Right side (near the front)

a ASSIGN. (assignable) 1/2/3 switches

You can assign the desired functions to these 

switches on OPERATION >Assignable SW in 

the setup menu (see page 131).

EZ Mode is assigned to the ASSIGN. 1 switch, 

and Off is assigned to the ASSIGN. 2/3 switches 

as the factory default setting.

The ASSIGN.1/3 switches are provided with an 

indicator to show whether a function is assigned 

to the switch (ON) or not (OFF).

b COLOR TEMP. (color temperature) 

button

Press to light the button and change the color 

temperature for shooting (factory default setting). 

You can use this as an assignable switch (see 

page 131).

c ALARM (alarm tone volume 

adjustment) knob

Controls the volume of the warning tone that is 

output via the built-in speaker or optional 

earphones. When the knob is turned to the 

minimum position, no sound can be heard.

However, if MAINTENANCE >Audio >Min 

Alarm Volume in the setup menu is set to [Set], 

the alarm tone is audible even when this volume 

control is at the minimum position.

d MONITOR (monitor volume 

adjustment) knob

Controls the volume of the sound other than the 

warning tone that is output via the built-in speaker 

or earphones. When the knob is turned to the 

minimum position, no sound can be heard.

e MONITOR (audio monitor selection) 

switches

By means of combinations of the two switches, 

you can select audio that you want to hear through 

the built-in speaker or earphones.

Position of down-side switch: CH-1/2

Position of down-side switch: CH-3/4

a) By connecting stereo headphones to the EARPHONE 

jack, you can hear the audio in stereo. (Under 

MAINTENANCE >Audio in the setup menu, 

Headphone Out must be set to STEREO.)

Position of up-side 

switch

Audio output

CH-1/CH-3 Channel 1 audio

MIX Channels 1 and 2 mixed 

audio (stereo) a)

CH-2/CH-4 Channel 2 audio

Position of up-side 

switch

Audio output

CH-1/CH-3 Channel 3 audio

MIX Channels 3 and 4 mixed 

audio (stereo) a)

CH-2/CH-4 Channel 4 audio

ALARM

Minimum Maximum
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f ASSIGN. (assignable) 0 switch

You can assign the desired function to this switch 

on OPERATION >Assignable SW in the setup 

menu (see page 132).

Off is assigned to this switch when the camcorder 

is shipped from the factory.

This is a momentary type switch. Each press of 

the switch turns the function assigned to this 

switch on or off.

g GAIN selector

Switches the gain of the video amplifier to match 

the lighting conditions during shooting. The gains 

corresponding to the L, M, and H settings can be 

selected on OPERATION >Gain Switch in the 

setup menu (see page 104). (The factory settings 

are L=0 dB, M=6 dB, and H=12 dB.)

When this switch is adjusted, the new setting 

appears on the viewfinder screen for about three 

seconds.

h OUTPUT/DCC (output signal/dynamic 

contrast control) switch

Switches the video signal output from the camera 

module, between the following two.

BARS: Output the color bar signal.

CAM: Output the video signal being shot. When 

this is selected, you can switch DCC 1) on and 

off.

1) DCC (Dynamic Contrast Control): Against a very 

bright background with the iris opening adjusted to the 

subject, objects in the background will be lost in the 

glare. The DCC function will suppress the high 

intensity and restore much of the lost detail and is 

particularly effective in the following cases.

• Shooting people in the shade on a sunny day

• Shooting a subject indoors, against a background 

through a window

• Any high contrast scene

i WHITE BAL (white balance memory) 

switch

Controls adjustment of the white balance.

PRST: Adjust the color temperature to the preset 

value (the factory default setting: 3200K). 

Use this setting when you have no time to 

adjust the white balance.

A or B: Recall the white balance adjustment 

settings already stored in A or B. Push the 

AUTO W/B BAL switch (see page 16) on 

the WHITE side, to automatically adjust the 

white balance, and save the adjustment 

settings in memory A or memory B.

B (ATW 1)): When this switch is set to B and 

OPERATION >White Setting >White 

Switch<B> is set to [ATW] in the setup 

menu, ATW is activated.

You can use the AUTO W/B BAL switch 

even when ATW is in use.

When this switch is adjusted, the new setting 

appears on the viewfinder screen for about three 

seconds.

1) ATW (Auto Tracing White Balance): The white 

balance of the picture being shot is adjusted 

automatically for varying lighting conditions.

j MENU ON/OFF switch

To use this switch, open the cover.

This switch is used to display the menu on the 

viewfinder screen or the test signal screen. Each 

time the switch is pushed down, the menu screen 

is turned on and off.

The function of this switch is the same as that of 

the MENU button in the thumbnail screen 

operations section.

k STATUS ON/SEL/OFF (menu display 

on/page selection/display off) switch

MENU CANCEL/PRST (preset) /

ESCAPE switch

When the menu is not displayed, this switch 

functions as the STATUS ON/SEL/OFF switch. 

When the menu is displayed, the switch functions 

as the MENU CANCEL/PRST/ESCAPE switch. 

(To use the MENU CANCEL/PRST/ESCAPE 

switch, open the cover.)

Use the STATUS ON/SEL/OFF switch in the 

following way.

ON/SEL: Each time this switch is pushed 

upward, a window to confirm the menu 

settings and status of the camcorder appears 

on the viewfinder screen (see page 65). The 

window consists of five pages, which are 

switched each time the switch is pushed 

upward. Each page is displayed for about 10 

seconds.

OFF: To clear the page immediately after 

display, push this switch down to the OFF 

position.

Use the MENU CANCEL/PRST/ESCAPE in the 

following way.
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CANCEL/PRST: Pushing this switch up to this 

position after a setting is changed in the setup 

menu displays the message to confirm 

whether the previous settings are cancelled. 

Pushing this switch up to this position again 

cancels the previous settings.

Pushing this switch up to this position before 

a setting is changed in the setup menu or after 

a setting change is cancelled in the setup 

menu displays the message to confirm 

whether the setting is reset to the initial 

value.

Pushing this switch up to this position again 

resets the settings to the initial value.

ESCAPE: Use this switch when the menu page, 

which has a hierarchical structure, is opened. 

Each time the switch is pushed to this 

position, the page returns to one stage higher 

in the hierarchy.

l Cover

Open this cover to use the MENU ON/OFF 

switch or the MENU CANCEL/PRST/ESCAPE 

switch.

Right side (near the rear)

a Built-in speaker

The speaker can be used to monitor E-E 1) sound 

during recording, and playback sound during 

playback. The speaker also sounds alarms to 

reinforce visual warnings (see page 148).

If you connect earphones to the EARPHONE 

jack, the speaker output is suppressed 

automatically.

1) E-E: Abbreviation of “Electric-to-Electric”. In E-E 

mode, video and audio signals input to the camcorder 

are output after passing through internal electric 

circuits only. This can be used to check input signals.

b Monochrome LCD panel

Displays remaining battery capacity, remaining 

media capacity, audio levels, time data, and so on 

(see page 25).
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c WARNING indicator

Lights up or flashes when an abnormality occurs 

(see page 148).

d ACCESS lamp

Lights up when data is written to or read from the 

recording media.

e Protection cover of the audio control 

section

Open to access the audio control section (see 

page 21).

f Protection cover of the thumbnail 

screen operations section

Open to access the thumbnail screen operations 

section (see page 21).

g F REV (fast reverse) button and 

indicator

This plays back at high speed in the reverse 

direction. The playback speed changes in the 

order ×4 t ×15 t ×24 with each press of the 

button. The indicator lights during high-speed 

playback in the reverse direction.

h PLAY/PAUSE button and indicator

Press this button to view play back video images 

using the viewfinder screen or the LCD monitor. 

The indicator lights during playback.

Press this button again during playback to pause, 

outputting a still image. At this time the indicator 

flashes at a rate of once per second.

Pressing the F REV or F FWD button during 

playback or pause starts high speed playback in 

the forward or reverse direction.

i F FWD (fast forward) button and 

indicator

This plays back at high speed in the forward 

direction. The playback speed changes in the 

order ×4 t ×15 t ×24 with each press of the 

button. The indicator lights during high-speed 

playback in the forward direction.

j PREV button

This jumps to the first frame of the current clip. 

If you press this together with the F REV button, 

the jump is to the first frame of the first recorded 

clip on the recording media.

If you press this button twice in rapid succession, 

the jump is to the first frame of the last preceding 

clip (or the first frame of the current clip when no 

preceding clips exist).

k STOP button

Press this button to stop playback.

l NEXT button

This jumps to the first frame of the next clip.

If you press this together with the F FWD button, 

the jump is to the first frame of the last recorded 

clip on the recording media.

m EXPAND (expand function) button

If you press this button when the thumbnail 

screen is displayed, the duration of the selected 

clip is divided into fractions, and the first frame of 

each of the divisions is shown in a further 

thumbnail display (expand function). For an HD 

recorded MP4 clip, its duration is divided into 12. 

If an SD recorded AVI clip comprises multiple 

files, the divisions are displayed for the individual 

files.

For MP4 clips, each time you press this button the 

division is repeated. Hold down the SHIFT button 

and press this button to step back through the 

division process.

n HOLD (display hold) button

Pressing this button instantly freezes the time data 

displayed in the monochrome LCD panel. (The 

timecode generator continues running.) Pressing 

this button again releases the hold.

For details of the counter display, see page 25.

o RESET/RETURN button

Resets the value shown in the time counter 

display in the monochrome LCD panel. 

According to the settings of the PRESET/

REGEN/CLOCK switch (see page 22) and the 

F-RUN/SET/R-RUN switch (see page 21), this 

button resets the display as follows.

Settings of switches To reset

DISPLAY switch: 

COUNTER

Counter to 0:00:00:00

DISPLAY switch: 

TC

PRESET/REGEN/

CLOCK switch: 

PRESET

F-RUN/SET/R-RUN 

switch: SET

Timecode to 00:00:00:00
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a) Of the timecode bits for every frame recorded on the 

media, those bits which can be used to record useful 

information for the user such as scene number, 

shooting place, etc.

For details, see “Setting the Time Data” (page 62).

This button returns to the previous screen when 

pressed during thumbnail screen display, expand 

thumbnail screen display, or shot mark thumbnail 

screen display.

p DISPLAY switch

This cycles the data displayed in the time counter 

display in the monochrome LCD panel through 

the sequence COUNTER, TC, and U-BIT (see 

page 25).

COUNTER: Display the elapsed recording/

playback time (hours, minutes, seconds, 

frames).

TC: Display timecode.

U-BIT: Display user bits data.

q BACKLIGHT button

Turns the backlight of the monochrome LCD on 

and off. The backlight of the monochrome LCD 

panel will be turned on when the camcorder is 

powered on for the first time after shipped from 

the factory.

Thumbnail screen operations section and audio 

control section

a THUMBNAIL indicator 

This lights when thumbnail screen is displayed.

b THUMBNAIL button

Press this button to display the thumbnail screen 

(see page 80) and to carry out a thumbnail 

operation.

Press once more to return to the original display.

c SET (set) button and arrow buttons

Use these buttons to make timecode and user bit 

settings, and for thumbnail screen operations (see 

page 85).

When the menu is displayed, press this button to 

select an item or to confirm the setting change.

d MENU button

Each press of this button turns the setup menu 

display on and off.

The function of this button is the same as that of 

the MENU ON/OFF switch.

e F-RUN/SET/R-RUN (free run/set/

recording run) switch

Selects the operating mode of the internal 

timecode generator. The operating mode is set as 

explained below, depending on the position of the 

switch.

F-RUN: Timecode keeps advancing, regardless 

of whether the camcorder is recording. Use 

this setting when synchronizing the timecode 

with external timecode.

SET: Sets the timecode or user bits.

R-RUN: Timecode advances only during 

recording. Use this setting to have a 

consecutive timecode on the recording 

media.

DISPLAY switch: 

U-BIT

PRESET/REGEN/

CLOCK switch: 

PRESET

F-RUN/SET/R-RUN 

switch: SET

User bits data a) to 00 00 00 

00

Settings of switches To reset
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For details, see “Setting the Timecode” (page 62) 

and “Setting the User Bits” (page 63).

f LEVEL CH-1/CH-2/CH-3/CH-4 (audio 

channel 1/2/3/4 recording level) knobs

Adjust the audio levels to be recorded on channels 

1, 2, 3, and 4 when the AUDIO SELECT CH-1/

CH-2 and AUDIO SELECT CH 3-4 switches are 

set to MANUAL.

g AUDIO SELECT CH 3-4 (audio 

channel 3/4 adjustment method 

selection) switch

Select the audio level adjustment method for each 

of audio channels 3 and 4.

AUTO: Automatic adjustment

MANUAL: Manual adjustment

h ESSENCE MARK button

By pressing this button when the thumbnail 

display of a clip is on the screen, you can view the 

following thumbnail display of the shot-marked 

frames of that clip, depending on the item 

selected in a list displayed on the screen.

Shot Mark1: Thumbnail display of the frames 

marked with Shot Mark 1

Shot Mark2: Thumbnail display of the frames 

marked with Shot Mark 2

Shot Mark: Thumbnail display of the frames 

marked with either Shot Mark 1 or Shot Mark 

2

i SHIFT button

Use this in combination with other buttons.

j PRESET/REGEN (regeneration)/

CLOCK switch

Selects the type of timecode to record.

PRESET: Record new timecode on the media.

REGEN: Record timecode continuous with the 

existing timecode recorded on the media. 

Regardless of the setting of the F-RUN/SET/

R-RUN switch, the camcorder operates in R-

RUN mode.

CLOCK: Record timecode synchronized to the 

internal clock. Regardless of the setting of 

the F-RUN/SET/R-RUN switch, the 

camcorder operates in F-RUN mode.

k AUDIO SELECT CH-1/CH-2 (audio 

channel 1/2 adjustment method 

selection) switches

Select the audio level adjustment method for each 

of audio channels 1 and 2.

AUTO: Automatic adjustment

MANUAL: Manual adjustment

l AUDIO IN CH-1/CH-2/CH-3/CH-4 

(audio channel 1/2/3/4 input selection) 

switches

Select the audio input signals to be recorded on 

audio channels 1, 2, 3 and 4.

FRONT: Audio input signals from the 

microphone connected to the MIC IN 

connector

REAR: Audio input signals from an audio device 

connected to the AUDIO IN CH1/CH2 

connectors

WIRELESS: Audio input signals from the UHF 

portable tuner if it is installed
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Left side and upper section

a ASSIGNABLE 4/5 switches

You can assign the desired functions to these 

switches on OPERATION >Assignable SW in 

the setup menu (see page 132).

Off is assigned to these switches when the 

camcorder is shipped from the factory.

b USB connector

Used to put this camcorder into USB connection 

mode and use it as an external storage device for 

a computer. When a computer without 

ExpressCard slot is connected to this connector, 

every memory card inserted in the camcorder is 

recognized as a drive for that computer.

c S×S memory card slots

These two slots (A and B) can receive S×S 

memory cards or other recording media (see 

page 68).

d ACCESS lamps

Indicate the state of slots A and B (see page 68). 

You can check whether the lamps are lit even 

when the slot cover is closed.

e EJECT buttons

To remove the recording media from the slot, 

press the EJECT button to release the lock, then 

press the button once more. This makes the media 

come out of the slot partially (see page 69).

f Slot cover

Slide to the left and right to open and close.

g SLOT SELECT (S×S memory card 

select) button

When S×S memory cards are loaded in both card 

slots A and B, press this button to select the card 

you want to use (see page 69).

h HDMI output connector

Outputs HDMI signals for video monitoring. 

When a video monitor provided with an HDMI 

signal input connector is connected to this 

connector, you can monitor picture being shot 

(camera picture) or playback picture.

i GENLOCK IN (genlock signal input) 

connector (BNC type)

This connector inputs a reference signal when the 

camcorder is to be genlocked or when timecode is 

to be synchronized with external equipment. 

(Genlock for the camera module supports 

horizontal sync signals only.) Use 

MAINTENANCE >GENLOCK in the setup 

menu to adjust the genlock H-phase (phase of 

horizontal sync signal).

HDMI GENLOCK
IN

TC IN

VIDEO
OUT

TC
OUT
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j TC IN (timecode input) connector 

(BNC type)

To apply an external lock to the timecode of the 

camcorder, input the reference timecode.

For details, see “Setting the Timecode” (page 62).

k VIDEO OUT connector (BNC type)

Outputs video signals for monitoring. The output 

signals can be selected either composite video or 

HD-Y depending on the setting of OPERATION 

>Input/Output >Output&i.LINK in the setup 

menu.

l TC OUT (timecode output) connector 

(BNC type)

To lock the timecode of an external VTR to the 

timecode of this camcorder, connect this 

connector to the external VTR’s timecode input 

connector.

Rear

a TALLY (back tally) indicators (red)

Light up during recording. They will not light if 

the TALLY switch is set to OFF. These indicators 

also flash to indicate warnings (see page 20). The 

tally indicator on the front of the viewfinder and 

the REC indication on the viewfinder screen light 

or flash in the same manner.

For details, see “Operation Warnings” (page 148).

b TALLY switch

Set to ON to activate the TALLY indicator 

function.

c EARPHONE jack (stereo, minijack)

You can monitor the E-E sound during recording 

and playback sound during playback. When an 

alarm is indicated, you can hear the alarm sound 

through the earphone. Plugging an earphone into 

the jack automatically cuts off the built-in 

speaker.

You can select monaural or stereo on 

MAINTENANCE >Audio in the setup menu.

d AUDIO IN selectors

Select the audio source you connect to the 

AUDIO IN CH1/CH2 connectors.

LINE: When connecting a stereo amplifier or 

other external audio signal source

MIC: When connecting a microphone that does 

not require 48 V power supply

+48V: When connecting a microphone that 

requires 48 V power supply

e HD/SD SDI OUT connector (BNC type)

Outputs an HD SDI or SD SDI signal (with 

embedded audio). The output from this connector 

can be turned on and off with OPERATION 

>Input/Output >SDI Output in the setup menu.

f AUDIO IN CH1/CH2 (audio channel 1 

and channel 2 input) connectors (XLR 

type, 3-pin, female)

These are audio input connectors for channels 1 

and 2 to which you can connect audio equipment 

or a microphone.

g AUDIO OUT connector (XLR type, 5-

pin, male)

Outputs the audio signals recorded on audio 

channels 1 and 2 or audio channels 3 and 4. The 

audio signals are selected by the MONITOR 

switch.
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h REMOTE connector (8-pin)

Connect a remote control unit, which makes it 

possible to control the camcorder remotely.

Note

Before connecting/disconnecting the Remote Control 

Unit to/from the camcorder, be sure to turn off the 

camcorder POWER switch.

i i.LINK (HDV/DV) connector (6-pin, 

IEEE1394 compliant, S400)

To input and output HDV/DV streams, connect to 

an HDV/DV device.

a Timecode status

NDF: Appears when non-drop-frame timecode is 

selected.

EXT-LK: Appears when the internal timecode 

generator is locked to an external signal input 

to the TC IN (timecode input) connector.

b Counter display mode

Shows the type of information selected by the 

DISPLAY switch to be displayed in the time 

counter display.

COUNTER: Counter values

TC: Timecode

U-BIT: User bits data

c Time counter display

Switches displays of time counter values, 

timecode, and user bits data, depending on the 

position of the DISPLAY switch.

When the HOLD button is pressed to hold the 

timecode value, the timecode is displayed in the 

format shown below. When the HOLD button is 

pressed again to release the hold, the timecode is 

displayed in the normal format.

d HOLD indication

Appears when the timecode generator output is 

displayed in the hold mode.

e Audio level indicators

Indicate the audio recording or playback levels of 

channels 1 to 4.

f Lock icon

Appears when the recording media is write-

protected.

g Remaining media capacity indicator

Shows bar segments indicating the remaining 

capacity of recording media in the slots.

h Remaining battery capacity indicator

Shows bar segments indicating the remaining 

battery capacity.

Monochrome LCD Panel

The three dots indicates that timecode is 
displayed in the hold mode.
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a  PUSH AF (auto focus) button

When the focus adjustment is in the manual 

mode, by pressing this button you can use the auto 

focus for an instantaneous adjustment to the 

subject.

When the button is pressed, the auto focus 

operates until the image is in focus, then 

disengages.

Even when the FOCUS switch is set to A (auto), 

by pressing this button, you can restart the auto 

focus.

b FOCUS switch

A (auto): The auto focus function is constantly 

active. Even with the switch in the A 

position, you can manually adjust the focus 

by operating the focus ring.

M (manual): The manual mode allows focusing 

adjustment with the focus ring.

In manual mode, auto focus adjustment is also 

possible, by pressing the PUSH AF button.

c MACRO switch

When this switch is in the ON position, the macro 

mode is enabled, allowing focusing over the 

whole range (5 cm 1) to ∞) including the macro 

range (from 5 cm 1) to 90 cm from the front of the 

lens).

This operation is independent of whether the 

focus adjustment mode is auto or manual.

In the macro range, the auto focusing speed is 

lower.

1) At the wide-angle setting

d Iris ring

For manual iris adjustment, set the IRIS switch to 

the M (manual) position, then turn this ring.

e Zoom ring

For manual zoom adjustment, set the ZOOM 

switch to the MANUAL position, then turn this 

ring.

f Focus ring

Turn this ring to adjust the focus.

This ring can be turned endlessly in both 

directions. The faster you turn, the faster the 

focusing mechanism operates, to minimize the 

amount of turning required for focusing.

When you slide the focus ring back (toward the 

camcorder), the focus mode becomes Full MF 

mode (see page 59).

g Flange focal length adjustment button

Press this to adjust the flange focal length (the 

distance from the lens mounting flange plane to 

the focusing plane) (see page 42).

h  Zoom control connector (8-pin)

Connecting an optional zoom servo controller 

allows remote control of zooming.

i ZOOM switch

SERVO: Motorized zoom. Operate the zoom 

with the power zoom lever.

MANU. (manual): Manual zoom. Operate the 

zoom with the zoom ring.

Auto Focus Lens (Supplied with 
the PMW-350K)
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j PUSH AUTO button

When the IRIS switch is in the M position for 

manual adjustment, press this button for an 

instantaneous auto adjustment.

The iris is automatically adjusted while the button 

is held down.

k IRIS switch

A (auto): The iris is adjusted automatically.

M (manual): Adjust the iris with the iris ring.

l Power zoom lever

This is enabled when the ZOOM switch is in the 

SERVO position. Press the W end for wide-angle 

and the T end for telephoto.

Press the lever harder for a faster zoom action.

Notes on auto focus

• In the following cases, it may be difficult to 

focus on the subject. If this does happen, use 

manual focusing.

- If the subject has no contrast

- If the subject is moving rapidly

- When shooting point light sources, under 

street lighting or at night

- When there are very bright objects close to the 

subject

- When shooting through a glass window

• If there are a number of objects within the 

screen at close and far range, the focus may not 

be on the intended subject. In this case, with the 

subject on which you want to focus in the center 

of the screen, press the PUSH AF button.

• After focusing with the PUSH AF button, if you 

operate the zoom or adjust the iris, the depth of 

field may become shallower, losing crisp focus. 

In such cases, press the PUSH AF button once 

more.

• If you focus at wide-angle then zoom to 

telephoto, the subject may no longer be in focus.

• It may take time until the image is in focus 

while using the slow shutter mode.

Note on zoom speed

Depending on the shooting distance, the zoom 

speed may fall as the lens approaches the 

telephoto end.

m RET (return video) button

You can use this as an assignable switch (see 

page 134).

Use this to check the video when Lens RET is 

assigned to this button (factory default setting). If 

you press this during recording pause, the last few 

seconds recorded appear on the viewfinder screen 

(recording review) (see page 72).

Pressing this button (single click) during 

recording or playback records a Shot Mark 1 

mark, and double-clicking records a Shot Mark 2 

mark (see page 73).

n VTR button

Use this to start and stop recording. Press once to 

start recording, then press once more to stop.

a Plug

Connect to the VF connector (rectangular) on the 

camcorder.

b Stopper

Prevents the viewfinder from coming off the 

camcorder when it is slid from side to side.

c Eyecup

d Diopter adjustment ring

Allows for optimal focus adjustment.

e Eyepiece

You can raise this up when required by the 

situation.

Viewfinder



Locations and Functions of Parts and Controls28

C
h

a
p

te
r 1

  O
ve

rv
ie

w

f Viewfinder barrel

You can raise this up or rotate when required by 

the situation.

g Tally indicator

Lights up when recording is started by a press of 

the REC START button on this camcorder, the 

VTR button on the lens, or the VTR button on the 

remote control unit.

When an abnormality occurs, the tally indicator 

flashes to indicate a warning.

h PEAKING control

Turning this control clockwise adjusts the picture 

sharpness, and makes focusing easier. This 

control has no effect on the output signals of the 

camcorder.

i CONTRAST control

Adjusts the contrast of the screen. This control 

has no effect on the output signals of the 

camcorder.

j BRIGHT control

Adjusts the brightness of the screen. This control 

has no effect on the output signals of the 

camcorder.

k TALLY switch

Controls the tally indicator located on the front of 

the viewfinder.

HIGH: The tally indicator brightness is set to 

high.

OFF: The tally indicator is disabled.

LOW: The tally indicator brightness is set to low.

l ZEBRA (zebra pattern) switch

Controls the zebra pattern display on the 

viewfinder screen as follows.

ON: Display a zebra pattern.

OFF: Do not display a zebra pattern.

m DISPLAY switch

Turns the display of text information on and off.

ON: Display text information.

OFF: Do not display text information.

n MIRROR switch

The image display on the monitor screen becomes 

reversed horizontally or vertically when the 

viewfinder barrel is raised up or rotated. Use this 

switch to control the image display in such 

situation.

L/R: Reverse the image horizontally.

OFF: Do not reverse the image.

B/T: Reverse the image vertically.

o Viewfinder cable

p Microphone holder
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The viewfinder screen displays not only the video 

picture but also characters and messages 

indicating the camcorder settings and operating 

status, a center marker, a safety zone marker, etc.

When the menu screen is not displayed and the 

DISPLAY switch is set to ON, the items for 

which an ON setting was made with 

OPERATION >Super Impose in the setup menu 

or with related switches are displayed at the top 

and bottom of the screen.

Caution messages are indicated for three seconds 

when you carry out operations to change 

camcorder settings. Adjustment execution 

messages are indicated while adjustments 

proceed. When adjustments are finished, 

messages showing the results of adjustments 

appear for three seconds.

Not only these indications are displayed on the 

viewfinder screen, but a menu setting enables 

them to be output as video signals. 

All items that can be displayed on the viewfinder 

screen are shown below.

Top of viewfinder screen

a Extender settings

Indicates the setting of the digital extender 

function (by digital extender option) of this 

camcorder and the setting of the lens extender.

EX: The lens extender is on.

08: The lens shrinker is on.

x2D: The optional digital extender function of 

this camcorder is on.

Ex2D: The lens extender and the optional digital 

extender function of this camcorder are both 

on.

b Zoom position (when the lens is 

mounted)

Indicates the zoom position of the zoom lens in 

the range from 0 to 99.

c Focus position (when the serial lens is 

mounted)

Indicates the focus position as distance to the 

subject (in units of m or f).

d Green tally

Lights when the camcorder is the following 

states.

• MAINTENANCE >Camera Config >HD-SDI 

Remote I/F is set to [G-Tally] in the setup menu 

and a recording control signal is output from the 

HD/SD SDI OUT connector.

• When the Picture Cache mode is enabled

e Media status

Displays the name of the currently active media 

slot (A or B).

f Recording mode/operation status

Indicates the current recording mode/operation 

status as follows.

Viewfinder Screen 
Display

Indication Meaning

zREC Recording in progress

STBY Standby for recording

zCACHE Standby in Picture Cache mode

zINT REC Recording in progress in Interval 

Recording mode

zINT STBY Standby for next recording in 

Interval Recording mode

INT STBY Standby in Interval Recording 

mode

zFRM REC Recording in progress in Frame 

Recording mode

zFRM 

STBY

Standby for next recording in 

Frame Recording mode

FRM STBY Standby in Frame Recording mode

zS&Q REC Recording in progress in Slow & 

Quick Motion mode

S&Q STBY Standby in Slow & Quick Motion 

mode

zCALL Being called from a connected 

device

BREVIEW During recording review
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g Wireless receiver reception level

When a wireless receiver is installed in the 

camcorder, “W” appears together with four 

segment reception level indicators for each of the 

channels (1 to 4) that can be used by the receiver. 

The indications are as follows.

In normal situation: The number of white 

segments indicates the strength of the signal 

level.

Muting (for an analog receiver) or error rate 

aggravation (for a digital receiver): The 

number of gray segments indicates the 

strength of the signal level.

h Battery remaining/voltage capacity

The following is displayed depending on the type 

of power source.

i External power input

Appears when power is supplied from an external 

power source connected to the DC IN connector.

j Color temperature

Displays a color temperature calculated from the 

gain of R and B, in the range 1.5 K to 50.0 K (in 

steps of 0.1 K). The +/– signs may be displayed 

depending on the Offset White setting (see 

page 92).

No display: Offset White is OFF

+: The value of Offset White is greater than 

3200K.

–: The value of Offset White is less than 3200K.

k Number of system lines

Indicates the number of system lines (1080/720/

576/480) of video currently being recorded or 

played back.

l Video format

Indicates the format of video being currently 

played back or recorded (see page 50).

The video aspect ratio (16:9 or 4:3) can also be 

displayed when the recording format is set to 

DVCAM.

m Depth of field indication (when the 

serial lens is mounted) 

Error/warning indication

A bar indicates the depth of field.

An error or warning message is displayed here 

depending on the situation.

n Special recording mode indication

The following is displayed when the camcorder is 

in a special recording mode.

• Frame Rec (Frame Recording mode)

• Interval Rec (Interval Recording mode)

• S&Q Motion (Slow & Quick Motion mode)

o Special recording mode settings 

indication

Appears when the camcorder is in a special 

recording mode.

Bottom of viewfinder screen

a TLCS iris control mode

The following icons are displayed to indicate the 

video level control modes based on the Total 

Level Control System (TLCS).

b Focus adjustment mode (when the auto 

focus lens is mounted)

Indicates the current focus adjustment mode of 

the camcorder.

• AF (Auto Focus mode)

• MF (Manual Focus mode)

Type of power 

source

What is displayed

InfoLithium 

battery

Remaining battery capacity icon 

and remaining recording time

Anton Bauer 

battery

Remaining battery capacity (% 

indication)

Other type than 

above

Input voltage

Icon TLCS control mode

Backlight mode

Standard mode

Spotlight mode

STDSTD
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• MF* (Manual Focus mode when the MF Assist 

function is on)

• Full MF (Full Manual Focus mode)

c External device control

“REC2” is displayed when MAINTENANCE 

>Camera Config >HD-SDI Remote I/F is set to 

[Chara] in the setup menu and a recording control 

signal is output from the HD/SD SDI OUT 

connector.

d Operation status of connected i.LINK 

device

The operating format (HDV or DV) and operation 

status of that device are indicated as follows.

e Video level indication

An indication is displayed together with an 

appropriate ND filter position number when the 

light level of the subject is too high or too low.

f Timecode 

Caution message

Indicates the elapsed recording/playback time, 

timecode, user bits data or other information 

selected by the DISPLAY switch (see page 21).

Also indicates a caution message when caution is 

required such as when you try to change settings.

g Brightness level

Indicates the average brightness level (%) of the 

detection area.

h External input source

Indicates the type of external input signal (HDV) 

to be recorded.

i Recording of external input

Indicates “EXT” when an external input is 

recorded.

j Electric color temperature filter

When the electric color temperature filter is set to 

ON, the set value of color temperature is 

displayed.

k ND Filter

Indicates the currently selected ND filter position 

number. (see page 16).

l White balance memory

Indicates the currently selected white balance 

automatic adjustment memory.

ATW: ATW (Auto Tracing White Balance) mode

W:A: Memory A mode

W:B: Memory B mode

W:P: Preset mode

m Gain value

Indicates the gain value (in dB) of the video 

amplifier, as set by the GAIN selector.

n Shutter

Indicates the shutter speed or the shutter mode. 

For details, see “Setting the Electronic Shutter” 

(page 55).

o Audio level meters

Indicate the audio levels of channel 1 and channel 

2.

p Remaining media capacity

Indicates the recording time remaining for each of 

the media loaded in the slots. The available time 

for recording with the current video format 

(recording bit rate) is calculated according to the 

remaining space of each media and indicated in 

time units of minutes. A lock icon appears if the 

media is write-protected.

q Histogram

Shows a pixel distribution of video luminance 

(HD mode only).

r Iris position (when the lens is mounted)

Indicates the iris position and the setting for iris 

override (reference value for the lens iris) (see 

page 57).

The iris override setting is indicated by four 

segments indicator as follows.

Indication Meaning

zREC HDV recording in progress

STBY Standby for HDV recording

zREC DV recording in progress

STBY Standby for DV recording

Reference 

value

Indicator

+0.25
x

Lower left segment is lit in grey.

+0.5 x

x

Left two segments are lit in grey.

+0.75 x
xx

Left two segments and lower 

right segment are lit in grey. 
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+1 xx
xx

All segments are lit in grey.

–0.25
s

Lower left segment is lit in 

white.

–0.5 s

s

Left two segments are lit in 

white.

–0.75 s
ss

Left two segments and lower 

right segment are lit in white.

–1 ss
ss

All segments are lit in white.

Reference 

value

Indicator
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For safety, use only the Sony battery packs and 

AC adaptors listed below.

• BP-GL95/GL65/L60S/L80S Lithium-ion 

Battery Pack

• AC power using the AC-DN2B/DN10 AC 

Adaptor

CAUTION

Danger of explosion if battery is incorrectly replaced. 

Replace only with the same or equivalent type 

recommended by the manufacturer.

When you dispose of the battery, you must obey the law 

in the relative area or country.

ATTENTION

Il y a danger d’explosion s’il y a remplacement incorrect 

de la batterie. Remplacer uniquement avec une batterie 

du même type ou d’un type équivalent recommandé par 

le constructeur.

Lorsque vous mettez la batterie au rebut, vous devez 

respecter la législation en vigueur dans le pays ou la 

région où vous vous trouvez.

VORSICHT

Explosionsgefahr bei Verwendung falscher Batterien. 

Batterien nur durch den vom Hersteller empfohlenen 

oder einen gleichwertigen Typ ersetzen.

Wenn Sie die Batterie entsorgen, müssen Sie die Gesetze 

der jeweiligen Region und des jeweiligen Landes 

befolgen.

When a BP-GL95/GL65/L60S/L80S Battery 

Pack is used, the camcorder will operate 

continuously for the time shown below.

WARNING

Batteries shall not be exposed to excessive heat such as 

sunshine, fire or the like.

AVERTISSEMENT

N’exposez pas les batteries à une chaleur excessive, au 

soleil ou près d’un feu par exemple.

WARNUNG

Akkus dürfen keinesfalls übermäßiger 

Wärmeeinwirkung ausgesetzt werden, wie z.B. 

Sonneneinstrahlung, Feuer o. ä.

Note

The battery pack operating time depends on the 

frequency of use of the battery pack, and the ambient 

temperature when used.

Before use, charge the battery pack with a charger 

suitable for each battery.

For details on the battery charging procedure, refer 

to the battery charger operation manual.

Note on using the battery pack

A warm battery pack may not be able to be fully 

recharged.

To attach the battery pack

1 Press the battery pack against the back 

of the camcorder, aligning the line on 

the side of the battery pack with the 

matching line on the camcorder.

Chapter2 Preparations

Preparing a Power 
Supply

Using a Battery Pack

Model name Operating time

BP-GL95 Approx. 310 minutes

BP-GL65 Approx. 210 minutes

BP-L60S Approx. 210 minutes

BP-L80S Approx. 270 minutes
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2 Slide the battery pack down until its 

“LOCK” arrow points at the matching 

line on the camcorder.

Note

If the battery pack is not attached correctly, the terminal 

may be damaged.

To detach the battery pack

Holding the release button in, pull the battery 

pack up.

Notes

• During recording and playback (while the ACCESS 

indicator is lit), be careful never to remove the battery 

pack.

• Make sure to power the camcorder off before replacing 

the battery pack.

Mount an AC-DN2B/DN10 on the camcorder in 

the same way as a battery pack, then connect to 

the AC power supply.

The AC-DN2B/DN10 can supply up to 100 W of 

power.

1BP-GL95/GL65/L60S/L80S
2Align these lines.

1 “LOCK” arrow
2Matching line on the camcorder

Using AC Power

Release button

To an AC outlet
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CAUTION

When the viewfinder is attached, do not leave the 

camcorder with the eyepiece facing the sun. Direct 

sunlight can enter through the eyepiece, be focused in the 

viewfinder and cause fire.

Note

When attaching the viewfinder, make notes of the 

following points.

• Be sure to power off the camcorder before coupling the 

viewfinder connector to the camcorder’s VF connector 

(rectangular). If you make this connection when the 

camcorder power is on, the viewfinder may not 

function properly.

• Couple the viewfinder connector firmly to the 

camcorder’s VF connector (rectangular). If the 

coupling is loose, noise may appear on the video or the 

tally indicator may not operate properly.

1 1 Loosen the viewfinder left-to-right 

positioning ring, 2 attach the 

viewfinder to the viewfinder fitting 

shoe, and 3 tighten the viewfinder left-

to-right positioning ring.

2 Couple the viewfinder connector to the 

VF connector (rectangular).

Detaching the viewfinder

You can detach the viewfinder by following the 

attaching procedure in reverse order, but there is 

an additional action to take: when detaching the 

viewfinder from the fitting shoe, pull up the 

stopper.

To adjust the viewfinder left-to-right position, 

loosen the left-to-right positioning ring, and to 

adjust the front-to-back position, loosen the front-

to-back positioning knob.

Attaching the Viewfinder

Attaching the Supplied Viewfinder

Stopper

Viewfinder left-
to-right 
positioning ring

Adjusting the Viewfinder Position

VF connector (rectangular)

Viewfinder front-to-back positioning knob

Viewfinder left-to-right positioning ring
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You can adjust the angle of the viewfinder.

To reverse the display (image/text indication) 

vertically

The viewfinder can be rotated as much as 180 

degrees toward the direction facing the subject.

When you do this, the picture and other 

information displayed in the viewfinder appear 

upside down. To restore the normal display, set 

the MIRROR switch on the rear panel of the 

viewfinder to B/T.

You can view the LCD screen inside the 

viewfinder or its mirrored image by lifting up the 

viewfinder barrel or the eyepiece.

This section describes how to lift up the 

viewfinder barrel and detach it. The eyepiece can 

also be lifted up and detached in the same way.

To raise up the viewfinder barrel

Push the clip on the bottom to release and flip up 

the viewfinder barrel.

It locks at the 120-degree position.

Normally use it in the locked position.

Although you can open it farther from the lock 

position, once return it to the closed position to 

lock it at the 120-degree position again.

Adjusting the Viewfinder Angle

Lifting Up the Viewfinder Barrel 
and Eyepiece

LCD screen
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To detach the viewfinder barrel

1 Push the clip on the bottom to release.

2 Flip up the viewfinder barrel.

3 Slide the knob on the top to the opposite 

side of the viewfinder barrel.

4 Detach the viewfinder barrel by 

horizontally sliding it.

To reverse the display (image/text indication) 

horizontally

By setting the MIRROR switch on the rear panel 

of the viewfinder to L/R, you can reverse the 

picture and other information displayed in the 

viewfinder horizontally.

To adjust the viewfinder focus

Turn the diopter adjustment ring until the 

viewfinder image is sharpest.

To adjust the viewfinder screen

Adjust the brightness, contrast, and peaking of the 

viewfinder screen with the controls shown below.

By fitting an optional BKW-401 Viewfinder 

Rotation Bracket, you can rotate the viewfinder 

out of the way so that your right leg does not hit 

the viewfinder while you are carrying the 

camcorder.

Adjusting the Viewfinder Focus 
and Screen

Using the BKW-401 Viewfinder 
Rotation Bracket

Diopter adjustment ring

1PEAKING control
2CONTRAST control
3BRIGHT control



Attaching the Viewfinder38

C
h

a
p

te
r 2

  P
re

p
a

ra
tio

n
s

1 Loosen the front-to-back viewfinder 

positioning levers and the front-to-back 

viewfinder positioning knobs, and then 

pull the viewfinder slide assembly 

forward.

2 Using a 2.5 mm diameter hexagonal 

wrench, detach the viewfinder slide 

assembly.

3 Attach the BKW-401 with the supplied 

bolts.

4 Adjust the front-to-back position so 

that the arm of the BKW-401 does not 

touch the handle when it is raised.

You can attach an optional DXF-51 (5-inch) Electronic Viewfinder. To attach it, an Accessory Shoe Kit 

(service part number: A-8274-968-B) is required.

For details, consult a Sony service representative.

Note

It is not possible to use the supplied viewfinder and a 5-inch viewfinder at the same time.

Remove the cover of the grip, and attach the shoe and stopper screw of the Accessory Shoe Kit.

Bolts with 
hexagonal 
hole

Viewfinder slide assembly

Bolts supplied with the BKW-401

Adjust position so that arm 
does not touch handle

Attaching a 5-inch Electronic Viewfinder
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VF cable

Fixing ring

Guide plate

Shoe a)

Stopper screw a)

a) Supplied with the Accessory Shoe Kit
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When using the camcorder for the first 
time

The area of use is not factory preset. Before using 

the camcorder, you need to set this item. (You 

cannot use the camcorder without setting this 

item.)

To set the area of use

1 Set the POWER switch to the ON 

position.

The screen for setting the area of use appears 

in the viewfinder.

2 Press the MENU knob.

The settings for selectable areas of use are 

displayed.

3 Turn the MENU knob to select the 

desired area of use.

a) The composite signal output from this camcorder 

is an NTSC signal with a black setup (7.5 IRE). 

The system frequency is 59.94i.

b) The composite signal output from this camcorder 

is an NTSC signal with no black setup. The 

system frequency is 59.94i.

c) The composite signal output from this camcorder 

is a PAL signal. The system frequency is 50i.

4 Set the following items.

• Time Zone

• Date/Time

See “Basic Setup Menu Operations” (page 94).

5 Turn the MENU knob to select 

“Finish”, then press the MENU knob.

The camcorder is now ready for use.

Setting the Area of Use

MENU knob

POWER switch

Setting Area of use

NTSC Area NTSC area (for areas other 

than Japan) a)

NTSC(J) Area NTSC area (Japan) b)

PAL Area PAL area c)
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You can set or change the date and time of the 

internal clock. The date and time set are reflected 

in the timecode.

For menu operations, see “Basic Setup Menu 

Operations” (page 94).

1 Select MAINTENANCE >Clock Set 

>Date/Time in the setup menu.

2 Press the MENU knob.

The Date/Time setting window appears.

3 Turn the MENU knob to display the 

desired value, and press the knob.

The selection shifts to the next item on the 

right.

4 To continue the remaining settings, 

repeat step 3.

5 Making sure that “SET” is selected, 

press the MENU knob.

The internal clock is set with the date and 

time set in steps 3 and 4.

To cancel the setting

Before executing step 5, push the MENU 

CANCEL/PRST/ESCAPE switch up to the 

CANCEL/PRST side.

First power off the camcorder, and then mount the 

lens using the following procedure.

For information about using the lens, refer to the 

operation manual for the lens.

1 Push the lens locking lever up and 

remove the lens mount cap from the 

lens mount.

2 Align the center pin on the lens with the 

center slot in the lens mount, and insert 

the lens into the mount.

3 Holding the lens in place, push the lens 

locking lever down to lock the lens.

Setting the Date/Time of 
the Internal Clock

Mounting and Adjusting 
the Lens

Lens mount 
securing rubber
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Caution

If the lens is not firmly locked, it may come off 

while the camcorder is being used. This could cause 

a serious accident. Make sure the lens is firmly 

locked. It is recommended that the lens mount 

securing rubber be put on the lens locking lever as 

illustrated above.

4 Connect the lens cable to the LENS 

connector.

5 Secure the lens cable with the cable 

clamps.

If you have attached an aberration correction 

lens

The aberration correction function is activated 

automatically. Starting the camcorder with an 

aberration correction lens may require more time 

than normally because of data loading at start-up.

The lens supplied with the PMW-350K is an 

aberration correction lens. Contact a Sony service 

representative for information about other 

aberration correction lenses.

If the lens does not stay in focus properly as you 

zoom from telephoto to wide angle, adjust the 

flange focal length (the distance from the plane of 

the lens mounting flange to the imaging plane). 

Make this adjustment just one time after 

mounting or changing the lens.

When carrying out the adjustment, use the 

supplied flange focal length adjustment chart as 

the subject.

Note

If you use a subject with insufficient contrast, or 

move the camcorder or subject during 

adjustment, this will cause an adjustment error.

Carrying out the adjustment

When using the auto focus lens

With the lens supplied with the PMW-350K, 

zoom and focus operations automatically adjust 

the flange focal length.

1 Open the iris, position the supplied 

flange focal length adjustment chart 

approximately 3 meters (10 ft) away 

from the camcorder, and arrange the 

lighting to obtain a satisfactory video 

output.

2 Set the ZOOM switch to SERVO 

(power zoom mode).

3 Hold down the flange focal length 

adjustment button for 3 seconds.

The flange focal length adjustment starts.

During adjustment

The message “AUTO FB EXECUTING” 

appears on the viewfinder screen.

If the adjustment completes correctly

The message on the viewfinder screen 

changes to “FB: OK”.

If the flange focal length adjustment does 

not complete correctly

Check the subject and lighting conditions, 

and repeat the adjustment.

When using a non-auto focus lens

1 Set the iris to manual.

2 Open the iris, position the supplied 

flange focal length adjustment chart 

approximately 3 meters (10 ft) away 

from the camcorder, and arrange the 

lighting to obtain a satisfactory video 

output.

3 Loosen the fixing screws on the F.f or 

F.B ring (flange focal length adjustment 

ring).

4 Use manual or power zoom to set the 

lens to telephoto.

5 Point the camcorder at the chart by 

turning the focus ring and focus on it.

Adjusting the Flange Focal Length

About 3 m (10 ft)
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6 Set the zoom ring to wide angle.

7 Turn the F.f or F.B ring until the chart 

is in focus, being careful not to disturb 

the focus ring.

8 Repeat steps 4 to 7 until the chart stays 

in focus all the way from wide angle to 

telephoto.

9 Tighten the F.f or F.B ring fixing 

screws. Attach the supplied microphone to the 

microphone holder of the supplied viewfinder.

1 Loosen the screw and open the 

microphone holder clamp.

2 Place the microphone in the 

microphone holder.

1 Wind the microphone spacer around 

the microphone, while peeling off the 

protective sheets on both sides of the 

microphone spacer.

2 Place the microphone in the holder so 

that “UP” is at the top.

3 Close the microphone holder.

4 Tighten the screw.

Preparing the Audio 
Input System

Connecting a Microphone to the 
MIC IN Connector

Microphone holder clamp
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On how to perform this operation, refer to the 

operation manual for the microphone.

3 Plug the microphone cable into the MIC 

IN connector, then set the AUDIO IN 

switch for the channel on which you 

want to record the audio from this 

microphone to FRONT (for CH-1/CH-2 

switch) or F (for CH-3/CH-4 switch).

4 Secure the microphone cable with the 

cable clamp.

You can connect up to two monaural 

microphones to the AUDIO IN CH1/CH2 

connectors, using an optional CAC-12 

Microphone Holder.

The following is the procedure for attaching an 

electret condenser microphone such as the ECM-

674/678.

On how to attach the CAC-12, refer to the operation 

manual for the CAC-12.

1 Attach the electret condenser 

microphone.

1 Loosen the ball joint lock lever.

2 Wind the microphone spacer (sheet 

type, supplied with the microphone) 

around the microphone, while peeling 

off the protective sheets on both sides 

of the microphone spacer.

3 Place the microphone in the holder so 

that “UP” is at the top.

4 Close the microphone holder.

5 Tighten the screw.

6 Position so that the microphone does 

not interfere with the viewfinder and 

tighten the ball joint lock lever.

Connecting Microphones to the 
AUDIO IN Connectors

Microphone
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2 Connect the microphone cable to the 

AUDIO IN CH1 or CH2 connector. 

3 Set the switches as follows.

• Set the AUDIO IN selectors indicated 

below, depending on the power supply type 

of the microphone.

Internal power supply: MIC

External power supply: +48V

• Set the AUDIO IN CH-1/CH-2 switch for 

the channel to which the microphone is 

connected to REAR.

4 Switch the input level to match the 

sensitivity of the microphone used.

Switch the input level by changing the setting of 

MAINTENANCE >Audio >Rear MIC CH1/

CH2 Ref in the setup menu (factory default 

setting is –60 dB). For details, see page 117.

Notes

• If the input level on the camcorder is not at an 

appropriate setting for the microphone sensitivity, loud 

sounds may be distorted, and the signal-to-noise ratio 

may be affected.

• In order for the AUDIO IN CH1 and CH2 connectors 

on the camcorder to be able to provide a phantom 48 V 

power supply, female XLR connectors (3-pin) are 

fitted. If the microphone cable has a female connector, 

use an adaptor.

• When you detach a CAC-12 Microphone Holder once 

you have attached to the camcorder, be careful not to 

lose the two screws fixing the CAC-12 (in step 1). 

After detaching the CAC-12, be sure to put the two 

screws back into their original places.

To use a Sony UHF wireless microphone system, 

power the camcorder off and then fit one of the 

following UHF portable tuners.

• DWR-S01D Digital Wireless Receiver

• WRR-855S UHF Synthesized Tuner Unit

• WRR-860A/861/862 UHF Synthesized 

Diversity Tuner

For details of these units, refer to the operation 

manuals for them.

To fit the DWR-S01D or WRR-855S

1 Remove the four fixing screws holding 

the cover of the portable tuner/receiver 

housing slot located in the rear of the 

camcorder, to remove the cover.

2 Insert the DWR-S01D or WRR-855S 

into the housing slot, and fasten the four 

fixing screws.

1AUDIO IN selectors
2Monaural microphone
3AUDIO IN CH-1/CH-2 switches
4To AUDIO IN CH1 or CH2 connector

Attaching a UHF Portable Tuner 
(for a UHF Wireless Microphone 
System)
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3 Set the AUDIO IN selector for the 

channel to which you want to input 

audio signal to WIRELESS (see 

page 22).

1 Attach the optional VCT-14/U14 

Tripod Adaptor to the tripod.

2 Mount the camcorder on the tripod 

adaptor.

To remove the camcorder from the tripod 
adaptor

Hold down the red button and pull the lever in the 

direction of the arrow.

DWR-S01D or WRR-855S

Tripod Mounting

Tripod adaptor

Camera mount

Slide the camcorder forward along the 
groove in the adaptor until it clicks.
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Note

The tripod adaptor pin may remain in the engaged 

position even after the camcorder is removed. If this 

happens, press the red button and move the lever as 

shown above until the pin returns to the stowed position. 

If the pin remains in the engaged position, you will not 

be able to mount the camcorder on the tripod adaptor.

With this camcorder, you can use the Anton 

Bauer Ultralight 2 or equivalent video light 

(powered by 12 V with maximum power 

consumption of 50 W).

• If you connect the video light to the LIGHT 

connector on the camcorder and set the LIGHT 

switch to AUTO, you can turn the light on and 

off automatically as you start and stop recording 

on this camcorder.

• The output of the LIGHT connector on the 

camcorder is controlled to 12 V even when the 

camcorder is supplied with over 12 V power 

(through the DC IN connector or battery pack). 

The brightness or color temperature of the light 

will not change according to voltage increase.

Notes

• Do not use a video light with power consumption of 

over 50 W.

• The brightness or color temperature of the light will 

change when the voltage (supplied through the DC IN 

connector or from the battery pack) is under 12 V.

To attach the video light

Fit the video light to the accessory fitting shoe on 

the camcorder grip, and connect the video light 

cable to the LIGHT connector.

Note

The accessory fitting shoe on the camcorder is of the 
1/4-inch tapped hole type. If you want to replace this with 

a slide-type shoe, contact a Sony service representative.

Red button

Lever

Connecting a Video 
Light
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To attach the shoulder strap

1 Fit one of the clips to a shoulder strap 

fitting.

2 Fit the other clip to the shoulder strap 

fitting on the other side of the grip in the 

same way as in step 1.

To remove the shoulder strapUsing the Shoulder 
Strap

Clip

Pull up the strap to lock the fitting.

Press here and pull in the direction 
shown by the arrow to release.



Adjusting the Shoulder Pad Position 49

C
h

a
p

te
r 2

  P
re

p
a

ra
tio

n
s

You can slide the shoulder pad back and forth 

within a 40 mm range. This adjustment helps you 

get the best balance for shooting with the 

camcorder on your shoulder.

1 Raise the lever in the center of the 

shoulder pad to unlock the shoulder 

pad.

2 Slide the shoulder pad backward or 

forward until it is in the most 

convenient position.

3 Bring down the lever to lock the 

shoulder pad in the selected position.

Adjusting the Shoulder 
Pad Position

Shoulder pad
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For menu operations, see “Basic Setup Menu Operations” (page 94).

The following recording formats can be selected for different combinations of video resolution and system 

frequency.

a) 59.94i/29.97P/59.94P/23.98P: When OPERATION >Format >Country in the setup menu is set to [NTSC Area] or 

[NTSC(J) Area]

50i/25P/50P: When OPERATION >Format >Country in the setup menu is set to [PAL Area]

b) 59.94i after 2-3 pulldown is recorded

c) When the optional CBK-DV01 is installed

d) Converted to PsF and recorded

Chapter3 Adjustments and Settings

Setting the Video Format

OPERATION >Format menu settings Video format (recording 

format/system frequency)

Frame size

HD/SD System Line Rec Format System Frequency a)

HD 1080 HQ 1920 59.94i HQ 1920/59.94i 1920×1080

50i HQ 1920/50i

29.97P HQ 1920/29.97P

25P HQ 1920/25P

23.98P HQ 1920/23.98P

HQ 1440 59.94i HQ 1440/59.94i 1440×1080

50i HQ 1440/50i

29.97P HQ 1440/29.97P

25P HQ 1440/25P

23.98P HQ 1440/23.98P

SP 1440 59.94i SP 1440/59.94i

50i SP 1440/50i

23.98P b) SP 1440/23.98P

720 HQ 1280 59.94P HQ 1280/59.94P 720×1280

50P HQ 1280/50P

29.97P HQ 1280/29.97P

25P HQ 1280/25P

23.98P HQ 1280/23.98P

SD — DVCAM c) 59.94i DVCAM/59.94i 720×480

50i DVCAM/50i 720×576

29.97P d) DVCAM/29.97P 720×480

25P d) DVCAM/25P 720×576
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Refer to the above table and change the settings of 

the relevant items.

1 Select OPERATION >Format in the 

setup menu (see page 96).

2 Turn the MENU knob to select the item 

to change, and press the knob.

3 Turn the MENU knob to change the 

setting, and press the knob.

A confirmation message appears.

4 Select [Execute] to execute, or select 

[Cancel] to cancel, and then press the 

MENU knob.

5 When the setting of HD/SD or Country 

was changed, power the camcorder off 

and on again.

To ensure excellent image quality when using this 

camcorder, conditions may require that both the 

black balance and the white balance be adjusted.

Black balance and white balance adjustment 

values that are automatically set by the camcorder 

and the various settings are stored in the 

camcorder memory and retained even when the 

power is turned off.

Black balance adjustment

The black balance will require adjustment in the 

following cases.

• When the camcorder is used for the first time

• When the camcorder has not been used for a 

long time

• When the camcorder is used under conditions in 

which the surrounding temperature has changed 

greatly

• When the GAIN selector (L/M/H/Turbo) values 

have been changed by using OPERATION 

>Gain Switch in the setup menu.

It is not usually necessary to adjust the black 

balance when using the camcorder after it has 

been off.

White balance adjustment

Always readjust the white balance when the 

lighting conditions change.

In automatic black balance mode, adjustments are 

performed in the following order: black set and 

black balance. Manual black balance adjustment 

can be selected from the setup menu.

For details of manual black balance adjustment, 

refer to the Maintenance Manual.

Automatic black balance adjustment is disabled 

in the following case.

• During recording

• In a special recording modes (Picture Cache 

Rec, Interval Rec, Frame Rec, Slow & Quick)

• When i.LINK output is supplied

Changing the Video Format Adjusting the Black 
Balance and the White 
Balance

Adjusting the Black Balance
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• When the shutter mode is SLS

1 Set the OUTPUT/DCC switch to CAM.

2 Push the AUTO W/B BAL switch to 

BLACK and release the switch.

The message “Executing...” appears during 

execution, and changes to “Done” when the 

adjustment finishes. Adjustment values are 

saved to memory automatically.

Notes

• During the black balance adjustment, the iris is 

automatically closed.

• During the black balance adjustment, the gain 

selection circuit is automatically activated so you may 

see flickering on the viewfinder screen, but this is not 

a fault.

If automatic black balance adjustment 
cannot be made

If the black balance adjustment cannot be 

completed normally, an error message will appear 

for about three seconds on the viewfinder screen.

Possible messages are listed below.

If any of the above error messages is displayed, 

retry the black balance adjustment. 

If the error message occurs again, an internal 

check is necessary.

For information about this internal check, refer to 

the Maintenance Manual.

Note

If the lens cable is not firmly connected to the LENS 

connector, it may not be possible to adjust the lens iris. If 

this happens, the black balance will be incorrect.

1 Set the switches and selectors as shown 

below.

• GAIN switch: L (set to a gain value that is 

as small as possible) 

• OUTPUT/DCC switch: CAM

• WHITE BAL switch: A or B a)

a) Adjustment values are saved to memory B only 

when OPEATION >White Setting >White 

Switch<B> in the setup menu, is set to [MEM]. 

2 Set the FILTER selector to suit the 

lighting conditions as follows.

3 Place a white test card under the same 

lighting conditions as for the subject to 

be shot and zoom up to it. 

Alternatively, any white object such as a 

cloth or a wall can be used.

The absolute minimum white area is as 

follows.

Note

Make sure there are not bright spots in the 

rectangle.

4 Adjust the lens iris.

Manually adjusted lens: set the iris to an 

appropriate setting.

Lens with automatic iris: set the automatic/

manual switch on the lens to automatic.

5 Push the AUTO W/B BAL switch to 

WHITE and then release the switch.

Error message Meaning

NG: Iris Not 

Closed

The lens iris did not close; 

adjustment was impossible.

NG: Timeout Adjustment could not be 

completed within the standard 

number of attempts.

NG: Out of 

Range

The difference between the 

reference value and the current 

value is so great that it exceeds 

the range. Adjustment was 

impossible.

Adjusting the White Balance

Rectangle centered on the screen. The 
lengths of the sides are 70% of the length 
and width of the screen.

The white object must be within the 
rectangle and have an area of at least 
10% of the screen.
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The message “Executing...” appears during 

execution, and changes to “OK: (color 

temperature of subject)” when the 

adjustment finishes.

The adjustment values are saved 

automatically in the memory selected in 

step 1 (A or B).

Note

If the camcorder has a zoom lens with an automatic 

iris, the iris may hunt 1) during the adjustment. To 

prevent this, adjust the iris gain knob (indicated as 

IG, IS, or S) on the lens.

For details, refer to the lens operation manual.

1) Hunting: Repeated brightening and darkening of 

the image, resulting from repeated response to 

automatic iris control.

If the automatic white balance adjustment 

cannot be made

If the white balance adjustment cannot be 

completed normally, an error message will appear 

for about three seconds on the viewfinder screen.

Possible messages are listed below.

If any of the above error messages is displayed, 

retry the white balance adjustment. If the error 

message occurs again, an internal check is 

necessary.

For information about this internal check, refer to 

the Maintenance Manual.

If you have no time to adjust the white 
balance

Set the WHITE BAL switch to PRST.

This makes it possible to automatically set the 

white balance to 5600K (factory default value) by 

pressing the COLOR TEMP. button.

The color temperature to which the white balance 

is set when the COLOR TEMP. button is pressed 

can be selected from among 3200K, 4300K, 

5600K, and 6300K on OPERATION 

>Assignable SW in the setup menu. You can also 

assign color temperatures to the ASSIGN. 1/3 

switches or ASSIGNABLE 4/5 switches.

To change the color temperature when 
the ND filter is switched

You can assign electrical CC (color correction) 

filters to ND filters (see page 16). This allows you 

to change the color temperature automatically 

when the ND filter is switched.

1 Set MAINTENANCE >White Filter 

>ND Filter C.Temp in the setup menu 

(see page 123) to On.

2 To assign an electrical CC filter to 

FILTER selector position number 1, 

select [ND FLT C.Temp<1>]. To assign 

it to positions 2 to 4, select [ND FLT 

C.Temp<2-4>].

3 Turn the MENU knob to select the 

desired color temperature.

As you turn the MENU knob, the color 

temperature changes as follows: 3200K y 

4300K y 5600K y 6300K.

4 Repeat steps 2 and 3 as required.

Error message Meaning

NG: Low Light The white video level is too low. 

Either open the lens iris or 

increase the gain.

NG: Timeout Adjustment could not be 

completed within the standard 

number of attempts.

NG: High Light The white video level is too 

high. Either stop down the lens 

iris or change the ND filter.

AUTO W/B BAL switch
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To switch between electrical CC filters 
with an assignable switch

You can assign the function that switches 

between electrical CC filters to an assignable 

switch. This allows you to switch between color 

temperatures (3200K/4300K/5600K/6300K) that 

have been assigned to up to four positions (A to 

D) with each press of the assignable switch.

Regardless of assignments to assignable 

switches, you can also switch between the color 

temperatures assigned to each position from a 

RM-B150/B750 Remote Control Unit.

1 Select MAINTENANCE >White Filter 

in the setup menu (see page 123).

2 Select the position to which to assign a 

CC filter by selecting one of [Electrical 

CC<A>] to [Electrical CC <D>], and 

then turn the MENU knob to select the 

desired color temperature.

As you turn the MENU knob, the color 

temperature changes as follows: 3200K y 

4300K y 5600K y 6300K.

To set no color temperature

Select “-----” with Electrical CC<C> or <D> 

selected.

When the assignable switch is pressed, the 

setting for that position is not displayed. For 

example, if “-----” is set for one position, then 

switching between the remaining three 

positions is carried out.

3 Repeat step 2 as required.

4 Assign the electrical CC filter switching 

function (ELECTRICAL CC) to an 

assignable switch (see page 133).

White balance memory

Values stored in memory are held until the white 

balance is next adjusted even when the camcorder 

power is turned off.

The camcorder has two white balance memories, 

A and B. You can automatically save adjustment 

values for each ND filter in the memory that 

corresponds to the WHITE BAL switch setting 

(A or B). The camcorder has four built-in ND 

filters, allowing you to save a total of eight 

adjustment values (4 × 2). However, the contents 

of the memories are not linked to ND filter 

settings in the following cases.

• When the number of memories allocated to 

each of A and B is limited to one by setting 

OPERATION >White Setting >Filter White 

Memory in the setup menu to Off.

• When the electrical CC filter switching function 

has been assigned to an assignable switch, or 

when a remote control unit has been connected. 

(In these cases, the contents of white balance 

memory are linked to electrical CC filter 

positions (A to D).)

Also, when OPERATION >White Setting 

>White Switch<B> in the setup menu is set to 

[ATW (Auto Tracing White Balance)], and the 

WHITE BAL switch is set to B, the ATW 

function is activated to automatically adjust the 

white balance of the picture being shot for 

varying lighting conditions.
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The shutter modes that can be used with the 

electronic shutter and the shutter speeds that can 

be selected are listed below.

Standard mode

Select this mode for shooting fast-moving 

subjects with little blurring.

You can set the shutter speed in one of two shutter 

modes: Speed mode, in which the speed is set in 

seconds, and Angle mode, in which the speed is 

set in degrees.

Speed mode

a) This speed cannot be selected when the camcorder is 

in Slow & Quick Motion mode and OPERATION 

>Rec Function >Frame Rate in the setup menu is set 

to a value that is greater than the system frequency.

Angle mode

180°, 90°, 45°, 22.5°, and 11.25°

ECS (Extended Clear Scan) mode

Select this mode for obtaining images with no 

horizontal bands of noise when shooting subjects 

such as monitor screens.

As shown in the following tables, the range of 

shutter speeds that can be set varies depending on 

whether the Slow & Quick Motion (S&Q) 

function is on or off.

System lines: 1080

System lines: 720

SLS (slow speed shutter) mode

Select this mode for shooting subjects in low level 

lighting conditions.

Notes

• SLS mode cannot be used when the video format is SP 

1440/23.98P or when the camcorder is in Slow & 

Quick Motion mode.

• It is not possible to output the color bar signal, turn the 

SLS mode on or off, or change the number of 

accumulated frames when the number of accumulated 

frames is set to 16, 32 or 64. 

Notes

• When the automatic iris is used, the iris opens wider as 

the shutter speed increases, thus reducing the depth of 

field.

• The selectable shutter speeds vary depending on the 

current system frequency.

Setting the Electronic 
Shutter

Shutter Modes

System 

frequency

Shutter speed (unit: seconds)

59.94i

59.94P

50i

50P

1/60, 
1/100, 

1/120, 1/125, 1/250, 1/500, 

1/1000, 1/2000

29.97P 1/40
a), 1/50

a)
, 
1/60, 1/100, 

1/120, 1/125, 

1/250, 1/500, 1/1000, 1/2000

25P 1/33
 a), 1/50

a), 1/60, 
1/100, 1/120, 

1/125, 

1/250, 1/500, 1/1000, 1/2000

23.98P 1/32
 a), 1/48

a), 1/50
a), 1/60, 1/96, 1/100, 

1/120, 
1/125, 1/250, 1/500, 1/1000, 1/2000

System 

frequency

Shutter speed (unit: Hz)

S&Q: Off S&Q: On

59.94i 60.00 to 3800 —

50i 50.00 to 3500 —

29.97P 29.99 to 4100 32.01 to 4100

23.98P 23.99 to 3700 32.02 to 3700

25P 25.00 to 3900 32.03 to 3900

System 

frequency 

Shutter speed (unit: Hz)

S&Q: Off S&Q: On

59.94P 60.07 to 4100 32.01 to 4100

50P 50.03 to 3900 32.03 to 3900

29.97P 29.99 to 4100 32.01 to 4100

23.98P 23.99 to 3700 32.02 to 3700

25P 25.00 to 3900 32.03 to 3900

Number of accumulated frames

2, 3, 4, 5, 6, 7, 8, 16, 32, 64

Selecting the Shutter Mode and 
Shutter Speed
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To switch between Speed mode and 
Angle mode

1 Select OPEARTION >Shutter Select 

>Shutter Select in the setup menu (see 

page 108).

2 Turn the MENU knob to select Second 

or Degree, and then press the knob.

To set the shutter mode and standard-
mode shutter speed

Once the shutter speed is selected, it is retained 

even when the camcorder power is turned off.

1 Push the SHUTTER selector from ON 

to SELECT.

The current shutter setting indication appears 

for about three seconds.

2 Before the shutter setting indication 

disappears, push the SHUTTER 

selector down to SELECT again and 

repeat this until the desired mode or 

speed appears.

When all modes and speeds are displayed, 

the display changes in the following order.
 

Note

Depending on the frame rate setting (see page 78), some 

shutter speeds cannot be selected in Slow & Quick 

Motion mode. These speeds are replaced by the slowest 

selectable shutter speed.

Example: If you perform Slow & Quick Motion 

shooting when setting the frame rate to 60 and the video 

format to HQ1280/29.97P

The shutter speed is indicated as follows.

When Slow & Quick Motion mode is off

1/40t1/50t1/60t1/100t...

When Slow & Quick Motion mode is on

1/60t1/60t1/60t1/100t...

To set the shutter speed in ECS or SLS 
mode

1 Set the shutter mode to ECS or SLS (see 

the previous item).

2 Turn the MENU knob to select the 

desired frequency or number of frames.

Speed Mode (with system frequency 59.94i)

ECS ModeSLS Mode
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The reference value for automatic iris adjustment 

can be changed to aid the shooting of clear 

pictures of back-lit subjects, or to prevent blown-

out highlights. The reference value for the lens 

iris can be set within the following range with 

respect to the standard value.

• 0.25 to 1 (increasing by increments of 0.25): 

About 0.25 to 1 stop further open

• –0.25 to –1 (decreasing by increments of 0.25): 

About 0.25 to 1 stop further close

Also you can set the area where light detection 

occurs.

To change the reference value

1 Set OPERATION >Auto Iris >Iris 

Override in the setup menu to On (see 

page 106).

2 Set the MENU ON/OFF switch to OFF.

3 Turn the MENU knob to change the 

reference value.

Note

Be sure to confirm that the current shutter mode is 

not ECS.

An indicator of the current reference value is 

shown at the iris position indication (see 

page 31) on the viewfinder screen.

To make the iris more open

Turn the MENU knob counterclockwise as 

seen from the front of the camcorder.

Select one of 0.25, 0.5, 0.75, or 1.

To stop down the iris

Turn the MENU knob clockwise as seen 

from the front of the camcorder.

Select one of –0.25, –0.5, –0.75, or –1.

The changed reference value is retained until 

the power of the camcorder is turned off.

Even if the reference value is changed, it 

reverts to the standard value every time the 

power is turned on.

To set the automatic iris window

1 Set OPERATION >Auto Iris >Iris 

Window Indication in the setup menu to 

On.

The current automatic iris window appears 

on the viewfinder screen.

If it is not necessary to display the auto iris 

window on the screen, set to Off.

2 Turn the MENU knob to select Iris 

Window, and then press the knob.

3 Turn the MENU knob until the desired 

auto iris window appears, and then 

press the knob.

If you select “Var”, the following items 

become effective and you can set the window 

of the desired size. Set the following items 

with MAINTENANCE >Auto Iris2.

When you exit the menu, the auto iris window 

selected in step 3 appears.

Unless you need to keep this window displayed, 

set OPERATION >Auto Iris >Iris Window 

Indication in the setup menu to Off. 

To counter problems with very bright 
highlights

If the subject is too bright, the iris may close too 

much, leaving the overall image dark, or the 

highlights may be blown out. In such cases, 

setting the highlight clip function on reduces the 

luminance range, avoiding problems from the 

automatic iris correction.

Set OPERATION >Auto Iris >Clip High Light in 

the setup menu to On.

Changing the Reference 
Value for Automatic Iris 
Adjustment

Item Setting

Iris Var Width The width of the window

Iris Var Height The height of the window

Iris Var H Pos The position of the window 

in the horizontal direction

Iris Var V Pos. The position of the window 

in the vertical direction.

The shaded parts indicate the 
area where light detection
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The lens supplied with the PMW-350K allows 

you to shoot with manual and servo zooming.

Set the ZOOM switch to SERVO (servo zoom) or 

MANU (manual zoom).

With the ZOOM switch set to MANU, turn the 

zoom ring.

With the ZOOM switch set to SERVO, operate 

the power zoom lever. The current lens zoom 

position appears in the viewfinder, over the range 

0 (wide-angle) to 99 (telephoto) (see page 29).

Push to the W (wide) side when you want wide-

angle, and push to the T (telephoto) side when 

you want telephoto. The zoom speed increases 

when you push the lever deeply, and decreases 

when you push less deeply.

The lens supplied with the PMW-350K allows 

you to adjust the focus in the following three 

ways.

Full MF (full manual focus) mode

This mode supports focusing with the focus ring 

only.

Without changing your grip, you can focus all the 

way from ∞ to the shortest shooting distance.

MF (manual focus) mode

In this mode, auto focus is enabled temporarily 

when you press the PUSH AF button.

You can also use the MF assist function. 

AF (auto focus) mode

In this mode, auto focus is always enabled.

The focus ring and the PUSH AF button are also 

enabled.

Note

The lens is designed with an extra margin at the infinity 

position (∞), to compensate for focus drifting due to 

variations in temperature. When shooting a subject at 

infinity in MF or Full MF mode, check the picture in the 

viewfinder as you focus.

When you slide the focus ring back (toward the 

camcorder), the focus mode becomes Full MF 

mode, in which all focus adjustments are manual.

Note

When you slide the focus ring back, the focus instantly 

moves to the mark position.

Focus by turning the focus ring while viewing the 

viewfinder.

The distance indications on the ring are valid in 

Full MF mode. The distances where the picture is 

in focus correspond to absolute positions of the 

focus ring.

Zooming

Switching between Zoom Modes

Using Manual Zoom

Using Servo Zoom

Adjusting the Focus

Adjusting in Full MF Mode
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Peaking

You can turn the PEAKING knob on the 

viewfinder to use the peaking function. Edges are 

emphasized in the monitor picture, which 

facilitates manual focusing.

The recorded video signals are not affected.

When you slide the focus ring forward (toward 

the lens hood), and set the FOCUS switch to M 

(manual), the focus mode becomes MF mode, in 

which focus adjustments are manual but auto 

focus is available only when necessary.

Using the focus ring

Focus by turning the focus ring while viewing the 

viewfinder.

The distance indications on the ring are invalid in 

MF mode. 

One-push auto focus

Press the PUSH AF button. Auto focus is enabled 

temporarily (one-push auto focus).

One-push auto focus ends when the subject is 

brought into focus.

MF assist function 

When the MF assist function is on, auto focus 

starts when you stop adjusting with the focus ring, 

enabling fine adjustments with the subject at the 

center of the screen.

Auto focusing by the MF assist function ends 

when the fine adjustments end.

When you slide the focus ring forward, and set the 

FOCUS switch to A (auto), the focus mode 

becomes AF mode, in which auto focus is always 

active.

The distance indications on the ring are invalid in 

AF mode.

Focusing in AF mode

In AF mode, the camcorder monitors the video 

for changes, and starts auto focus whenever it 

detects a change. Auto focusing ends when the 

subject is in focus, but the auto focus function 

remains on standby.

In AF mode, you can also start auto focusing by 

pressing the PUSH AF button or by turning the 

focus ring.

When the focus mode is MF or AF, you can set 

the MACRO switch to the ON side to enable 

macro mode. Macro mode allows you to focus 

over the range that includes the macro area.

Macro mode is disabled in Full MF mode.

Adjusting in MF Mode

White line indicating the current distance

Focus ring

Distance indication

Adjusting in AF Mode

Using Macro Mode
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When you set the AUDIO SELECT switch to 

AUTO, the input levels of analog audio signals 

recorded on each channel are adjusted 

automatically. You can also make manual 

adjustments.

Note

Even if you set the AUDIO SELECT switch to AUTO, 

the input levels of digital audio signals are not adjusted 

automatically.

Target audio level for manual audio level 

adjustment

Make adjustment using –20 dB as the target level.

If the audio level meter shows a maximum level 

of 0 dB, then it indicates that the input audio level 

is excessive.

1 To adjust the signal input to the AUDIO 

IN CH1 or CH2 connector, set the 

AUDIO IN CH-1 or CH-2 switch to 

REAR.

To adjust both input signals, set both 

switches to REAR.

2 Set the AUDIO SELECT switch(es) 

corresponding to the channel(s) selected 

in step 1 to MANUAL.

3 With the LEVEL control(s) for the 

channel(s) selected in step 1, adjust so 

that the audio level meter shows up to 

–20 dB for a normal input volume. 

Correspondence between recording level 
adjustments and audio level controls

On MAINTENANCE >Audio in the setup menu, 

you can select which audio level control controls 

the audio recording level of the input to each of 

the AUDIO IN CH1/CH2 connectors. The 

correspondences between the settings of the menu 

items and the controls are as follows.

Rear1/WRR Level: Channel 1 recording level

Rear2/WRR Level: Channel 2 recording level

Note

When you have operation of the LEVEL (CH-1/CH-2) 

controls and MIC LEVEL control linked together, if the 

MIC LEVEL control is set to 0, the audio signals on 

channels 1 and 2 cannot be recorded. Check the position 

of the MIC LEVEL control before adjusting the LEVEL 

(CH-1/CH-2) controls.

1 Set either or both of the AUDIO IN 

switch(es) to FRONT.

2 Set the AUDIO SELECT switch(es) for 

the desired channel(s) selected in step 1 

to MANUAL.

Adjusting the Audio 
Level

Manually Adjusting the Audio 
Levels of the Audio Inputs from 
the AUDIO IN CH1/CH2 
Connectors

Target input level

Excessive input level

Setting Knob

Side1 LEVEL (CH1) knob

Front MIC LEVEL knob

Front+Side1 LEVEL (CH1) knob and MIC 

LEVEL knob (linked operation) 

Setting Knob

Side2 LEVEL (CH2) knob

Front MIC LEVEL knob

Front+Side2 LEVEL (CH2) knob and MIC 

LEVEL knob (linked operation)

Manually Adjusting the Audio 
Level of the MIC IN Connector
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3 Turn the MIC LEVEL control, and 

adjust so that the audio level meter 

shows up to –20 dB for a normal input 

volume.

Correspondence between recording level 
adjustments and audio level controls

On MAINTENANCE >Audio in the setup menu, 

you can select which audio level control controls 

the audio recording level of the front microphone 

input. The correspondences between the settings 

of the menu items and the controls are as follows.

MIC CH1 Level: Channel 1 recording level

MIC CH2 Level: Channel 2 recording level

Note

When you have operation of the MIC LEVEL control 

and LEVEL (CH-1/CH-2) controls linked together, if the 

LEVEL (CH-1/CH-2) controls are set to 0, the audio 

signals on channels 1 and 2 cannot be recorded. Check 

the position of the LEVEL (CH-1/CH-2) controls before 

adjusting the MIC LEVEL control.

Selecting the recorded audio

You can select the audio recorded on audio 

channels 3 and 4 with the AUDIO IN CH3/CH4 

switches.

You can have the selection made automatically, 

as follows.

To automatically select the same audio as on 

channels 1 and 2

Set MAINTENANCE >Audio >Audio CH3/4 

Mode of the setup menu to [CH 1/2].

Adjusting the audio recording levels

To adjust automatically

Set the AUDIO SELECT CH 3-4 switch to 

AUTO.

To adjust manually

1 Set the AUDIO SELECT CH 3-4 switch 

to MANUAL.

2 Select the knobs that adjust the audio 

levels with the Audio CH3 Level and 

Audio CH4 Level items under 

MAINTENANCE >Audio in the setup 

menu.

Audio CH3 Level: Channel 3 recording 

level

Audio CH4 Level: Channel 4 recording 

level

Setting Knob

Side1 LEVEL (CH1) knob

Front MIC LEVEL knob

Front+Side1 LEVEL (CH1) knob and MIC 

LEVEL knob (linked operation)

Setting Knob

Side2 LEVEL (CH2) knob

Front MIC LEVEL knob

Front+Side2 LEVEL (CH2) knob and MIC 

LEVEL knob (linked operation)

Recording Audio on Channels 3 
and 4

CH3 switch Channel 3 recording target

FRONT Front microphone audio

REAR Audio signal input to AUDIO IN 

CH1 connector

WIRELESS Wireless microphone audio

CH4 switch Channel 4 recording target

FRONT Front microphone audio

REAR Audio signal input to AUDIO IN 

CH2 connector

WIRELESS Wireless microphone audio

Setting Knob

Side3 LEVEL (CH3) knob

Front MIC LEVEL knob

Front+Side3 LEVEL (CH3) knob and 

MIC LEVEL knob (linked 

operation)
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You can now adjust the levels of audio 

channels 3 and 4 with the knobs selected 

here.

Note

When picture cache mode is enabled, it is not possible to 

set time data, even if you set the F-RUN/SET/R-RUN 

switch to SET. If you want to set time data, first exit 

picture cache mode.

The timecode setting range is from 00 : 00 : 00 : 

00 to 23 : 59 : 59 : 29 (hours : minutes : seconds : 

frames).

1 Set the DISPLAY switch to TC.

2 Set the PRESET/REGEN/CLOCK 

switch to PRESET.

3 Set the F-RUN/SET/R-RUN switch to 

SET.

The first (leftmost) digit of timecode flashes.

4 Use the up and down arrow buttons to 

change values, and use the left and right 

arrow buttons to move the flashing 

digit. Repeat until all digits are set.

To reset the timecode value to 00:00:00:00

Press the RESET/RETURN button.

5 Set the F-RUN/SET/R-RUN switch to 

F-RUN or R-RUN.

F-RUN: Free run. The timecode generator 

keeps running.

R-RUN: Recording run. The timecode 

generator runs only while recording.

To set the drop frame mode/non-drop frame 

mode

You can select the drop frame (DF) mode or non-

drop frame (NDF) mode on MAINTENANCE 

>Timecode in the setup menu.

Setting Knob

Side4 LEVEL (CH4) knob

Front MIC LEVEL knob

Front+Side4 LEVEL (CH4) knob and 

MIC LEVEL knob (linked 

operation)

Setting the Time Data

Setting the Timecode
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To make the timecode consecutive

When the F-RUN/SET/R-RUN switch is set to 

R-RUN, recording a number of scenes on the 

media normally produces consecutive timecode. 

However, once you remove the media and record 

on another media, the timecode will no longer be 

consecutive when you use the original media 

again for recording. In this case, to make the 

timecode consecutive, set the PRESET/REGEN/

CLOCK switch to REGEN. 

Saving the real Time in the Timecode

Setting the PRESET/REGEN/CLOCK switch to 

CLOCK saves the real time in the timecode.

When it is necessary to set the actual time, use 

MAINTENANCE >Clock Set >Date/Time in the 

setup menu.

For details, see “Setting the Date/Time of the 

Internal Clock” (page 41).

By setting the user bits (up to 8 hexadecimal 

digits), you can record user information such as 

the date, time, or scene number on the timecode 

track.

1 Set the DISPLAY switch to U-BIT.

2 Set the F-RUN/SET/R-RUN switch to 

SET.

The first (leftmost) digit flashes.

3 Use the up and down arrow buttons to 

change values, and use the left and right 

arrow buttons to move the flashing 

digit. Repeat until all digits are set.

To reset the user bit data to 00 00 00 00

Press the RESET/RETURN button.

4 Set the F-RUN/SET/R-RUN switch to 

F-RUN or R-RUN, corresponding to the 

desired operating mode for the 

timecode generator.

To store the user bit setting in memory

The user bit setting (apart from the real time) is 

automatically retained in memory even when the 

power is turned off.

You can synchronize the internal timecode 

generator of this camcorder with an external 

generator for the regeneration of an external 

timecode. You can also synchronize the timecode 

generators of other camcorders/VTRs with the 

internal generator of this camcorder.

Connections for timecode 
synchronization

Connect both the reference video signal and the 

external timecode as illustrated below.

Example 1: Synchronizing with an external 

timecode

Setting the User Bits

Synchronizing the Timecode

External timecode

1GENLOCK IN connector
2TC IN connector

Reference video signal
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Example 2: Interconnecting a number of 

camcorders (including one reference 

camcorder) 

To lock the timecode to an external 
source

1 Turn on the POWER switch.

2 Set the PRESET/REGEN/CLOCK 

switch to PRESET.

3 Set the F-RUN/SET/R-RUN switch to 

F-RUN.

4 Set the DISPLAY switch to TC.

5 Supply a timecode signal and a 

reference video signal complying with 

the SMPTE standard and in proper 

phase relationship, to the TC IN 

connector and to the GENLOCK IN 

connector, respectively.

This operation synchronizes the internal 

timecode generator with the external 

timecode. After about 10 seconds, you can 

disconnect the external timecode without 

losing the synchronization.

Notes

• When you finish the above procedure, the internal 

timecode is immediately synchronized with the 

external timecode and the counter display will show 

the value of the external timecode. However, wait for 

a few seconds until the sync generator stabilizes before 

recording.

• If the frequency of the reference video signal is not the 

same as the system frequency of the camcorder, the 

camcorder cannot be correctly genlocked. In such a 

case, the internal timecode is not correctly 

synchronized with the external timecode.

User bit settings during timecode 

synchronization

When the timecode is synchronized, only the time 

data is synchronized with the external timecode 

value.

To release the timecode synchronization

First disconnect the external timecode, then set 

the F-RUN/SET/R-RUN switch to R-RUN.

To change the power supply from the battery 

pack to an external power supply during 

timecode synchronization

To maintain a continuous power supply, connect 

the external power supply to the DC IN connector 

before removing the battery pack. You may lose 

timecode synchronization if you remove the 

battery pack first.

Camcorder synchronization during timecode 

synchronization

During timecode synchronization, the camcorder 

is genlocked to the reference video signal input 

from the GENLOCK IN connector.

1VIDEO OUT connector
2TC OUT connector
3TC IN connector
4GENLOCK IN connector

To another camcorder to be synchronized
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The status screens allow you to check camcorder 

settings and various types of status information.

There are five status screens, listed below.

To display status screens

With no menu is displayed, push the STATUS 

ON/SEL/OFF switch up to the ON/SEL side. 

Each push selects the next status screen, in the 

order given in the table above. 

CAMERA status screen

This screen displays settings and status 

information related to shooting.

White Bal: White balance status 

Gain: GAIN switch status 

Zoom Speed: Zoom speed set with the lens 

ZOOM button

Zebra: Zebra status 

Skin Tone Detail: Skin details status 

AUDIO status screen

This screen displays settings and status 

information related to audio input and output.

CH-1/CH-2/CH-3/CH-4: Audio level meters 

and input sources 

Wind Filter: Wind filter settings

VIDEO status screen

This screen displays settings and status 

information related to recording and playback.

Video Format: Video format

Rec Mode: Recording bit rate (HD mode only) 

Output&i.LINK: Output&i.LINK setting and 

i.LINK usage status

SDI Output: HD/SD SDI OUT connector output 

setting 

HDMI Output: HDMI connector output setting

Down Converter: SD output down converter 

setting (HD mode only)

ASSIGN SWITCH status screen

This screen displays the names of the functions 

assigned to assignable switches

Checking Camcorder 
Settings and Status 
Information (Status 
Screens)

Status screen Information displayed

CAMERA status Settings and status information 

related to shooting

AUDIO status Settings and status information 

related to audio input and 

output

VIDEO status Settings and status information 

related to recording and 

playback 

ASSIGN 

SWITCH status

Names of functions assigned 

to assignable switches

BATTERY/

MEDIA status

Status of the battery mounted 

on the camcorder and the 

media status



Checking Camcorder Settings and Status Information (Status Screens)66

C
h

a
p
te

r 3
  A

d
ju

s
tm

e
n

ts
 a

n
d

 S
e

ttin
g

s

BATTERY/MEDIA status screen

This screen displays the status of the battery 

mounted on the camcorder and the media status.

Battery: The remaining battery capacity 

Charge Count: The number of times the battery 

has been charged 

HDD A/HDD B: Remaining battery capacity of 

PHU-60K/120K/120R

Media A/Media B: 

• Remaining capacity of media

• Recordable time

• Approximate writable lifetime (Life)

“Life 100%” is shown for unused media.
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This camcorder records video and audio on S×S 

memory cards (not supplied) loaded into one or 

both of its memory card slots.

The PHU-60K/120K/120R Professional Hard 

Disk Unit or MEAD-MS01 Media Adaptor can 

also be used for recording. For details, refer to the 

Supplement supplied in the CD-ROM (labeled 

“Manuals for Solid-State Memory Camcorder”).

S×S memory cards that can be used with 
this camcorder

Use the following Sony S×S memory cards (S×S 

PRO or S×S-1) with this camcorder.

S×S PRO

• SBP-8 (8 GB)

• SBP-16 (16 GB)

• SBP-32 (32 GB)

S×S-1

SBS-32G1 (32 GB)

Proper operation cannot be guaranteed when 

memory cards other than S×S PRO and S×S-1 are 

used.

The memory cards listed above comply with the 

ExpressCard memory card standard.

• S×S, S×S PRO and S×S-1 are trademarks of 

Sony Corporation.

• The ExpressCard label and logo are property of 

the Personal Computer Memory Card 

International Association (PCMCIA) and are 

licensed to Sony Corporation. Other trademarks 

and trade names are the property of their 

respective owners.

Notes on the use of S×S memory cards

• Recorded data may be lost or corrupted in the 

following cases.

- When the camcorder is subjected to shock or 

vibrations during reading, writing, or 

formatting of an S×S memory card, and when 

the camcorder is powered off or an S×S 

memory card is removed during reading, 

writing, or formatting

- When the camcorder is used in an 

environment subject to static electricity or 

electric noise

• Do not use or store S×S memory cards in 

locations that are:

- Outside the specified environmental ranges

- Very hot, such in as vehicles parked in the sun 

during summer, or exposed to direct sunlight, 

or near heaters

- Subject to high humidity and corrosion

• When inserting a memory card, insert with the 

label side facing the correct direction.

• Carry and store S×S memory cards in their 

cases, and lock the cases securely.

• Guard against accidents and inadvertent data 

loss by backing up the data stored on S×S 

memory cards. Sony cannot be responsible for 

any consequences of damage to or loss of data 

stored on S×S memory cards.

• Do not attach anything other than the supplied 

labels in the designated label space. When 

attaching a label, make sure it does not protrude 

beyond the label space.

Chapter4 Shooting

Handling S×S Memory 
Cards

About S×S Memory Cards
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• Use this camcorder to format S×S memory 

cards that will be used with this camcorder. 

When memory cards are formatted on another 

unit, the format is regarded as an invalid format, 

making it necessary to format the memory cards 

again. 

However, note that the format and delete 

functions of this camcorder do not completely 

remove data from memory cards. Before 

discarding or disposing of a memory card, erase 

it using commercial data erasure software, or 

physically destroy it. Sony cannot be 

responsible for any failure to erase data 

completely.

• Clip operations may not be possible when the 

remaining capacity of the media is low. In this 

case, use a computer to delete unneeded files 

and try again.

• Open the memory card case completely before 

storing a card in the case or removing a card 

from the case.

Preventing accidental erasure

You can prevent accidental recording, editing, 

and deletion of data on an S×S memory card by 

setting the write protect switch to the WP side.

Note

Do not touch the write protect switch while an S×S 

memory card is loaded in a card slot. Eject the card 

before setting the write protect switch.

To load S×S memory cards

1 Slide the cover to the left to open.

2 Insert an S×S memory card into a card 

slot.

The ACCESS lamp lights in orange, and then 

lights in green to indicate that the memory 

card is usable.

3 Close the cover.

ACCESS lamp status indications

Card slots A and B each have an ACCESS lamp 

to indicate the slot status.

S
xS

 P
R

O
   8

G
B

Label space

Write protect switch

Loading and Ejecting S×S Mem-
ory Cards

Lamp Slot status

Lights in orange Accessing the S×S memory card 

(lights during data reading and 

writing)

Lights in green Standby (the loaded S×S 

memory card is ready for 

recording or playback)

Not lit • No S×S memory card is loaded.

• An unusable card is loaded.

• An S×S memory card is loaded, 

but the other slot is selected. 

Insert with the label 
side facing right.
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To eject S×S memory cards

1 Open the cover, and then press the 

EJECT button to release the lock and 

pull the button out.

2 Press the EJECT button again to eject 

the card.

Note

Data integrity cannot be guaranteed if you power the 

camcorder off or remove a memory card while the card 

is being accessed. Doing so may corrupt all data recorded 

on the card. Always make sure that the ACCESS lamp is 

lit green or not lit before you power the camcorder off or 

remove a memory card.

When S×S memory cards are loaded in both slot 

A and slot B, you can press the SLOT SELECT 

button to select the S×S memory card to use.

The camcorder switches automatically to the 

other card if the selected card becomes full during 

recording.

Note

The SLOT SELECT button is disabled during playback. 

Even when pressed, it does not change the selected slot. 

Button operations are enabled when a thumbnail screen 

(see page 80) is displayed.

When you load an unformatted S×S memory 

card, or load an S×S memory card that has been 

formatted to other specifications, a message 

“Cannot Use Media(A)/Unsupported File 

System” appears in the viewfinder. In this case, 

format the memory card in the following way.

Note

S×S memory cards must be formatted on an 

XDCAM EX device. Cards in other formats 

cannot be used.

To format (initialize) a memory card

1 Select OPERATION >Format Media in 

the setup menu (see page 97).

2 Select [Media(A)] (slot A) or [Media(B)] 

(slot B).

3 Turn the MENU knob to select 

“Execute”, and then press the knob.

The confirmation message for formatting is 

displayed on the viewfinder screen.

4 Turn the MENU knob to select 

“Execute”, and press the knob.

Execution of the format starts.

During execution of the format, a progress 

indication appears (%), and the ACCESS 

lamp lights in orange.

A completion message appears for three 

seconds when the format finishes.

Recording and playback during format execution

Even during execution of a format, recording and 

playback are possible using an S×S memory card 

loaded into the other card slot.

Selecting the S×S Memory Card to 
Use

Press the button once 
to release the lock.

Formatting (Initializing) S×S 
Memory Cards
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If the format operation fails

A format operation may fail because the S×S 

memory card is write protected, or because it is 

not the type of card specified for use with this 

camcorder.

In this case, an error message appears. Following 

the instructions in the error message and 

exchange the card for an S×S memory card that 

can be used with this camcorder.

Notes

• All data is erased when you format a memory card, 

including setup files and all of the recorded video data.

• Use the format function of this camcorder to format 

S×S memory cards for use on this camcorder. The 

formats of cards formatted on other devices are not 

recognized as valid formats, making it necessary to 

format them again on this camcorder.

You can check the remaining capacity of the S×S 

memory cards loaded in the two slots by checking 

the recording media remaining capacity display 

in the viewfinder.

The camcorder calculates the remaining 

recording time for the media in each slot on the 

basis of the current video format (recording bit 

rate), and displays it in units of minutes.

You can also check the remaining time in the 

BATTERY/MEDIA status screen (see page 66).

Note

The  mark appears when a memory card is write 

protected.

When to exchange S×S memory cards

• The warning message “Media Near Full” 

appears, the WARNING indicator and the REC 

indication on the viewfinder screen flash, and 

the buzzer sounds when the total remaining 

recording time of the two memory cards falls to 

five minutes during recording.

Exchange one of the cards for media with 

available recording capacity.

• If you continue recording, the message “Media 

Full” appears and recording stops when the total 

remaining recording time falls to 0.

Note

About up to 600 clips can be recorded on one S×S 

memory card.

The display of remaining recording time changes to “0” 

and the message “Media Full” appears when the clip 

limit is reached.

If for any reason an error should occur in a 

memory card, the card must be restored before 

use.

When you load an S×S memory card that needs to 

be restored, a message appears in the viewfinder 

to ask whether you want to restore it.

To restore a card

Turn the MENU knob to select [Execute], and 

then press the knob.

The restoration starts.

During the restoration, a execution message 

appears, the progress is displayed (%), and the 

ACCESS lamp lights in orange.

When the restoration finishes, a completion 

message is displayed for three seconds.

If restoration fails

• Write protected S×S memory cards and cards 

on which memory errors have occurred cannot 

be restored. A warning message appears for 

such cards. Follow the instructions in the 

message and unprotect the card or replace it 

with another card.

• S×S memory cards on which memory errors 

have occurred may become usable if they are 

reformatted.

• In some cases, some clips can be restored while 

others cannot. The restored clips can be played 

normally.

• If the message “Could not Restore Some Clips” 

keeps appearing after repeated attempts at 

restoration, it may be possible to restore the S×S 

memory card with the following procedure.

1 Use the camcorder’s copy function 

(see page 87) or the XDCAM EX Clip 

Browsing Software (see page 143) to 

copy the required clips to another S×S 

memory card.

Checking the Remaining 
Recording Time

Restoring S×S Memory Cards
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2 Format the unusable S×S memory card 

on the camcorder.

3 Copy the required clips back to the 

newly formatted S×S memory card.

Recording and playback during restoration

Even while restoration is in progress, you can 

record and play an S×S memory card in the other 

card slot. This section explains the basic shooting and 

recording procedures.

Before starting to shoot, inspect the camera 

system to verify that it is operating properly.

1 Attach a fully charged battery pack (see 

page 33).

2 Load one or two S×S memory cards (see 

page 68).

If you load two cards, the camcorder 

switches automatically to the second card 

when the first card becomes full.

3 Set the camcorder’s POWER switch 

(see page 14) to ON.

4 Make the following settings.

Marker display: On (see page 103)

Iris: Auto (see page 57)

Zoom: Auto (see page 58)

Camera output: Select the picture currently 

being shot (camera picture), and turn the 

DCC function on (see page 18).

Timecode advance mode: F-RUN (Free 

Run) or R-RUN (Rec Run) (see page 62)

Audio input channel selection: Auto (see 

page 24)

5 Push the AUTO W/B BAL switch to the 

BLACK side to adjust the black balance 

(see page 51).

6 Select a filter according to the lighting 

conditions, and adjust the white balance 

(see page 52).

7 Point the camcorder at the subject, and 

adjust the focus (see page 58) and zoom.

8 If you are using the electronic shutter, 

select an appropriate shutter mode and 

speed (see page 55).

9 Do one of the following to start 

recording.

Basic Operations
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- Press the REC START button (see 

page 16).

- Press the VTR button on the lens (see 

page 27).

- Turn on the assignable switch to which the 

Rec function has been assigned (see 

page 132).

During recording, the TALLY indicators, the 

tally indicator on the front panel of the 

viewfinder, and the REC indication on the 

viewfinder screen light. Adjust the zoom and 

focus as required.

Notes

• Never remove the battery pack while the 

camcorder is recording (while an ACCESS lamp 

is lit). Doing so risks the loss of several seconds 

of data before the recording was interrupted, 

because internal processing will not end 

normally.

• The playback control buttons (EJECT, F REV, F 

FWD, NEXT, PREV, PLAY/PAUSE, STOP) do 

not function during recording.

10 To stop recording, perform one of the 

operations listed in step 9.

The TALLY indicators, the tally indicator on 

the front panel of the viewfinder, and the 

REC indication on the viewfinder screen go 

out, and camcorder enters recording standby 

(STBY) mode.

A clip is created from the video shot between 

steps 9 and 10.

To check the recording (recording review)

With the camcorder in recording standby 

(STBY) mode, turn on the assignable switch 

to which the Rec Review function or the 

Freeze Mix function has been assigned (see 

page 131).

The camcorder plays the entire last clip, or 

the last few seconds of that clip (3 seconds or 

10 seconds), and then returns to standby 

mode.

You can use MAINTENANCE >Camera 

Config >Rec Review in the setup menu (see 

page 122) to change the playback time.

When the Rec Review function is assigned to 

the RET button on the lens, you can also 

conduct a review by using the RET button.

11 Repeat steps 9 and 10 to continue 

recording.

With each repetition, another clip is created 

on the memory card.

Notes

• You cannot resume recording for about one second 

after stopping recording.

• The maximum number of clips that can be recorded on 

one memory card is 600. Even if the memory card has 

enough free capacity to record more clips, when 600 

clips have been recorded, no further recording is 

possible.

Notes on Clips

The XDCAM EX-series products limit the 

maximum file size of an HD clip to 4 GB and that 

of an SD clip to 2 GB. 

If you continue recording for an extended period, 

recorded materials may be segmented into 

multiple files, depending on the file size (the 

maximum number of partitions is 99). 

The camcorder regards continuous recording as 

one clip even if it has been segmented into 

multiple files.

When the camcorder is in standby (STBY) mode, 

you can play all or part of the most recently 

recorded clip (see page 72).

1 Insert the S×S memory card to play (see 

page 68).

2 Press the PREV button (see page 20) or 

the F REV button (see page 20) to cue 

up the clip to play.

3 Press the PLAY/PAUSE button.

The PLAY/PAUSE indicator lights, and the 

playback picture appears in the viewfinder.

To pause the playback

Press the PLAY/PAUSE button.

The PLAY/PAUSE indicator flashes during 

pause.

Press the button again to return to playback mode.

Playing Recorded Clips

Clip 1 Clip 2 Clip 3
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To play at high speed

Press the F FWD button (see page 20) or the 

F REV button (see page 20).

To return to normal playback, press the PLAY/

PAUSE button.

To switch between memory cards

When two memory cards are loaded, press the 

SLOT SELECT button (see page 23) to select the 

active slot.

It is not possible to switch between memory cards 

during playback.

To end playback

Press the STOP button: Playback stops, and the 

camcorder enters E-E mode.

Press the THUMBNAIL button: Playback 

stops, and a thumbnail screen (see page 80) 

appears in the viewfinder.

Playback also stops and the timecode screen 

appears in the viewfinder when you start 

recording during playback, and when you eject an 

S×S memory card.

You can use the assignable switches to delete the 

last recorded clips (Last Clip DEL function).

You can also use the THUMBNAIL menu to delete all 

recorded clips (All Clips DEL function) or to delete 

selected clips. For details, see “Deleting Clips” 

(page 88).

1 Turn on the assignable switch to which 

the Last Clip DEL function has been 

assigned (see page 132).

A confirmation message appears.

2 Turn the MENU knob to select 

[Execute], and then press the knob. Or 

use the J or j button to select 

[Execute], and then press the SET 

button.

On this camcorder, two types of shot marks are 

available in HD mode. You can record them at 

user-specified positions to make it easier for 

editors to cue up those positions. You can record 

up to 127 shot marks per clip.

Note

Shot marks cannot be recorded in SD mode.

You can also use the THUMBNAIL menu to add and 

delete shot marks in clips. For details, see “Adding 

and Deleting Shot Marks (HD Mode Only)” 

(page 90).

To record shot marks

Do one of the following.

• Turn on an assignable switch to which Shot 

Mark 1 or Shot Mark 2 has been assigned (see 

page 131). 

• If Lens RET has been assigned to the RET 

button on the lens, operate as follows.

To record Shot Mark 1: Press the RET button 

once.

To record Shot Mark 2: Press the RET button 

twice in quick succession.

When a shot mark is recorded, a “Shot Mark 1” or 

“Shot Mark 2” indication appears in the 

viewfinder for about three seconds near the 

timecode indication.

To make it easier for editors to select good clips, 

you can set OK marks in clips recorded in HD 

mode.

Notes

• OK marks cannot be set in SD mode.

• OK marks cannot be set or deleted during recording or 

playback.

You can also use the THUMBNAIL menu to add and 

delete OK marks in previously recorded clips. For 

Deleting Recorded Clips

Advanced Operations

Recording Shot Marks

Setting OK Marks
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details, see “Adding and Deleting OK Marks (HD 

Mode Only)” (page 87).

To set OK marks

After recording of a clip ends, turn on the 

assignable switch to which the OK Mark function 

has been assigned (see page 131). If the OK Mark 

function has been assigned to the RET button on 

the lens, press RET button on the lens.

An OK mark is set in the most recently recorded 

clip, and an “OK Mark” indication appears in the 

viewfinder for about three seconds near the 

timecode indication.

To delete OK marks

1 If an OK mark has been set in the most 

recently recorded clip, turn on the 

assignable switch to which the OK 

Mark function has been assigned (see 

page 131). 

If the OK Mark function has been 

assigned to the RET button on the lens, 

press RET button on the lens.

A confirmation message appears.

2 Turn the MENU knob to select 

[Execute], and then press the knob.

The OK mark is deleted from the most 

recently recorded clip.

The camcorder is equipped with enough internal 

memory to pre-store up to 15 seconds of video 

and audio data in a picture cache. This allows you 

to begin recording a specified number of seconds 

in advance of the time when you press a recording 

start button.

Selecting picture cache mode and setting 
the picture cache time

Before recording in picture cache mode, you must 

select picture cache mode and set the picture 

cache time (the number of seconds of video and 

audio data stored to memory) in the 

OPERATION menu.

The picture cache time determines how far in 

advance you can start recording, counting back in 

seconds from the operation that starts recording. 

Note that it may not be possible to start this far in 

advance in the special cases explained in the 

following notes.

Notes

• Storage of picture data to memory begins when you 

select picture cache mode. Therefore, if you start 

recording immediately after selecting picture cache 

mode, the picture data from before the selection is not 

recorded.

• No data is recorded to picture cache memory during 

playback or recording review and display of 

thumbnails. It is not possible to record picture data 

from the time you were conducting playback or a 

recording review.

To select picture cache mode and set the picture 

cache time

Notes

• Picture cache recording is not possible in Frame Rec, 

Interval Rec, and Slow & Quick Motion mode. The 

camcorder exits Frame Rec, Interval Rec, or Slow & 

Quick Motion mode whenever you select picture cache 

mode. The camcorder exits picture cache mode 

automatically whenever you select Frame Rec, 

Interval Rec, or Slow & Quick Motion mode.

• The data stored in picture cache memory is cleared 

when you change the system settings, for example by 

selecting a different video format. Picture data from 

before the change is not recorded even if you start 

recording immediately after the change. The 

camcorder exits picture cache mode automatically.

• It is not possible to set the picture cache time during 

recording.

1 In the setup menu, select OPERATION 

>Rec Function >Picture Cache Rec.

For menu operations, see “Basic Setup Menu 

Operations” (page 94).

2 Turn the MENU knob to select [On], 

and then press the knob. 

3 Select [P. Cache Rec Time], turn the 

MENU knob to select the desired 

picture cache time, and then press the 

knob. 

You can select from 0-2sec, 2-4sec, 4-6sec, 

6-8sec, 8-10sec, 10-12sec, 12-14sec, and 

13-15sec.

Once made, picture cache mode settings remain 

in effect until changed.

Instead of carrying out steps 1 and 2, you can also 

select picture cache mode by using an assignable 

Starting to Record from Pre-
stored Video (Picture Cache 
Function)
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switch to which the Picture Cache function has 

been assigned (see page 131).

Camcorder data handling while recording in 

picture cache mode

Recording procedures in picture cache mode are 

basically the same as normal recording 

procedures. However, note the following 

differences with respect to how the camcorder 

handles video, time, and output data.

• If you start recording while the media is being 

accessed, the start point of the video that is 

actually recorded may be later than the 

currently specified picture cache time. Because 

the delay increases as the number of recorded 

clips increases, you should avoid rapid start-

and-stop recording operations in picture cache 

mode.

• Regardless of the setting of the F-RUN/SET/

R-RUN switch, the advance mode of the 

internal timecode generator is always F-RUN.

• In picture cache mode, you cannot set time data 

by setting the F-RUN/SET/R-RUN switch to 

SET.

To set time data, exit picture cache mode.

• If the remaining free capacity of the media in 

the currently selected slot is less than the picture 

cache time, and the media in the other slot has 

enough remaining capacity, then data is 

recorded to the media in the other slot.

However, no data is recorded when there is no 

media in the other slot, and when the media in 

the other slot does not have enough remaining 

capacity. (A message appears in the viewfinder 

to inform you that there is not enough remaining 

capacity.)

• Shot marks are not recorded if they are set 

before the recording start operation.

• When you select a video format that supports 

i.LINK HDV output and play a clip that was 

recorded in picture cache mode, two or more 

frames with the same picture and timecode may 

follow on each other.

• i.LINK output is possible during picture cache 

recording. However, the picture cache time is 

limited.

If power is lost during recording

• If you set the camcorder’s POWER switch to 

OFF, the camcorder is powered off 

automatically after a few seconds, during which 

the media is accessed to record the video and 

audio data stored in the camcorder’s memory up 

to that point.

• If power is lost because the battery was 

removed, the DC cable was disconnected, or the 

power was turned off on the AC adaptor side, 

then the video and audio data stored in memory 

is lost. The data stored in memory is not 

recorded. Be careful to avoid this when 

exchanging the battery.

The camcorder’s Interval Rec function allows 

you to capture time-lapse video to the 

camcorder’s internal memory. This function is an 

effective way to shoot slow-moving subjects.

When you start recording, the camcorder 

automatically records a specified number of 

frames at a specified interval time.

A pre-lighting function is available when Interval 

Rec is enabled. This function automatically turns 

on a video light before recording starts, which 

allows you to record pictures under stable light 

and color temperature conditions.

Interval Rec settings and shooting

Notes

• The Interval Rec function cannot be used at the same 

time as the picture cache, Frame Rec, or Slow & Quick 

Motion function. When you select Interval Rec mode, 

the picture cache, Frame Rec, and Slow & Quick 

Motion functions are disabled. When you select 

picture cache, Frame Rec, or Slow & Quick Motion 

mode, the Interval Rec function is disabled.

Recording Time-lapse Video 
(Interval Rec Function)

Interval time

Number of frames in one take
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• The data stored in picture cache memory is cleared 

when you change the system settings, for example by 

selecting a different video format. Picture data from 

before the change is not recorded even if you start 

recording immediately after the change. The 

camcorder exits picture cache mode automatically.

• Interval Rec settings cannot be changed during 

recording.

• Interval Rec is disabled when the following formats 

are selected.

- SP 1440/59.94i or SP 1440/50i, when the output 

setting is HD and OPERATION >Input/Output 

>i.LINK I/O in the setup menu is set to [Enable]

- SP 1440/23.98P (pull-down recording)

- Other than HQ 1920/23.98P or HQ 1280/23.98P, 

when the output setting is SD and OPERATION 

>Input/Output >i.LINK I/O in the setup menu is set 

to [Enable]

To make Interval Rec settings

1 Select OPERATION >Rec Function 

>Interval Rec in the setup menu.

For menu operations, see “Basic Setup Menu 

Operations” (page 94).

2 Turn the MENU knob to select [On], 

and then press the knob. 

The camcorder enters Interval Rec mode, the 

“Interval” indication on the viewfinder 

screen flashes.

3 Select [Number of Frames], turn the 

MENU knob to select the number of 

frames to record in one take, and then 

press the knob. 

You can select from 1, 3, 6, 9 (or from 2, 6, 

12 when the video format setting is 720/

59.94P or 720/50P).

4 Select [Interval Time], turn the MENU 

knob to select the desired interval, and 

then press the knob. 

You can select 1 to 10/15/20/30/40/50 sec, 

1 to 10/15/20/30/40/50 min, 1 to 4/6/12/24 

hour.

5 As required, select [Pre-Lighting], turn 

the MENU knob to select the length of 

lighting time before recording starts, 

and then press the knob. 

You can select 1 to 10/15/20/30/40/50 sec, 

1 to 10/15/20/30/40/50 min, 1 to 4/6/12/24 

hour.

Notes

• If you want to turn the video light on before the start of 

recording, set the camcorder’s LIGHT switch to 

[AUTO]. The video light’s switch must also be turned 

on. When this is done, the video light turns on and off 

automatically. However, the video light remains lit 

when the time that it is off is five seconds or less.

• If you set the LIGHT switch to [MANUAL] and turn 

the video light’s switch on, the video light is always lit. 

(It does not go on and off automatically.)

The camcorder exits Interval Rec mode when it is 

powered off, but the number of frames, interval 

time, and pre-lighting settings are maintained. 

You do not need to set them again the next time 

you shoot in Interval Rec mode.

To shoot in Interval Rec mode

Make the settings and preparations described in 

“Basic Operations” (page 71), secure the 

camcorder so that it does not move, and begin 

shooting.

When recording starts, the “Interval” indication 

in the viewfinder changes from flashing to lit, and 

“INT REC” and “INT STBY” appear 

alternatively at the position of the REC 

indication. The TALLY indicators and the tally 

indicator on the front panel of the viewfinder light 

as they do during normal recording.

If you are using the pre-lighting function, the 

video light comes on before recording starts.

To stop shooting

Stop the recording.

When shooting ends, the video data stored in 

memory up to that point is written to the media.

To exit Interval Rec mode

Do one of the following.

• Set the POWER switch to OFF.

• With the camcorder in recording standby mode, 

set OPERATION >Rec Function >Interval Rec 

in the setup menu to “Off”.

Limitations during recording

• The i.LINK (HDV/DV) connector cannot be 

used.

• Regardless of the setting of the F-RUN/SET/

R-RUN switch, the advance mode of the 

internal timecode generator is always F-RUN.

• Audio cannot be recorded.

• Recording review is not possible.
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• If you press the SLOT SELECT button, the 

camcorder completes recording of the specified 

number of frames, creates a clip, and switches 

to the other media.

• Genlock is not possible.

If power is lost during recording

• If you set the camcorder’s POWER switch to 

OFF, the camcorder is powered off 

automatically after a few seconds, during which 

the media is accessed to record the video and 

audio data stored in the camcorder’s memory up 

to that point.

• If power is lost because the battery was 

removed, the DC cable was disconnected, or the 

power was turned off on the AC adaptor side, 

then the video and audio data shot up to that 

point may be lost (maximum 10 seconds). Be 

careful to avoid this when exchanging the 

battery.

The Frame Rec function is useful for shooting 

stop motion animations, such as animations with 

puppets or clay figures.

Each time that you press the recording start 

button, the camcorder shoots a specified number 

of frames and then stops.

Frame Rec settings and shooting

Notes

• The Frame Rec function cannot be used at the same 

time as the picture cache, Interval Rec, or Slow & 

Quick Motion function. When you select Frame Rec 

mode, the picture cache, Interval Rec, and Slow & 

Quick Motion functions are disabled. When you select 

picture cache, Interval Rec, or Slow & Quick Motion 

mode, the Frame Rec function is disabled.

• The data stored in memory is cleared when you change 

the system settings, for example by selecting a 

different video format. Picture data from before the 

change is not recorded even if you start recording 

immediately after the change. The camcorder exits 

Frame Rec mode automatically.

• Frame Rec settings cannot be changed during 

recording.

• Frame Rec is disabled when the following formats are 

selected.

- SP 1440/59.94i or SP 1440/50i, when the output 

setting is HD and OPERATION >Input/Output 

>i.LINK I/O in the setup menu is set to Enable

- SP 1440/23.98P (pull-down recording)

- Other than HQ 1920/23.98P or HQ 1280/23.98P, 

when the output setting is SD and OPERATION 

>Input/Output >i.LINK I/O in the setup menu is set 

to Enable

To make Frame Rec settings

1 Select OPERATION >Rec Function 

>Frame Rec in the setup menu.

For menu operations, see “Basic Setup Menu 

Operations” (page 94).

2 Turn the MENU knob to select [On], 

and then press the knob. 

The camcorder enters Frame Rec mode, the 

“Frame Rec” indication on the viewfinder 

screen flashes.

3 Select [Number of Frames], turn the 

MENU knob to select the number of 

frames to record in one take, and then 

press the knob. 

You can select from 1, 3, 6, 9 (or from 2, 6, 

12 when the video format setting is 720/

59.94P or 720/50P).

The camcorder exits Frame Rec mode when it is 

powered off, but the setting for the number of 

frames setting is maintained. You do not need to 

set it again the next time you shoot in Frame Rec 

mode.

To shoot in Frame Rec mode

Make the settings and preparations described in 

“Basic Operations” (page 71), secure the 

camcorder so that it does not move, and begin 

shooting.

When recording starts, the “Frame Rec” 

indication in the viewfinder changes from 

flashing to lit, and “FRM REC” and “FRM 

STBY” appear alternatively at the position of the 

REC indication. The TALLY indicators and the 

tally indicator on the front panel of the viewfinder 

light as they do during normal recording.

To stop shooting

Stop the recording.

When shooting ends, the video data stored in 

memory up to that point is written to the media.

To exit Interval Rec mode

Do one of the following.

Shooting Stop Motion Animations 
(Frame Rec Function)
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• Set the POWER switch to OFF

• With the camcorder in recording standby mode, 

set OPERATION >Rec Function >Interval Rec 

in the setup menu to “Off”.

Limitations during recording

• The i.LINK (HDV/DV) connector cannot be 

used.

• Regardless of the setting of the F-RUN/SET/

R-RUN switch, the advance mode of the 

internal timecode generator is always R-RUN.

• Audio cannot be recorded.

• Recording review is not possible.

• If you press the SLOT SELECT button, the 

camcorder completes recording of the specified 

number of frames, creates a clip, and switches 

to the other media.

• Genlock is not possible.

If power is lost during recording

• If you set the camcorder’s POWER switch to 

OFF, the camcorder is powered off 

automatically after a few seconds, during which 

the media is accessed to record the video and 

audio data stored in the camcorder’s memory up 

to that point.

• If power is lost because the battery was 

removed, the DC cable was disconnected, or the 

power was turned off on the AC adaptor side, 

then the video and audio data shot up to that 

point may be lost (maximum 10 seconds). Be 

careful to avoid this when exchanging the 

battery.

When the camcorder is in HD mode and the video 

format (see page 50) is set to one of the formats 

listed below, you can specify a recording frame 

rate that is different from the playback frame rate.

When the Country setting is NTSC: HQ 1920/

29.97P, HQ 1920/23.98P, HQ 1280/59.94P, 

HQ 1280/29.97P, HQ 1280/23.98P

When the Country setting is PAL: HQ 1920/

25P, HQ 1280/50P, HQ 1280/25P

By shooting with a frame rate that differs from the 

playback frame rate, you can obtain slow and 

quick motion effects that are smoother than low-

speed or high-speed playback of content recorded 

at the normal frame rate.

Example

When the video format is HQ 1280/23.98P, you 

can obtain quick-motion effects by setting the 

frame rate to 1 to 23, and obtain slow-motion 

effects by setting the frame rate to 25 to 60.

Slow & Quick Motion settings and 
shooting

Notes

• The Slow & Quick Motion function cannot be used at 

the same time as the picture cache, Interval Rec, or 

Frame Rec function. When you select Slow & Quick 

Motion mode, the picture cache, Interval Rec, and 

Frame Rec functions are disabled. When you select 

picture cache, Frame Rec, or Interval Rec mode, the 

Slow & Quick Motion function is disabled.

• Slow & Quick Motion is disabled when the slow 

shutter function (viewfinder display “SLS”) function is 

enabled. The slow shutter function is disabled when 

the Slow & Quick Motion function is enabled.

• Slow & Quick Motion is disabled when OPERATION 

>Input/Output >i.LINK I/O in the setup menu is set to 

[Enable]. When Slow & Quick Motion is enabled, 

i.LINK I/O is fixed as [Disable].

• Slow & Quick Motion settings cannot be changed 

during recording.

To make Slow & Quick Motion settings

1 Select OPERATION >Rec Function > 

Slow & Quick in the setup menu.

For menu operations, see “Basic Setup Menu 

Operations” (page 94).

2 Turn the MENU knob to select [On], 

and then press the knob. 

The camcorder enters Slow & Quick Motion 

mode, and the “S&Q Motion” indication in 

the viewfinder flashes.

3 Select [Frame Rate], turn the MENU 

knob to select the recording frame rate, 

and then press the knob. 

The setting range for the frame rate is as 

follows.

When you finish making these settings, the 

system frequency and the frame rate appear at the 

top of the viewfinder screen. You can change the 

frame rate while viewing the display in the 

Shooting with Slow & Quick 
Motion

System lines Frame rate

1080 1 to 30

720 1 to 60
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viewfinder by turning the MENU knob, or by 

using the J or j button and then pressing the 

SET button.

The Slow & Quick Motion mode setting and the 

frame rate are retained even after the camcorder is 

powered off.

To shoot in Slow & Quick Motion mode

Shoot as described in “Basic Operations” 

(page 71).

When recording starts, the “S&Q Motion” 

indication in the viewfinder changes from 

flashing to lit, and the REC indication lights (the 

indication displays “S&Q REC”). The TALLY 

indicators and the tally indicator on the front 

panel of the viewfinder light as they do during 

normal recording.

To stop shooting

Stop the recording.

Note

It takes longer than normal for recording to stop when 

Frame Rate is set to a low value (for a slow frame rate).

To exit Slow & Quick Motion mode

With the camcorder in recording standby mode, 

set OPERATION >Rec Function > Slow & Quick 

in the setup menu to “Off”.

Limitations during recording

• The i.LINK (HDV/DV) connector cannot be 

used.

• Regardless of the setting of the F-RUN/SET/

R-RUN switch, the advance mode of the 

internal timecode generator is always R-RUN.

• Audio cannot be recorded when the recording 

and playback frame rates differ.

• Recording review is not possible.

• If you change the recording frame rate to a value 

faster than the current shutter speed, the shutter 

speed is changed to the slowest value for which 

shooting is possible.

Example: If the frame rate is 32 and the shutter 

speed is 1/40, and you change the frame rate to 

55, then the shutter speed is changed to 1/60.

If is not possible to select a shutter speed that is 

slower than the recording frame rate.

• Genlock is not possible.

The freeze mix function allows you to 

temporarily overlap a still image (freeze picture) 

from a clip shot in HD mode onto the current 

camera picture. This makes it easier to frame the 

shot.

Note

The freeze mix function is not available in the following 

cases.

• When the recording format is SP 1440/23.98P

• When the video formats of the recorded picture and the 

camera picture differ

• When you are shooting in Slow & Quick Motion mode 

or slow shutter mode

• When there is i.LINK input

To display a freeze mix picture

1 Play a clip or conduct a recording 

review of a clip with the same format as 

the camera picture.

2 Display the picture that you want to use 

as the frame, and then turn on the 

assignable switch to which the Freeze 

Mix function has been assigned.

The recording review picture is frozen and 

overlaps the camera picture.

Note

The following functions are disabled at the freeze mix 

times.

• Menu operations

• During Focus Mag display

• Marker display

• Zebra display

• Peaking display

• Skin tone details display

To cancel the freeze mix display

Do one of the following.

• Press an assignable switch again to which the 

Freeze Mix function has been assigned.

The freeze mix display is canceled and the 

display returns to the normal camera picture.

• Start recording (see page 131).

Normal recording starts.

Framing Shots with the Freeze 
Mix Function
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A thumbnail screen appears if you press the THUMBNAIL button in E-E or playback mode. Thumbnail 

screens display lists of the clips stored on S×S memory cards in the form of index pictures. (A message 

appears if you insert a memory card that contains no clips.)

You can select any clip (see page 82) in a thumbnail screen and start playback of that clip (see page 82).

In thumbnail screens, the timecode of the index picture appears beneath the thumbnail for each clip. (An 

OK mark also appears when a clip has been marked with an OK mark.)

Note

Normal thumbnail screens display SD clips only or HD clips only, even if the S×S memory card contains clips in both 

formats. You can select the format to display by selecting a mode with OPERATION >Format >HD/SD (see page 96) in 

the setup menu.

If you want to display all recorded clips, regardless of the HD/SD mode, switch to the all clips thumbnail screen. 

However, it is not possible to start playback from the all clips thumbnail screen (see page 85).

HD mode thumbnail screen

Chapter5 Clip Operations

Clip Playback

Thumbnail Screen

Clip number/Number of clips

Cursor (yellow)
The icon of the currently selected S×S memory card is highlighted.
(If the card is write protected, a lock appears on the left.)
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a Index picture

When a clip is recorded, its first frame is set 

automatically as the index picture. You can 

change to index picture to any frame (see 

page 90).

b Lock mark

Indicates the selected clip is marked with an OK 

mark and protected.

c Date and start time of recording

d Clip name

e Independent AV file icon

This appears only when a clip is an independent 

AV file. S×S memory cards may contain 

independent files that have been added directly 

from a computer. Because independent files lack 

the associated management files, some operations 

and information displays may not be available.

f Video format of recording

g Special recording information

This displays the mode of clips that have been 

recorded in a special mode (Slow & Quick 

Motion, Interval Rec, Frame Rec).

For Slow & Quick Motion clips, the frame rates 

are displayed to the right as [Recording frame 

rate/Playback frame rate] fps.

h OK mark

An OK mark appears only when the clip has been 

marked with an OK mark (see page 87).

i File format

Indicates the file format of the selected clip 

(MP4).

j Clip duration

k Timecode

This is the timecode of the index picture.

SD mode thumbnail screen

a Take mark

Indicates that the file size is larger than 2 GB, and 

that the clip has been split before being saved.

You can check the segment files on the expand 

thumbnail screen (see page 88).

b Index picture

When a clip is recorded, its first frame is set 

automatically as the index picture.

Clip number/Number of components

Cursor (yellow)

The icon of the currently selected S×S memory card is highlighted.
(If the card is write protected, a lock appears on the left.)
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c Date and start time of recording

d Clip name/Number of components

The number after the clip name (delimited by /) is 

the number of components. This appears only for 

clips larger than 2 GB in size, which have been 

split into smaller files for storage.

e Video format of recording

f File format

Indicates the file format of the selected clip 

(AVI).

g Clip duration

h Timecode

This is the timecode of the index picture.

To switch between S×S memory cards

When two S×S memory cards are loaded, you can 

switch between them by pressing the SLOT 

SELECT button.

Note

Switching between memory cards is possible only in the 

normal thumbnail screen, the OK clip thumbnail screen, 

or the all clips thumbnail screen, or when you have 

pressed the STOP button to display the camera picture.

To hide the thumbnail screen

Press the THUMBNAIL button.

To select clip thumbnails

Do one of the following to move the yellow 

cursor to the clip that you want to select.

• Press an arrow button (J, j, K, k).

• Turn the MENU knob.

• Press the PREV or NEXT button.

To select the first thumbnail

With the F REV button held down, press the 

PREV button.

To select the last thumbnail

With the F FWD button held down, press the 

NEXT button.

To play clips sequentially starting from a 
selected clip

1 Select the thumbnail of the clip that you 

want to play first.

2 Press the PLAY/PAUSE button.

Play begins from the top of the selected clip.

Play continues through all clips after the selected 

clip.

When the last clip has been played to the end, the 

camcorder enters pause (still image) mode at the 

last frame of the last clip.

Press the THUMBNAIL button to return to the 

thumbnail screen.

Notes

• There may be momentary picture breakup or still 

image display at the transition from one clip to another. 

During this time, the playback controls and the 

THUMBNAIL button cannot be operated.

• When you select a clip in the thumbnail screen and 

begin playback, there may be momentary picture 

breakup at the top of the clip. To view the top of the 

clip without breakup, put the camcorder into playback 

mode, pause, use the PREV button to return to the top 

of the clip, and start playback again.

• On S×S memory cards that contain both HD-mode and 

SD-mode clips, you cannot play all clips in sequence. 

For example, while an HD mode thumbnail screen is 

displayed, only HD mode clips are played in sequence.

To pause playback

Press the PLAY/PAUSE button.

The PLAY/PAUSE indicator flashes while 

playback is paused.

Press the button again to return to playback mode.

To play at high speed

Press the F FWD button (see page 20) or the 

F REV button (see page 20).

To return to normal playback, press the PLAY/

PAUSE button.

To stop playback

Press the STOP button: Playback stops and the 

camcorder enters E-E mode.

Press the THUMBNAIL button: Playback stops 

and the thumbnail screen (see page 80) 

appears in the viewfinder.

Playback also stops if you eject the memory card. 

In this case, the camera picture appears in the 

viewfinder.

Playing Clips
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To cue up clips

To return to the top of the current clip

Press the PREV button.

• During playback or F FWD, this jumps to the 

top of the current clip and starts playback.

• During F REV or pause, this jumps to the top of 

the current clip and displays a still image.

• Each subsequent press of the button moves to 

the previous clip.

To play from the top of the first clip

Simultaneously press the PREV and F REV 

buttons. This jumps to the top of the first clip on 

the S×S memory card.

To jump to the top of the next clip

Press the NEXT button.

• During playback or F FWD, this jumps to the 

top of the next clip and starts playback.

• During F REV or pause, this jumps to the top of 

the next clip and displays a still image.

• Each subsequent press of the button moves to 

the next clip.

To play from the top of the last clip

Simultaneously press the NEXT and F FWD 

buttons. This jumps to the top of the last clip on 

the S×S memory card.

To add a shot mark during playback 
(HD mode only)

You can add shot marks to clips during playback 

by using the same method used during recording 

(see page 73).

Notes

• Shot marks cannot be recorded when the S×S memory 

card is write protected.

• Shot marks cannot be added at the first or last frame of 

a clip.

You can switch a thumbnail screen to the 

following thumbnail search screens, which allow 

you quickly find the clips you want.

• Expand thumbnail screen

• Shot mark thumbnail screen (HD mode only)

Like the normal thumbnail screen and the OK clip 

thumbnail screen, these screens allow you to 

select clip thumbnails (see page 82) and to start 

clip playback (see page 82).

To search for scenes in clips with the 
expand thumbnail screen

The expand thumbnail screen is convenient when 

you want to find and cue up a specific scene in a 

long clip.

To display the expand thumbnail screen, select a 

clip in the thumbnail screen and press the 

EXPAND button (see page 20) or select 

THUMBNAIL >Thumbnail View >Forward 

Expansion in the setup menu. The selected clip is 

displayed as follows.

HD mode: The clip is divided into 12 equally-

sized blocks, and a thumbnail of the first 

frame in each block is displayed.

SD mode: Only in the case of clips that have been 

split into partial files because the file size was 

larger than 2 GB, a thumbnail of the first 

frame of each partial file is displayed.

This helps you to quickly cue up to a desired 

scene in a clip of long duration.

See “Displaying the Expand Thumbnail Screen” 

(page 88) for more information about the expand 

thumbnail screen.

To search for shot marks in clips with the 
shot mark thumbnail screen (HD mode)

When a clip contains one or more shot marks, you 

can easily find them with the shot mark thumbnail 

screen. The shot mark thumbnail screen displays 

a thumbnail of each shot mark frame in the clip.

To display the shot mark thumbnail screen, press 

the ESSENCE MARK button (see page 22) or 

select THUMBNAIL >Thumbnail View > 

Essence Mark Thumbnail in the setup menu.

See “Displaying the Shot Mark Thumbnail Screen 

(HD Mode Only)” (page 89) for more information 

about the shot mark thumbnail screen.Using Thumbnails to Search 
Inside Clips
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You can use the THUMBNAIL menu to perform various operations on clips, to check clip properties, and 

to change clip metadata.

a) HD mode only

Thumbnail Operations

THUMBNAIL Menu Configuration

Menu items Sub-items Description

Clip Properties — Displays detailed properties (see page 86)

Set Index Picture a) — Changes index pictures in the expand thumbnail screen or 

the shot mark thumbnail screen (see page 90)

Thumbnail View Forward Expansion • Displays the expand thumbnail screen (see page 88)

• In the expand thumbnail screen, increases the number of 

divisions (see page 89)

Back Expansion In the expand thumbnail screen, decreases the number of 

divisions

Essence Mark Thumbnail a) Displays the shot mark thumbnail screen (see page 89)

Clip Thumbnail Displays the normal thumbnail screen

All Clip Thumbnail Displays the all clips thumbnail screen (see page 85)

Set Shot Mark a) Add Shot Mark1 In the expand thumbnail screen or the shot mark thumbnail 

screen, adds a Shot Mark1 mark (see page 90)

Delete Shot Mark1 In the expand thumbnail screen or the shot mark thumbnail 

screen, deletes a Shot Mark1 mark (see page 90)

Add Shot Mark2 In the expand thumbnail screen or the shot mark thumbnail 

screen, adds a Shot Mark2 mark (see page 90)

Delete Shot Mark2 In the expand thumbnail screen or the shot mark thumbnail 

screen, deletes a Shot Mark2 mark (see page 90)

Add OK Mark a) — Adds an OK mark and protects a clip (see page 87)

Delete OK Mark a) — Deletes an OK mark and unprotects a clip (see page 87)

Copy Clip — Copies a clip (see page 87)

Delete Clip — Deletes a clip (see page 88)

Divide Clip a) — Divides a clip (see page 91)

Filter Clips a) — Displays the OK clip thumbnail screen (see page 85)

Copy All Clips Execute/Cancel Copies all clips (see page 88)

Delete All Clips Execute/Cancel Deletes all unprotected clips (see page 88)
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See “Basic Setup Menu Operations” (page 94) for 

information about menu operations.

To display the THUMBNAIL menu

1 Set the MENU ON/OFF switch to ON, 

or press the MENU button.

2 Turn the MENU knob to select “TH”, 

and then press the knob. Or press the J 

or j button to select “TH”, and then 

press the SET button.

The THUMBNAIL menu appears.

To hide the THUMBNAIL menu, press the 

MENU button again.

To select menu items and sub-items

Do one of the following.

• Turn the MENU knob to select an item or sub-

item, and then press the knob.

• Press the arrow buttons (J, j, K, k) to 

select an item or sub-item, and then press the 

SET button.

According to the selected item or sub-item, a 

selection list or a clip properties screen appears 

(see page 86).

To return to the previous state, push the MENU 

CANCEL/PRST/ESCAPE switch down to the 

ESCAPE side.

Notes

• When an S×S memory card is write protected, it is not 

possible to copy, delete, or divide clips, to change 

index pictures, or to add and delete OK marks and shot 

marks.

• Some items cannot be selected, depending on the state 

of the camcorder when the menu was displayed.

To hide the clip properties screen

Do one of the following.

Press the RESET/RETURN button: This 

returns to the THUMBNAIL menu.

Press the THUMBNAIL button: The 

camcorder enters E-E mode, and the camera 

picture appears.

Press the PLAY/PAUSE button: Playback from 

the selected clip starts.

To display OK clip thumbnails (HD mode 
only)

From among all clips stored on the currently 

selected S×S memory card, the OK clip 

thumbnail screen displays only clips which have 

been marked with an OK mark.

When the normal thumbnail screen is displayed, 

you can select THUMBNAIL >Filter Clips to 

switch to the OK clip thumbnail screen.

See “Adding and Deleting OK Marks (HD Mode 

Only)” (page 87) for information about how to add 

OK marks.

To display the all clips thumbnail screen

The all clips thumbnail screen displays 

thumbnails of all of the clips on the selected 

memory card, including both HD-mode and 

SD-mode clips. This is useful when you want to 

check whether the memory card contains clips in 

another mode.

You can switch to the all clips thumbnail screen 

by selecting THUMBNAIL >All Clip Thumbnail 

in the setup menu in the normal thumbnails 

screen.

Pressing the RESET/RETURN button returns 

you to the normal thumbnails screen, where you 

can perform playback and other clip operations.

Note

You cannot start playback from the all clips thumbnail 

screen.

Basic THUMBNAIL Menu 
Operations

Changing the Thumbnail Screen 
Type



Thumbnail Operations86

C
h

a
p
te

r 5
  C

lip
 O

p
e

ra
tio

n
s

The clip properties screen appears when you select Clip Properties in the THUMBNAIL menu.

a Image of the current clip

b Image of the previous clip

Press the PREV button to display the properties 

of the previous clip.

c Image of the next clip

Press the NEXT button to display the properties 

of the next clip.

d Clip name

In SD mode, only for clips that have been 

divided because the file size was greater than 2 

GB, the number of component clips appears 

after the clip name.

e Lock mark (HD mode only)

This appears when the clip is marked with an 

OK mark and protected.

f OK mark (HD mode only)

This appears only when an OK mark has been 

added.

g Date and start time of recording

h File format

The file format of the clip (MP4 or AVI) 

appears.

Displaying Clip Properties

HD mode

SD mode
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i Special recording information (HD 

mode only)

This displays the mode of clips that have been 

recorded in a special mode (Slow & Quick 

Motion, Interval Rec, Frame Rec).

For Slow & Quick Motion clips, the frame rates 

are displayed to the right as [Recording frame 

rate/Playback frame rate].

j Timecode of the displayed image

k Timecode of the recording start point

l Timecode of the recording end point

m Duration

n Recorded audio channels

o Video format of recording

You can add OK marks to clips. This makes it 

possible to display thumbnails of only the clips 

that you need by pressing the THUMBNAIL 

button.

Clips with OK marks cannot be deleted or 

divided. If you want to delete or divide such a 

clip, delete the OK mark first.

To add an OK mark

1 In the thumbnail screen, select 

THUMBNAIL >Add OK Mark.

The screen changes to the clip properties 

screen, and a confirmation message appears 

beneath the index picture.

2 Select [Execute], and press the MENU 

knob.

An OK mark is added to the selected clip.

To delete an OK mark

A Delete OK Mark item appears in the 

THUMBNAIL menu when you have selected a 

clip that has an OK mark.

1 In the thumbnail screen, select 

THUMBNAIL >Delete OK Mark.

The screen changes to the clip properties 

screen, and a confirmation message appears 

beneath the index picture.

2 Select [Execute], and press the MENU 

knob.

The OK mark is deleted from the selected clip.

You can copy clips to other S×S memory cards.

Clips are copied to destination S×S memory cards 

using the same names as the original clips.

Notes

• If a clip with the same name already exists at the copy 

destination S×S memory card, a one-digit number in 

parentheses is added to the original name.

The number in parentheses is the smallest number that 

does not exist at the copy destination.

Examples:

ABCD0002tABCD0002(1)

ABCD0002(1)tABCD0002(2)

ABCD0005(3)tABCD0005(4)

• If the parenthetical numbers (1) to (9) already exist at 

the copy destination, it is not possible to copy any more 

clips under that name. (A tenth clip cannot be copied.)

• A message appears if there is not enough free capacity 

at the copy destination S×S memory card. Exchange 

the card for one with more free capacity.

1 In the thumbnail screen, select the 

thumbnail of the clip to copy, and then 

select THUMBNAIL >Copy Clip.

The screen changes to the properties screen 

of that clip, and a confirmation message 

appears beneath the index picture.

2 Select [Execute], and press the MENU 

knob.

The copy starts.

During the copy, an execution message and 

progress bar are displayed.

When the copy finishes, the display returns to the 

thumbnail screen.

To cancel a copy operation

Press the RESET/RETURN button.

The copy is cancelled, and the display returns to 

the thumbnail screen.

Adding and Deleting OK Marks 
(HD Mode Only)

Copying Clips
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To batch copy groups of clips

You can batch copy groups of clips from one S×S 

memory card to another S×S memory card.

When both HD-mode and SD-mode clips exist on 

the source S×S memory card, only clips in the 

currently selected mode are copied. This is a 

convenient way to extract clips in one of the 

modes.

1 In the thumbnail screen, select the 

thumbnails of the clips to copy and then 

select THUMBNAIL >Copy All Clips.

The confirmation message “Copy All 

Clips?” appears.

2 Select [Execute], and press the MENU 

knob.

The copy starts.

During the copy, the progress of the copy is 

displayed.

If you executed the copy in HD mode, only 

HD-mode clips are copied.

If you executed the copy in SD mode, only 

SD-mode clips are copied.

To cancel the copy operation

Press the RESET/RETURN button.

When the copy finishes

A completion message appears, and the 

THUMBNAIL menu screen appears again.

You can delete clips from S×S memory cards.

Note

HD clips with OK marks cannot be deleted.

If you want to delete such clips, first delete the OK marks 

(see page 87).

1 In the thumbnail screen, select the 

thumbnail of the clip to delete, and then 

select THUMBNAIL >Delete Clip.

The screen changes to the properties screen 

of that clip, and a confirmation message 

appears beneath the index picture.

2 Select [Execute], and press the MENU 

knob.

The clip is deleted.

In the thumbnail screen, the clips that followed 

the deleted clip move up one position.

To batch delete groups of clips

You can batch delete groups of clips from an S×S 

memory card.

Notes

• When both HD-mode and SD-mode clips exist on the 

S×S memory card, only clips in the currently selected 

mode are deleted.

• In HD mode, clips with OK marks are not deleted, 

even when a deletion is executed for a group of clips 

that includes them.

1 In the thumbnail screen, select the 

thumbnails of the clips to delete and 

then select THUMBNAIL >Delete All 

Clips.

The confirmation message “Delete All 

Clips?” appears.

2 Select [Execute], and press the MENU 

knob.

The deletion starts.

During the deletion, the progress of the 

deletion is displayed.

If you executed the deletion in HD mode, 

only HD-mode clips are deleted.

If you executed the deletion in SD mode, 

only SD-mode clips are deleted.

To cancel the deletion

Press the RESET/RETURN button.

When the deletion finishes

A completion message appears, and the 

THUMBNAIL menu screen appears again.

The expand thumbnail screen allows you to 

search inside clips by using thumbnails (see 

page 83), to change index pictures (see page 90), 

and to add and delete shot marks (see page 90).

To display the screen

In the thumbnail screen, select a thumbnail and 

press the EXPAND button (see page 20) or select 

THUMBNAIL >Thumbnail View >Forward 

Expansion.

An expand thumbnail screen for the selected clip 

appears.

Deleting Clips

Displaying the Expand Thumbnail 
Screen
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Expand thumbnail screen in HD mode

In HD mode, the selected clip is divided into 12 

equally-sized blocks, and a thumbnail of the first 

frame in each block is displayed.

Clip properties are shown at the bottom of the 

screen.

Except for the items listed below, the information 

displayed here is the same as the information 

displayed in the normal thumbnail screen.

a Frame information

This displays frame information using icons. 

The same icons are also displayed beneath the 

thumbnails. However, when several icons could 

be displayed for the same frame, one icon is 

selected for display, in the order of priority 

Index picture > Shot Mark1 > Shot Mark2.

b Timecode

This displays the timecode of the selected 

frame in the expand thumbnail screen.

Expand thumbnail screen in SD mode

In SD mode, only in the case of clips that have 

been split into partial files because the file size 

was larger than 2 GB, a thumbnail of the first 

frame of each partial file is displayed.

Clip properties are displayed at the bottom of the 

screen.

Except for the items listed below, the information 

displayed here is the same as the information 

displayed in the normal thumbnail screen.

a Timecode

This is the timecode of the selected partial file.

b Duration

This is the duration of the selected partial file.

To increase the number of divisions

When you press the EXPAND button, or select 

THUMBNAIL >Thumbnail View >Forward 

Expansion, the divided clip or file is further 

divided into 12 equally-sized blocks (a clip or file 

that has been divided into 12 is further divided 

into 12, for 12 × 12 = 144 divisions). You can 

repeat the same operation to increase the number 

of division.

To return to the previous division level

Press the EXPAND button with the SHIFT button 

held down, or select THUMBNAIL >Thumbnail 

View >Back Expansion. The expand thumbnail 

screen returns to the previous division level.

In the shot mark thumbnail screen (shown only in 

HD mode), you can search for shot marks in clips 

(see page 83), change index pictures (see 

page 90), and add and delete shot marks (see 

page 90). 

Index picture

Frame with Shot Mark1

Frame with Shot Mark2

S1 S2

S2 S1

Number of the selected frame

S1

S2

Displaying the Shot Mark 
Thumbnail Screen (HD Mode 
Only)

Number of the selected frame
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1 In the thumbnail screen, select the 

thumbnail of a clip, and press the 

ESSENCE MARK button (see page 22) 

or select THUMBNAIL >Thumbnail 

View >Essence Mark Thumbnail.

2 The shot mark thumbnail screen 

appears, and a selection list is displayed.

3 Select Shot Mark, Shot Mark1, or Shot 

Mark2.

Shot Mark1: Display only frames marked 

with Shot Mark1 marks.

Shot Mark2: Display only frames marked 

with Shot Mark2 marks.

Shot Mark: Display frames marked with 

either Shot Mark1 or Shot Mark2 marks.

Example shot mark thumbnail screen 
(with Shot Mark selected)

The properties of the clip appear at the bottom of 

the screen.

Except for the following item, the information 

displayed here is the same as the information 

displayed in the expand thumbnail screen.

a Timecode

This is the timecode of the selected frame in the 

shot mark thumbnail screen.

In the shot mark thumbnail screen (see page 89) 

or the expand thumbnail screen (see page 88), 

you can add thumbnails to any frame of clips 

recorded in HD mode, and delete recorded shot 

marks.

To add shot marks

1 Select the frame where you want to add 

a shot mark, and then select 

THUMBNAIL > Set Shot Mark > Add 

Shot Mark1 (or Add Shot Mark2).

The properties screen of the selected frame 

appears, and a confirmation message appears 

below the image.

2 Select [Execute], and press the MENU 

knob.

To delete shot marks

1 Select the frame where you want to 

delete a shot mark, and then select 

THUMBNAIL > Set Shot Mark > 

Delete Shot Mark1 (or Delete Shot 

Mark2).

The properties screen of the selected frame 

appears, and a confirmation message appears 

below the image.

2 Select [Execute], and press the MENU 

knob.

In the expand thumbnail screen (see page 88) or 

the shot mark thumbnail screen (see page 89), 

you can set the selected frame as the clip index 

picture in HD mode. 

1 Select the thumbnail of the frame that 

you want to use as the index picture, 

and then select THUMBNAIL >Set 

Index Picture. 

The properties screen of the selected frame 

appears, and a confirmation message appears 

below the image.

2 Select [Execute], and press the MENU 

knob.

Note

Even if you set the index picture to a frame that is not the 

first frame of a clip, playback of that clip from a 

thumbnail screen always begins at the first frame. 

Adding and Deleting Shot Marks 
(HD Mode Only)

S1 S2 S2 S1

S1 S1

Changing Clip Index Pictures 
(HD Mode Only)
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In the expand thumbnail screen (see page 88) and 

the shot mark thumbnail screen (see page 89) , 

HD-mode clips can be divided into two clips at 

the selected frame. 

1 Select the thumbnail of the frame where 

you want to divide the clip, and then 

select THUMBNAIL >Divide Clip.

The properties screen of the selected frame 

appears, and a confirmation message appears 

below the image.

2 Select [Execute], and press the MENU 

knob.

The clip is divided at the selected frame, and 

two clips with different names are created. 

The first four characters of the clip name are 

taken from the name of the original clips, and the 

last four characters are new serial numbers.

Example: When the name of a newly recorded 

clip would be EFGH0100, and a clip named 

ABCD0002 is divided, the names of the two 

newly created clips are ABCD0100 and 

ABCD0101. 

Note

When there is not enough remaining capacity on the S×S 

memory cards to store the divided clips, a message 

appears to inform you that there is not enough capacity.

Dividing Clips (HD Mode Only)
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On this camcorder, settings for shooting and 

playback are made in the setup menu, which 

appears in the viewfinder.

The setup menu can also be displayed on an 

external video monitor (see page 140).

The setup menu consists of the following menus.

Op: OPERATION menu

Settings related to shooting, except settings 

related to picture quality (see page 96)

Pa: PAINT menu

Settings related to picture quality (see page 109)

Th: THUMBNAIL menu

Settings related to clip thumbnails (see page 84)

Note

The THUMBNAIL menu is used only when a thumbnail 

screen (see page 80) is displayed. It is disabled when no 

thumbnail screen is displayed.

Ma: MAINTENANCE menu

Settings related to audio and timecode (see 

page 115)

Fi: FILE menu

Settings related to file operations (see page 127)

See “THUMBNAIL Menu Configuration” (page 84) 

for the organization of the THUMBNAIL menu.

OPERATION Menu (see page 96)

Chapter6 Menu and Detailed Settings

Setup Menu 
Organization and Levels

Setup Menu Organization

Setup Menu Levels

OPERATION

Format

Format Media

Input/Output

Super Impose

Rec Function

Assignable SW

VF Setting

Marker

Gain Switch

TLCS

Zebra

Display On/Off

Auto Iris

White Setting

Offset White

Shutter Select

Time Zone

Clip
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PAINT Menu (see page 109) 

MAINTENANCE Menu (see page 115) 

FILE Menu (see page 127) 

PAINT

Switch Status

White

Black

Flare

Gamma

Black Gamma

Knee

White Clip

Detail(HD Mode)

Detail(SD Mode)

Aperture

Skin Detail

Matrix

Multi Matrix

V Modulation

Low Key Saturation

Noise Suppress

MAINTENANCE

White Shading

Black Shading

Battery

Audio

WRR Setting

Timecode

Essence Mark

Camera Config

Preset White

White Filter

DCC Adjust

Auto Iris2

Flicker Reduce

Genlock

ND Comp

Lens

Auto Shading

Trigger Mode

Clock set

Language

Hours Meter

Version

FILE

All

Scene

Reference

Lens
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To display the setup menu

Set the MENU ON/OFF switch to ON, or press 

the MENU button.

The camcorder enters menu mode and the menu 

list appears on the screen.

A cursor appears over the first two characters of the 

most recently used menu, and the corresponding 

menu item selection area appears to the right.

Example: When the cursor is positioned at the 

OPERATION menu

Note

The setup menu cannot be used when the camcorder is in 

focus magnification mode. Exit focus magnification 

mode by pressing the assignable switch to which the 

Focus Mag function has been assigned.

To make menu settings

1 Turn the MENU knob, or press the J or 

j button, to move the cursor to the item 

that you want to set.

A list of selectable menu items appears in the 

menu item selection area to the right of the 

icon.

2 Press the MENU knob or the SET 

button.

The cursor moves to the menu item selection 

area.

You can also move the cursor to the menu 

item selection area by pressing the k 

button.

• The menu item selection area displays a 

maximum of seven lines. You can scroll 

through menus with more than seven lines 

by moving the cursor up and down.

Triangles appear at the upper right and 

lower right of the menu item selection area 

to indicate that a menu is scrollable.

3 Turn the MENU knob, or press the J or 

j button, to move the cursor to the item 

that you want to set, and then confirm 

by pressing the MENU knob or the SET 

button.

The sub-items area appears to the right of the 

menu item selection area, and the cursor 

moves to the first sub-item.

Basic Setup Menu 
Operations

Menu item selection area

Menu list

Menu item selection area
• B appears to the right when more detailed 

sub-items are available.
• Settings appear to the right when a menu 

item has no sub-items.
• You can select  to return to the 

previous level. 

Appears when more menu items 
are available below the last line. 
(v appears when more menu items 
are available above the first line.)

Sub-items area

• Displays sub-items and their current 
settings

• To return to the previous level, select , 
press the K button, or push the MENU 
CANCEL/PRST/ESCAPE switch down to 
the ESCAPE side.
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4 Turn the MENU knob, or press the J or 

j button, to move the cursor to the sub-

item that you want to set, and then 

confirm the selection by pressing the 

MENU knob or the SET button.

The settings of the selected sub-item appear, 

and the cursor moves to the currently 

selected value.

• The settings area displays a maximum of 

seven lines. You can scroll through menus 

with more than seven sub-items by moving 

the cursor up and down. Triangles appear at 

the upper right and lower right of the 

settings area to indicate that a sub-item 

menu is scrollable.

• For sub-items with a large settings range 

(for example, –99 to +99), the settings area 

is not displayed. Instead, the sub-item name 

is highlighted to indicate that the sub-item 

can be set.

5 Turn the MENU knob, or press the J or 

j button, to select the value to set, and 

then confirm by pressing the MENU 

knob or the SET button.

The setting is changed, and the display is 

updated to show the new setting.

If you select [Execute] for an executable 

item, the corresponding function is executed.

Items that require confirmation before execution

In step 3, the menu disappears and a confirmation 

message appears if you select an item that 

requires confirmation before execution. Follow 

the instructions in the message to execute or 

cancel the operation.

To enter text 

Some items, such as time data or file names, must 

be set by entering text. When you select one of 

these items, the text entry area is highlighted, with 

“SET” displayed to the right.

1 Turn the MENU knob, or press the J or 

j button, to select a character, and then 

confirm by pressing the MENU knob or 

the SET button.

The cursor moves to the next position.

To return to the previous position, push the 

MENU CANCEL/PRST/ESCAPE switch 

down to the ESCAPE side.

2 Select characters for all positions up to 

the last.

The cursor moves to “SET”.

3 Press the MENU knob or the SET 

button.

This confirms the setting.

To cancel the setting change

Push the MENU CANCEL/PRST/ESCAPE 

switch down to the ESCAPE side.

To reset a setting to the initial value

1 Before a setting is changed or after a 

setting change is cancelled, push the 

MENU CANCEL/PRST/ESCAPE 

switch up to the CANCEL/PRST side.

2 When the message to confirm whether 

the current setting is reset to the initial 

value, push the MENU CANCEL/

PRST/ESCAPE switch up to the 

CANCEL/PRST side again.

The current setting is reset to the initial value.

To exit the menu

Set the MENU ON/OFF switch to OFF or press 

the MENU button.

The normal camera picture reappears.

Settings area
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Settings in bold are the factory default values.

Menu List

OPERATION Menu

OPERATION

Menu items Sub-item Settings Description

Format

Specifies the 
camcorder’s operating 
mode and recording 
format.

HD/SD HD/SD Switches between HD or SD as the 

operating mode (execute by 

selecting Execute).

Note

When the optional CBK-DV01 is not 

installed, [SD] cannot be selected. (SD 

recording is not allowed.)

HD System Line 1080/720 When the operating mode is HD, 

sets the number of system lines to 

1080 or 720 (execute by selecting 

Execute).

System Frequency The available settings 

vary depending on the 

settings in HD/SD, HD 

System Line, and 

Country.

Selects the system frequency 

(execute by selecting Execute).

59.94i/29.97P/23.98P When the HD/SD setting is [HD], 

the HD System Line setting is 

[1080], and the Country setting is 

other than [PAL Area].

59.94P/29.97P/23.98P When the HD/SD setting is [HD], 

the HD System Line setting is [720], 

and the Country setting is other than 

[PAL Area].

59.94i/29.97P When the HD/SD setting is [SD], 

and the Country setting is other than 

[PAL Area].

50i/25P • When the HD/SD setting is [HD], the 

HD System Line setting is [1080], 

and the Country setting is [PAL 

Area].

• When the HD/SD setting is [SD], and 

the Country setting is [PAL Area].

50P/25P When the HD/SD setting is [HD], 

the HD System Line setting is [720], 

and the Country setting is [PAL 

Area].
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Format

Specifies the 
camcorder’s operating 
mode and recording 
format.

Rec Format The available settings 

vary depending on the 

settings in HD/SD, HD 

System Line, and System 

Frequency.

Selects the recording format 

(execute by selecting Execute).

HQ 1920/HQ 1440 When the HD/SD setting is [HD], 

the HD System Line setting is 

[1080], and the System Frequency 

setting is [29.97P] or [25P].

HQ 1920/HQ 1440/

SP 1440

When the HD/SD setting is [HD], 

the HD System Line setting is 

[1080], and the System Frequency 

setting is other than [29.97P] and 

[25P].

HQ 1280 When the HD/SD setting is [HD], 

and the HD System Line setting is 

[720].

DVCAM When the HD/SD setting is [SD].

Aspect Ratio(SD) 16:9/4:3 Selects the aspect ratio when SD 

mode (recording format: 

DVCAM a)) is selected (execute by 

selecting Execute).

Country NTSC Area/NTSC(J) 

Area/PAL Area

Selects the area of use (execute by 

selecting Execute).

Format Media

Executes a media 
format.

Media(A) Execute/Cancel Initializes the S×S memory card in 

slot A (execute by selecting 

Execute).

Media(B) Execute/Cancel Initializes the S×S memory card in 

slot B (execute by selecting 

Execute).

OPERATION

Menu items Sub-item Settings Description
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Input/Output

Makes settings related 
to I/O signals.

Output& i.LINK HD&HDV/SD&HDV/

SD&DV/480P (576P)

Selects the signals output from the 

video connectors and the i.LINK 

(HDV/DV) connector.

• When the HD/SD setting is SD, 

“SD&DV” is selected.

• On 480P576P, “480P” can be 

selected when the Country setting is 

other than “PAL Area”, and “576P” 

can be selected when the Country 

setting is “PAL Area”.

23.98P Output PsF/Pull Down When the video format is HQ 1920/

23.98P or HQ 1440/23.98P, selects 

whether to use progressive output 

(PsF) or pulldown output (Pull 

Down).

Source Select Camera/i.LINK Selects whether to use the video 

camera picture (Camera) or the 

signal input from the i.LINK (HDV/

DV) connector (i.LINK) as the video 

input source.

i.LINK I/O Enable/Disable Selects whether to enable or disable 

input and output of signals via the 

i.LINK (HDV/DV) connector.

SDI Output On/Off Turns on or off the output of signals 

from the HD/SD SDI OUT 

connector.

HDMI Output On/Off Turns on or off the output of signals 

from the HDMI connector.

SDI/HDMI Out 

Super

On/Off Turns on or off the superimposition 

of text information on the output of 

the HD/SD SDI OUT and HDMI 

connectors.

Video Out Super On/Off Turns on or off the superimposition 

of text information on the output of 

the VIDEO OUT connector.

OPERATION

Menu items Sub-item Settings Description
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Input/Output

Makes settings related 
to I/O signals.

Down Converter Crop/Letter/Squeeze Selects the signal conversion mode 

for output of SD signals.

Crop: Crop the edges of the 16:9 

picture and output as a 4:3 

picture.

Letter: Mask the top and bottom of 

the 4:3 picture and display in 

the center of the screen as a 

16:9 picture.

Squeeze: Squeeze the 16:9 picture 

horizontally and output as a 4:3 

picture.

Wide ID Through/AUTO Selects whether to add wide picture 

information to the SD output signal.

Through: Output without adding 

wide picture information.

AUTO: Add and output wide 

picture information when the 

Down Converter setting is 

Squeeze.

Super Impose

Makes settings related 
to superimposed text 
and markers.

Super(VF Display) On/Off When the setting of Input/Output 

>SDI/HDMI Out Super or Video 

Out Super is On, superimpose text 

information on the output from the 

HD/SD SDI OUT connector, HDMI 

connector, and VIDEO OUT 

connector, as specified (On or Off) 

for each item.

Super(Menu) On/Off

Super(Timecode) On/Off

Super(Marker) On/Off When the setting of Input/Output 

>Video Out Super is On, specifies 

whether to superimpose markers on 

the output from the VIDEO OUT 

connector.

OPERATION

Menu items Sub-item Settings Description
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Rec Function

Makes settings related 
to special recording 
modes.

Slow & Quick On/Off Turns the Slow & Quick Motion 

function on or off. (When this is set 

to On, the Picture Cache Rec, 

Interval Rec, and Frame Rec sub-

items are set to Off.)

Frame Rate The available settings 

vary depending on the 

Format >HD System Line 

setting.

When the Slow & Quick setting is 

On, sets the frame rate for Slow & 

Quick Motion shooting.

When Format >Country 

is set to other than [PAL 

Area]: 1 to 30

When Format >Country 

is set to [PAL Area]: 1 to 

25 to 30

When the HD System Line setting is 

1080.

When Format >Country 

is set to other than [PAL 

Area]: 1 to 30 to 60

When Format >Country 

is set to [PAL Area]: 1 to 

25 to 60

When the HD System Line setting is 

720.

Picture Cache Rec On/Off Turns the picture cache function on 

or off. (When this is set to On, the 

Slow & Quick, Interval Rec, Frame 

Rec sub-items are set to Off.) 

P. Cache Rec Time 0-2sec/2-4sec/4-6sec/

6-8sec/8-10sec/10-12sec/

12-14sec/13-15sec

When the Picture Cache Rec setting 

is On, set the picture cache time.

Interval Rec On/Off Turns the Interval Rec function on or 

off. (When this is set to On, the Slow 

& Quick, Picture Cache Rec, and 

Frame Rec sub-items are set to Off.)

Frame Rec On/Off Turns the Frame Rec function on or 

off. (When this is set to On, the Slow 

& Quick, Picture Cache Rec, and 

Interval Rec sub-items are set to 

Off.)

Number of Frames The available settings 

vary depending on the 

settings in Format >HD 

System Line and Format 

>System Frequency.

When Interval Rec or Frame Rec is 

set to On, specifies the number of 

frames to shoot in one Interval Rec 

or Frame Rec take.

2frame/6frame/12frame When the HD System Line setting is 

720, and the System Frequency 

setting is 59.94P or 50P.

1frame/3frame/6frame/

9frame

When the HD System Line setting is 

other than 720, or the System 

Frequency setting is other than 

59.94P or 50P.

OPERATION

Menu items Sub-item Settings Description
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Rec Function

Makes settings related 
to special recording 
modes.

Interval Time 1/2/3/4/5/6/7/8/9/10/15/

20/30/40/50 (sec)

1/2/3/4/5/6/7/8/9/10/15/

20/30/40/50 (min) 1/2/3/

4/6/12/24 (hour)

When the Interval Rec setting is On, 

sets the interval for Interval Rec 

shooting.

Pre-Lighting Off/2sec/5sec/10sec If you want the video light to be 

turned on before Interval Rec 

shooting, select a number of seconds 

before the start of shooting. If you 

do not want it to be turned on, select 

Off.

Assignable SW

Assigns functions to 
assignable switches.

See “Assigning 

Functions to Assignable 

Switches” (page 131) 

for more information 

about assigning 

functions.

<0> See page 131. Assigns function to ASSIGN. 0 

switch.

<1> Assigns function to ASSIGN. 1 

switch.

<2> Assigns function to ASSIGN. 2 

switch.

<3> Assigns function to ASSIGN. 3 

switch.

<4> Assigns function to ASSIGNABLE 

4 switch.

<5> Assigns function to ASSIGNABLE 

5 switch.

RET Assigns function to RET button on 

the lens.

C. Temp Assigns function to COLOR TEMP. 

button.

Zoom Speed 0 to 20 to 99 When Zoom has been assigned to 

the ASSIGNABLE 4 or 5 switch, 

specifies the zoom speed.

OPERATION

Menu items Sub-item Settings Description
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VF Setting

Makes settings related 
to the viewfinder 
screen.

Color –99 to ±0 to +99 Adjusts the density of the colors 

displayed in the viewfinder screen.

Mode Color/B&W Selects Color or B&W as the display 

mode of the viewfinder screen. 

(Even when B&W is selected, some 

indications are always displayed in 

color. Examples include tally 

indications, thumbnails, and the skin 

gate area.)

Peaking Type Normal/Color/Both Selects the peaking type.

Normal: Normal peaking

Color: Color peaking

Both: Both

Peaking Frequency Normal/High Selects Normal or High as the 

peaking frequency.

Peaking Color White/Red/Yellow/Blue When the Peaking Type setting is 

Color, selects the peaking color from 

among White, Red, Yellow, and 

Blue.

Peaking Level Low/Mid/High When the Peaking Type setting is 

Both, selects the color peaking level 

from among Low, Mid, and High.

DXF Rec Tally Upper/Both When a separately sold viewfinder is 

installed, specified whether to light 

the tally indicator on the upper side 

only (Upper), or on both the upper 

and lower sides (Both).

OPERATION

Menu items Sub-item Settings Description
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Marker

Makes settings related 
to marker display in the 
viewfinder screen.

Setting On/Off Turns all markers on or off.

Center Marker 1/2/3/4/Off When the center marker is 

displayed, selects the type. Select 

Off if you do not want to display the 

marker.

Center H Position –40 to 0 to 40 Specifies the horizontal position of 

the center marker.

Center V Position –40 to 0 to 40 Specifies the vertical position of the 

center marker.

Safety Zone On/Off Turns the safety zone display on or 

off.

Safety Area 80%/90%/92.5%/95% Selects the safety zone range.

Aspect Marker Line/Mask/Off When an aspect marker is to be 

displayed, selects the display 

method. Select Off if you do not 

want to display the marker.

Line: Show as white lines.

Mask: Display by lowering the 

video signal level of areas 

outside the marker range.

Aspect Select 15:9/14:9/13:9/4:3/

1.66:1/1.85:1/2.35:1/

2.4:1

Selects the aspect ratio of the 

marker.

Aspect Mask 0% to 30% to 90% (10% 

step) 

When the Aspect Marker setting is 

Mask, specifies the video signal 

level of areas outside the marker 

range as a percentage value relative 

to the video signal level of areas 

inside the marker range.

User Box On/Off Turns the box cursor display on or 

off.

User Box Width 40 to 500 to 999 Specifies the box cursor width 

(distance from the center to the left 

and right edges).

User Box Height 70 to 500 to 999 Specifies the box cursor height 

(distance from the center to the top 

and bottom edges).

User Box H Position –479 to 0 to 479 Specifies the horizontal position of 

the box cursor center.

User Box V Position –464 to 0 to 464 Specifies the vertical position of the 

box cursor center.

Guide Frame On/Off Turns display of the guide frame on 

or off.

OPERATION
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Gain Switch

Makes settings related 
to the GAIN switch.

Gain Low –3dB/0dB/3dB/6dB/9dB/

12dB/18dB/24dB/30dB/

36dB/42dB

Specifies the gain value for the 

L position of the GAIN switch.

Gain Mid –3dB/0dB/3dB/6dB/9dB/

12dB/18dB/24dB/30dB/

36dB/42dB

Specifies the gain value for the 

M position of the GAIN switch.

Gain High –3dB/0dB/3dB/6dB/9dB/

12dB/18dB/24dB/30dB/

36dB/42dB

Specifies the gain value for the 

H position of the GAIN switch.

Gain Turbo –3dB/0dB/3dB/6dB/9dB/

12dB/18dB/24dB/30dB/

36dB/42dB

Specifies the gain value for the 

Turbo Gain function, which can be 

assigned to an assignable switch.

Shockless Gain On/Off Turns shockless gain (a function that 

switches smoothly when the gain is 

switched) on or off.

TLCS

Makes settings related 
to total level control.

Mode Backlight/Standard/

Spotlight

Selects the auto iris mode used when 

the TLCS system is activated.

Backlight: Backlight mode (lessens 

the blackout of the main subject 

that occurs under backlit 

conditions)

Standard: Standard mode

Spotlight: Spotlight mode (lessens 

the whiteout of the main subject 

that occurs under a spotlight) 

Speed –99 to ±0 to +99 Specifies the control speed (speed of 

reaction to changes in the video) 

used when the TLCS system is 

activated. (Larger values specify 

quicker reaction times.)

AGC On/Off Turns the AGC (auto gain control) 

function on or off.

AGC Limit 3dB/6dB/9dB/12dB/

18dB

Specifies the maximum gain used 

when AGC is on.

AGC Point F5.6/F4/F2.8 Specifies the F value where control 

by auto iris switches to control by 

AGC, used when AGC is on.

Auto Shutter On/Off Turns the auto shutter function on or 

off.

Auto Shutter Limit 1/100 / 1/150 / 1/200 / 

1/250

Selects the maximum shutter speed 

used when auto shutter is on.

Auto Shutter Point F5.6/F8/F11/F16 Specifies the F value where control 

by auto iris switches to control by 

auto shutter, used when auto shutter 

is on.

Zebra

Makes settings related 
to zebra displays.

Zebra Select 1/2/BOTH Selects the zebra pattern type 

(Zebra1, Zebra2, Both).

Zebla1 Level 50% to 70% to 107% Specifies the Zebra1 display level.

Zebra1 Aperture 

Level

1 to 10% to 20% Specifies the Zebra1 aperture level.

Zebra2 Level 52% to 100% to 109% Specifies the Zebra2 display level.

OPERATION
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Display On/Off

Selects the items to 
display in the 
viewfinder screen.

Video Level 

Warnings

On/Off Turns the warnings that appear when 

the video level is too bright or too 

dark on or off.

Brightness Display On/Off Turns the numerical indication of the 

video brightness on or off.

Histogram Display On/Off Turns the histogram display of video 

signal levels on or off (in HD mode 

only).

Lens Info Off/Meter/Feet Selects meters or feet as the unit for 

display of the depth of field. Select 

Off if you do not want to display the 

depth of field.

Focus Position On/Off Turns the indication of the lens focus 

position on or off.

Zoom Position On/Off Turns the indication of the lens 

zoom position on or off.

Audio Level Meter On/Off Turns the display of the audio level 

meters on or off.

Timecode On/Off Turns the display of time data 

(timecode, user bits, counter, 

duration) on or off.

Battery Remain On/Off Turns the indications of the 

remaining battery time and input 

voltage on or off.

Media Remain On/Off Turns the indication of the 

remaining media capacity on or off.

TLCS Mode On/Off Turns the indication of the TLCS 

operating mode on or off.

Focus Mode On/Off Turns the indication of the focus 

operating mode on or off.

White Balance Mode On/Off Turns the indication of the white 

balance mode on or off.

Filter Position On/Off Turns the indication of the ND filter 

setting on or off.

Iris Position On/Off Turns the indication of the iris 

position on or off.

Gain Setting On/Off Turns the indication of the gain 

setting on or off.

Shutter Setting On/Off Turns the indications of the shutter 

mode and shutter speed on or off.

Color Temp On/Off Turns the indication of the color 

temperature on or off.

Video Format On/Off Turns the indication of the video 

format on or off.

OPERATION
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Display On/Off

Selects the items to 
display in the 
viewfinder screen.

System Line On/Off Turns the indication of the system 

lines on or off.

Rec Mode On/Off Turns the indication of special 

recording modes (S&Q, Interval, 

Frame Rec, Picture Cache Rec) on 

or off.

Extender On/Off Turns the lens extender indication on 

or off.

WRR RF Level On/Off Turns the indication of the digital 

wireless receiver reception level on 

or off.

Clip Number(PB) On/Off Turns the indication of clip 

information on or off.

Auto Iris

Makes settings related 
to auto iris.

Iris Override On/Off Turns iris override (a setting that 

opens or closes the iris more than 

normal) on or off.

Iris Speed –99 to ±0 to +99 Specifies the iris control speed 

(speed of reaction to changes in the 

video). (Larger values specify 

quicker reaction times.)

Clip High light On/Off Turns on or off the function that 

disregards highlights and forces a 

flatter reaction to high luminance.

Iris Window 1/2/3/4/5/6/Var Selects the auto iris detection 

window type.

Var: Variable

Iris Window 

Indication

On/Off Turns the indication of the auto iris 

detection window frame on or off.

OPERATION

Menu items Sub-item Settings Description
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White Setting

Makes settings related 
to auto white balance 
adjustments.

White Switch<B> Memory/ATW Specifies the operating mode 

selected by the B position of the 

WHITE BAL switch.

Memory: Auto white balance

ATW: Auto tracing white balance

Shockless White Off/1/2/3 Specifies the reaction speed when 

the WHITE BAL switch setting is 

changed. Off is an instant reaction, 

and 1 is faster than 2 or 3.

ATW Speed 1/2/3/4/5 Specifies the reaction speed when 

the White Switch<B> setting is 

ATW. 1 is the fastest reaction.

AWB Fixed Area On/Off Specifies whether auto white 

balance is executed at the center of 

the screen.

On: Execute in an area 

corresponding to 25% of the 

height and width of the screen.

Off: Execute in an area 

corresponding to 70% of the 

height and width of the screen.

Filter White Memory On/Off Specifies whether to allocate a white 

balance memory area for each 

FILTER knob position.

On: Allocation a white balance 

memory area for each FILTER 

knob position.

Off: Use A/B memory regardless of 

the filter position.

OPERATION
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Offset White

Makes settings related 
to white balance offset 
values.

Offset White <A> On/Off Specifies whether to add (On) or not 

to add (Off) an offset value to the 

white balance value in memory A.

Warm Cool <A> Approximate color 

temperature

When the setting of Offset 

White<A> is On, specifies (as a 

color temperature) the offset to add 

to the white balance value in 

memory A. (Note that the error 

range becomes larger for higher 

offset color temperatures. Adjust 

while viewing the actual video.)

Warm Cool 

Balance<A>

–99 to ±0 to +99 Specifies a more precise color 

temperature, for use when 

satisfactory video cannot be 

obtained with the Warm Cool <A> 

setting.

Offset White <B> On/Off When this is set to On, the offset 

adjusted set with this item is added 

to the white balance of channel B.

Warm Cool <B> Approximate color 

temperature

When the setting of Offset 

White<B> is On, specifies (as a 

color temperature) the offset to add 

to the white balance value in 

memory B. (Note that the error 

range becomes larger for higher 

offset color temperatures. Adjust 

while viewing the actual video.)

Warm Cool 

Balance<B>

–99 to ±0 to +99 Specifies a more precise color 

temperature, for use when 

satisfactory video cannot be 

obtained with the Warm Cool <B> 

setting.

Shutter Select

Makes settings related 
to shutter speed 
selection.

Shutter Select Second/Degree Specifies the unit used to select 

shutter speeds.

Second: Select in units of seconds.

Degree: Select in units of degrees.

Time Zone

Specifies the time zone.

Zone –12:00 to +0:00 to 

+14:00 (in steps of 

30 minutes) 

Specifies a difference from UTC 

(Greenwich Mean Time) in units of 

30 minutes.

Clip

Make settings for clip 
name or clip 
management.

Title Prefix Text input

Titles can contain upper- 

and lowercase 

alphanumeric characters 

(a to z, A to Z, 0 to 9), 

hyphens (-), and 

underscores (_).

Specifies the title part (four 

alphanumeric characters) of clip 

titles.

Number Set 0001 to 9999 Specifies the initial value of the 

numeric part (four digits) of clip 

names.

Update Media<A>/Media<B> Updates the management files on the 

media in the selected slot (execute 

by selecting Execute).

OPERATION

Menu items Sub-item Settings Description
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a) When the optional CBK-DV01 is installed

PAINT Menu

PAINT

Menu items Sub-item Settings Description

Switch Status

Turns various signal 
correction functions 
and a test signal on or 
off.

Gamma On/Off Turns gamma correction on or off.

Black Gamma On/Off Turns black gamma correction on or 

off.

Matrix On/Off Turns linear matrix correction and 

user matrix correction on or off.

Knee On/Off Turns knee correction on or off.

White Clip On/Off Turns white clip correction on or 

off.

Detail On/Off Turns detail correction on or off.

Aperture On/Off Turns aperture correction on or off.

Flare On/Off Turns flare correction on or off.

Test Saw On/Off Turns the test saw signal on or off.

White

Sets the color 
temperature, and 
performs manual white 
balance adjustment.

Color Temp <A> 1500K to 3200K to 

50000K

Displays the white balance color 

temperature saved in memory A.

Color Temp BAL 

<A>

–99 to ±0 to +99 Specifies the white balance gain 

values saved in memory A (linked R 

gain and B gain).

R Gain <A> –99 to ±0 to +99 Specifies the white balance R gain 

value saved in memory A.

B Gain <A> –99 to ±0 to +99 Specifies the white balance B gain 

value saved in memory A.

Color Temp <B> 1500K to 3200K to 

50000K

Displays the white balance color 

temperature saved in memory B.

Color Temp BAL 

<B>

–99 to ±0 to +99 Specifies the white balance gain 

values saved in memory B (linked R 

gain and B gain).

R Gain <B> –99 to ±0 to +99 Specifies the white balance R gain 

value saved in memory B.

B Gain <B> –99 to ±0 to +99 Specifies the white balance B gain 

value saved in memory B.

Black

Specifies the black 
level (level of the 
unilluminated parts of 
the video).
You can achieve a 
desired look by 
adjusting the black 
level for deeper or 
shallower blacks.

Master Black –99 to ±0 to +99 Specifies the master black level.

R Black –99 to ±0 to +99 Specifies the R black level.

B Black –99 to ±0 to +99 Specifies the B black level.
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Flare

Makes settings related 
to flare.
Flare is light generated 
from a bright image 
region that spreads 
broadly across the 
image, adding light to 
dark regions and 
reducing contrast. It is 
caused by reflection 
inside the lens system.

Flare On/Off Turns flare correction on or off.

Master Flare –99 to ±0 to +99 Sets the master flare correction 

level.

R Flare –99 to ±0 to +99 Sets the R flare correction level.

G Flare –99 to ±0 to +99 Sets the G flare correction level.

B Flare –99 to ±0 to +99 Sets the B flare correction level.

Gamma

Makes settings related 
to gamma.
Gamma correction 
allows you to 
significantly alter the 
impression made by the 
video by adjusting the 
contrast.

Gamma On/Off Turns gamma correction on or off.

Step Gamma 0.35 to 0.45 to 0.90 (0.05 

step) 

Specifies a gamma correction value 

in steps of 0.05

Master Gamma –99 to ±0 to +99 Specifies the master gamma level.

R Gamma –99 to ±0 to +99 Specifies the R gamma level.

G Gamma –99 to ±0 to +99 Specifies the G gamma level.

B Gamma –99 to ±0 to +99 Specifies the B gamma level.

Gamma Select The available settings 

vary depending on the 

setting in Gamma 

Category (see 

“Description”).

Select the gamma table to use in 

gamma correction.

When Gamma Category is STD:

1 DVW: DVW camcorder 

equivalent

2 ×4.5: ×4.5 gain

3 ×3.5: ×3.5 gain

4 240M: SMPTE-240M equivalent

5 R709: ITU-R709 equivalent 

(default setting)

6 ×5.0: ×5.0 gain

When Gamma Category is HG:

1 3250: Condense 325% video input 

to 100% video output

2 4600: Condense 460% video input 

to 100% video output

3 3259: Condense 325% video input 

to 109% video output

4 4609: Condense 460% video input 

to 109% video output (default 

setting)

Gamma Category STD/HG Selects use of standard gamma 

(STD) or HyperGamma (HG).

Black Gamma

Makes settings related 
to black gamma 
correction.
Black gamma 
correction allows you 
to reproduce gradations 
and color nuances in 
black or near-black 
(dark) parts of the 
picture.

Black Gamma On/Off Turns black gamma correction on or 

off.

Gamma Level –99 to ±0 to +99 Specifies the master black gamma 

level.

Range Low/L.Mid/H.Mid/High Selects the black gamma correction 

effective range.

LOW: 0 to 3.6%

L.MID: 0 to 7.2%

H.MID: 0 to 14.4%

HIGH: 0 to 28.8%

PAINT

Menu items Sub-item Settings Description
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Knee

Makes settings related 
to knee correction.
Knee correction is 
processing that 
prevents washout by 
compressing the bright 
parts of the video 
according to an upper 
limit for the dynamic 
range of the recorded 
and output picture. The 
signal level where knee 
processing begins is 
called the “knee point”, 
and the slope of knee 
compression is called 
the “knee slope”.

Knee On/Off Turns knee correction on or off.

Knee Point 50.0% to 95.0% to 

109.0%

Specifies the knee point.

Knee Slope –99 to ±0 to +99 Specifies the knee slope.

Knee Saturation On/Off Turns the knee saturation function 

on or off.

Knee Saturation 

Level 

–99 to ±0 to +99 Specifies the knee saturation level.

White Clip

Makes settings related 
to white clipping 
adjustments.
White clipping is 
processing that limits 
the maximum level of 
video output signals. 
The maximum video 
signal output value is 
called the “white clip 
level”.

White Clip On/Off Turns white clipping adjustment on 

or off.

Level NTSC Area is selected 

for Country

90.0% to 108.0% to 

109.0%

PAL Area is selected for 

Country

90.0% to 105.0% to 

109.0% 

Specifies the white clip level.

PAINT

Menu items Sub-item Settings Description
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Detail(HD Mode)/

Detail(SD Mode)

Makes settings related 
to details adjustments 
in HD mode and SD 
mode.
Detail adjustment is 
processing that 
improves the clarity of 
the video by adding 
detail signals to the 
edges of the subject.

Detail On/Off Turns detail adjustment on or off.

Level –99 to ±0 to +99 Specifies the detail level.

H/V Ratio –99 to ±0 to +99 Specifies the mix ratio between the 

H detail level and the V detail level.

Crispening –99 to ±0 to +99 Specifies the crispening level.

Level Depend On/Off Turns the level depend adjustment 

function on or off.

Level Depend Level –99 to ±0 to +99 Specifies the level depend level.

Frequency –99 to ±0 to +99 Specifies the central frequency for H 

detail signals. Larger values give 

finer details.

Knee Aperture On/Off Turns the knee aperture function on 

or off.

Knee Aperture Level –99 to ±0 to +99 Specifies the knee aperture level.

Limit –99 to ±0 to +99 Specifies the detail limiter values for 

both the white-side and black-side 

direction.

White Limit –99 to ±0 to +99 Specifies the white-side detail 

limiter value.

Black Limit –99 to ±0 to +99 Specifies the black-side detail 

limiter value.

V-BLK Limit –99 to ±0 to +99 Specifies the black-side V detail 

limiter value.

V Detail Creation NAM/G/R+G/Y Selects the source signal used to 

generate the V detail signal.

NAM: A V detail signal created 

from the R signal, or a V detail 

signal created from the G 

signal, or a V detail signal 

created from the B signal, 

whichever is the signal with the 

highest level

G: G signal

G+R: Composite signal comprising 

the G signal and R signal in a 

1:1 ratio

Y: Y signal

Aperture

Makes settings related 
to aperture correction.
Aperture correction is 
processing to improve 
resolution by adding 
high-frequency 
aperture signals to the 
video signal, which 
corrects degeneration 
due to high-frequency 
characteristics.

Aperture On/Off Turns aperture correction on or off.

Level –99 to ±0 to +99 Sets the aperture level.

PAINT

Menu items Sub-item Settings Description
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Skin Detail

Makes settings related 
to skin detail 
correction.
Skin detail correction is 
processing that 
increases or decreases 
the detail level of a 
specified color range 
(skin tone range), for 
the purpose of 
obtaining attractive 
reproduction of skin 
tones.

Skin Detail On/Off Turns skin detail correction on or 

off.

Area Detection Color detection screen Detects the color to be targeted by 

skin detail correction.

Area Indication On/Off Turns on or off the function that 

displays a zebra pattern in the area 

targeted by skin detail correction.

Level –99 to ±0 to +99 Specifies the skin detail level.

Saturation –99 to ±0 to +99 Specifies the saturation of the color 

targeted by skin detail correction.

Hue 0 to 359 Specifies the hue of the color 

targeted by skin detail correction.

Width 0 to 40 to 90 Specifies a range for the hue of the 

color targeted by skin detail 

correction.

Matrix

Makes settings related 
to matrix correction.
Matrix correction 
allows you to adjust the 
color and vividness of 
the video. Depending 
on the effect you want, 
you can select one from 
among a number of 
preset matrixes, which 
define different 
parameter sets. Or you 
can select a user matrix 
with your own 
parameters.

Matrix On/Off Turns the matrix correction function 

on or off.

Preset Matrix On/Off Turns the preset matrix function on 

or off.

Preset Select 1/2/3/4/5/6 Selects a preset matrix.

1: SMPTE-240M equivalent

2: ITU-709 equivalent

3: SMPTE WIDE equivalent

4: NTSC equivalent

5: EBU equivalent

6: PAL equivalent

User Matrix On/Off Turns the user matrix function on or 

off.

User Matrix R-G –99 to ±0 to +99 Specifies a freely defined R-G user 

matrix.

User Matrix R-B –99 to ±0 to +99 Specifies a freely defined R-B user 

matrix.

User Matrix G-R –99 to ±0 to +99 Specifies a freely defined G-R user 

matrix.

User Matrix G-B –99 to ±0 to +99 Specifies a freely defined G-B user 

matrix.

User Matrix B-R –99 to ±0 to +99 Specifies a freely defined B-R user 

matrix.

User Matrix B-G –99 to ±0 to +99 Specifies a freely defined B-G user 

matrix.

PAINT
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Multi Matrix

Makes settings related 
to multi matrix 
correction.
Multi-matrix correction 
allows specific colors 
to be selected for 
saturation correction in 
a 16-axis hue space.

Multi Matrix On/Off Turns the multi matrix correction 

function on or off.

Area Indication On/Off Turns on or off the function that 

displays a zebra pattern in the color 

area targeted by multi matrix 

correction.

Color Detection Color detection screen Detects colors targeted by multi 

matrix correction.

Axis B/B+/MG–/MG/MG+/

R/R+/YL–/YL/YL+/G–/

G/G+/CY/CY+/B–

Specifies a color targeted by multi 

matrix correction (16-axis mode) 

Hue –99 to ±0 to +99 Specifies the hue of the color 

targeted by multi matrix correction 

for each 16-axis mode.

Saturation –99 to ±0 to +99 Specifies the saturation of the color 

targeted by multi matrix correction 

for each 16-axis mode.

V Modulation

Makes settings related 
to V modulation 
shading.
V modulation shading 
corrects vertical 
imbalances in 
sensitivity arising from 
the relationship 
between a lens and 
prism.

V Modulation On/Off Turns V modulation shading on or 

off.

Master V 

Modulation

–99 to ±0 to +99 Specifies the master V modulation 

level.

R V Modulation –99 to ±0 to +99 Specifies the V modulation level of 

R signals.

G V Modulation –99 to ±0 to +99 Specifies the V modulation level of 

G signals.

B V Modulation –99 to ±0 to +99 Specifies the V modulation level of 

B signals.

Low Key Saturation

Makes settings related 
to low key saturation 
correction.
You can correct the 
saturation of colors in 
dark parts of the video 
only.

Low Key Saturation On/Off Turns low key saturation correction 

on or off.

Level –99 to ±0 to +99 Specifies the saturation of colors in 

low luminance areas.

Range Low/L.Mid/H.Mid/High Specifies the luminance level for 

which low key saturation is enabled.

Noise Suppress

Makes settings related 
to noise suppression 
(noise compression).
You can effectively 
suppress noise 
components while 
preserving fine edge 
components in the 
subject.

Noise Suppress On/Off Turns noise suppression on or off.

PAINT
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MAINTENANCE Menu

MAINTENANCE

Menu items Sub-item Settings Description

White Shading

Makes settings related 
to white shading.
White shading is 
required for each 
different lens to correct 
irregularities arising 
from lens 
characteristics. It 
corrects luminance and 
color irregularities in 
bright areas.

Channel Select Red/Green/Blue Selects the target of white shading 

correction.

R/G/B White H Saw –99 to ±0 to +99 Specifies a SAW white shading 

correction value for the horizontal 

direction.

R/G/B White H Para –99 to ±0 to +99 Specifies a parabola white shading 

correction value for the horizontal 

direction.

R/G/B White V Saw –99 to ±0 to +99 Specifies a SAW white shading 

correction value for the vertical 

direction.

R/G/B White V Para –99 to ±0 to +99 Specifies a parabola white shading 

correction value for the vertical 

direction.

White Saw/Para On/Off Turns the white shading SAW and 

parabola correction functions on or 

off.

Black Shading

Makes settings related 
to black shading 
correction.
Black shading is 
required for each 
different lens to correct 
irregularities arising 
from lens 
characteristics. It 
corrects luminance and 
color irregularities in 
dark areas.

Channel Select Red/Green/Blue Selects the target of black shading 

correction.

R/G/B Black H Saw –99 to ±0 to +99 Specifies a SAW black shading 

correction value for the horizontal 

direction.

R/G/B Black H Para –99 to ±0 to +99 Specifies a parabola black shading 

correction value for the horizontal 

direction.

R/G/B Black V Saw –99 to ±0 to +99 Specifies a SAW black shading 

correction value for the vertical 

direction.

R/G/B Black V Para –99 to ±0 to +99 Specifies a parabola black shading 

correction value for the vertical 

direction.

Black Saw/Para On/Off Turns the black shading SAW and 

parabola correction functions on or 

off.

Master Black –99 to ±0 to +99 Specifies the master black level.

Master Gain (TMP) –3dB/0dB/3dB/6dB/9dB/

12dB/18dB/24dB/30dB/

36dB/42dB

Specifies a temporary master gain 

value. (The value is the same as the 

value selected with the GAIN 

switch.)

Battery

Makes settings related 
to batteries.

Info Before End 5%/10%/15%...95%/

100%

Specifies a threshold value that 

triggers a “Battery Before End” 

warning when a BP-GL65/GL95 

battery pack is used.

Info End 0%/1%/2%/3%/4%/5% Specifies a threshold value that 

triggers a “Battery End” warning 

when a BP-GL65/GL95 battery 

pack is used.
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Battery

Makes settings related 
to batteries.

Sony Before End 11.5V to 17V (0.1V step) Specifies a threshold value that 

triggers a “Battery Near End” 

warning when a BP-L60S/L80S 

battery pack is used.

Sony End 11.0V to 11.5V (0.1V 

step) 

Specifies a threshold value that 

triggers a “Battery End” warning 

when a BP-L60S/L80S battery pack 

is used.

Other Before End 11.5V to 11.8V to 17.0V 

(0.1V step) 

Specifies a threshold value that 

triggers a “Battery Near End” 

warning when a non-Sony battery 

pack is used.

Other End 11.0V to 14.0V (0.1V 

step) 

Specifies a threshold value that 

triggers a “Battery End” warning 

when a non-Sony battery pack is 

used.

DC In Before End 11.5V to 11.8V to 17.0V 

(0.1V step) 

Specifies a threshold value that 

triggers a “Battery Near End” 

warning when an external power 

source is connected to the DC IN 

connector.

DC In End 11.0V to 14.0V (0.1V 

step) 

Specifies a threshold value that 

triggers a “Battery End” warning 

when an external power source is 

connected to the DC IN connector.

Detected Battery Info/Sony/Other/DC IN Displays the results of automatic 

battery pack type detection.

Type Detection Auto/Other Auto: Detect the battery type 

automatically.

Other: Fix battery type detection as 

“Other”.

Segment No.10 11.0V to 17.0V (0.1V 

step) 

Specify voltage threshold values 

that cause remaining capacity 

segments to go off in the display of 

remaining battery capacity (see 

page 30). (The segments go off 

below the specified value.)

These values are used when the 

battery type has been found to be 

“Other”.

Segment No.9 11.0V to 16.0V to 17.0V 

(0.1V step) 

Segment No.8 11.0V to 15.0V to 17.0V 

(0.1V step) 

Segment No.7 11.0V to 14.0V to 17.0V 

(0.1V step) 

Segment No.6 11.0V to 13.5V to 17.0V 

(0.1V step) 

Segment No.5 11.0V to 13.0V to 17.0V 

(0.1V step) 

Segment No.4 11.0V to 12.5V to 17.0V 

(0.1V step) 

Segment No.3 11.0V to 12.0V to 17.0V 

(0.1V step) 

Segment No.2 11.0V to 11.5V to 17.0V 

(0.1V step) 

Segment No.1 11.0V to 17.0V (0.1V 

step) 
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Audio

Makes settings related 
to audio.

Front MIC Select Mono/Stereo Selects whether the front 

microphone is monaural (Mono) or 

stereo (Stereo).

Audio CH3/4 Mode Ch1/2 / Switch Selects the input signals for the 

AUDIO IN CH-3/CH-4 connectors.

CH1/2: The same signals as the 

AUDIO IN CH-1/ CH-2 

connectors.

Switch: The signals selected with 

the AUDIO IN CH-3/CH-4 

switches.

Front MIC CH1 Ref –70dB/–60dB/–50dB/

–40dB/–30dB/–20dB

Selects the reference level for 

channel 1 of the front microphone.

Front MIC CH2 Ref –70dB/–60dB/–50dB/

–40dB/–30dB/–20dB

Selects the reference level for 

channel 2 of the front microphone.

Rear MIC CH1 Ref –70dB/–60dB/–50dB/

–40dB/–30dB/–20dB

Selects the reference input level 

when the setting of the AUDIO IN 

CH-1 switch is MIC.

Rear MIC CH2 Ref –70dB/–60dB/–50dB/

–40dB/–30dB/–20dB

Selects the reference input level 

when the setting of the AUDIO IN 

CH-2 switch is MIC.

Line Input Ref +4dB/0dB/–3dB/EBUL Selects the reference input level 

when the AUDIO IN CH-1 and 

AUDIO IN CH-2 switches are set to 

LINE.

Min Alarm Volume Off/Set Selects the volume when the 

ALARM knob is turned all the way 

down.

OFF: Almost inaudible

SET: Fairly audible

Speaker Attenuate Off/3dB/6dB/9dB/12dB Selects the volume from the monitor 

or speakers (does not affect 

earphone volume).

Headphone Out Mono/Stereo Selects whether the earphones are 

monaural (Mono) or stereo (Stereo).

Reference Level –20dB/–18dB/–16dB/

–12dB/EBUL

Selects the output level of the 1 kHz 

test signal.

Reference Out 0dB/+4dB/–3dB/EBUL Specifies the output level with 

respect to the reference input level.

CH1&2 AGC Mode Mono/Stereo For automatic adjustment of the 

input level of analog audio signals 

recorded on channels 1 and 2, 

specifies whether to make the 

adjustments separately for each 

channel (Mono) or in stereo mode 

(Stereo).
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Audio

Makes settings related 
to audio.

CH3&4 AGC Mode Mono/Stereo For automatic adjustment of the 

input level of analog audio signals 

recorded on channels 3 and 4, 

specifies whether to make the 

adjustments separately for each 

channel (Mono) or in stereo mode 

(Stereo).

AGC Spec –6dB/–9dB/–12dB/

–15dB/–17dB

Selects the AGC saturation level.

Limiter Mode Off/–6dB/–9dB/–12dB/

–15dB/–17dB

For manual audio level adjustments, 

selects the saturation level for the 

limiter applied to loud input signals.

Select Off if you do not wish to use 

the limiter.

Output Limiter On/Off Turns the audio output limiter on or 

off.

CH1 Wind Filter On/Off Turns the channel 1 wind filter on or 

off.

CH2 Wind Filter On/Off Turns the channel 2 wind filter on or 

off.

CH3 Wind Filter On/Off Turns the channel 3 wind filter on or 

off.

CH4 Wind Filter On/Off Turns the channel 4 wind filter on or 

off.

Audio SG (1KHz) On/Off/Auto Selects whether to output (On) or 

not output (Off) a 1 kHz test signal 

in color bar mode.

Auto: Output a test signal only 

when the AUDIO SELECT 

CH1 switch is set to AUTO.

MIC CH1 Level Side1/Front/Front+Side1 For recording input audio from the 

front microphone on channel 1, 

selects the knob that adjusts the 

audio level. 

Side1: The LEVEL knob (left) on 

the side panel

Front: The MIC LEVEL knob on 

the front panel

Front+Side1: Adjust with both the 

LEVEL knob (left) and the 

MIC LEVEL knob.

MIC CH2 Level Side2/Front/Front+Side2 For recording input audio from the 

front microphone on channel 2, 

selects the knob that adjusts the 

audio level.

Side2: The LEVEL knob (right) on 

the side panel

Front: The MIC LEVEL knob on 

the front panel

Front+Side2: Adjust with both the 

LEVEL knob (right) and the 

MIC LEVEL knob.
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Audio

Makes settings related 
to audio.

Rear1/WRR Level Side1/Front/Front+Side1 Selects the knob that adjusts the 

audio levels of a wireless 

microphone and a device connected 

to the AUDIO IN CH-1 connector 

on the rear panel.

Side1: The LEVEL knob (left) on 

the side panel

Front: The MIC LEVEL knob on 

the front panel 

Front+Side1: Adjust with both the 

LEVEL knob (left) and the 

MIC LEVEL knob.

Rear2/WRR Level Side2/Front/Front+Side2 Selects the knob that adjusts the 

audio levels of a wireless 

microphone and a device connected 

to the AUDIO IN CH-2 connector 

on the rear panel.

Side2: The LEVEL knob (right) on 

the side panel

Front: The MIC LEVEL knob on 

the front panel

Front+Side2: Adjust with both the 

LEVEL knob (right) and the 

MIC LEVEL knob.

Audio CH3 Level Side3/Front/Front+Side3 Selects the knob that adjusts the 

level of audio recorded on channel 

3. 

Side3: The LEVEL knob on side 

panel

Front: The MIC LEVEL knob on 

the front panel

Front+Side3: Adjust with both the 

LEVEL knob and the MIC 

LEVEL knob.

Audio CH4 Level Side4/Front/Front+Side4 Selects the knob that adjusts the 

level of audio recorded on channel 

4.

Side4: The LEVEL knob on side 

panel

Front: The MIC LEVEL knob on 

the front panel

Front+Side4: Adjust with both the 

LEVEL knob and the MIC 

LEVEL knob.
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WRR Setting

Makes settings related 
to the wireless tuner.

WRR Valid CH Sel All/CH1 Selects whether to enable channels 1 

and 2 of the wireless receiver (All) 

or channel 1 only (CH1).

WRR CH Select TX1/TX2 Specifies the target channel for other 

sub-items.

TX1: Channel 1

TX2: Channel 2

WRR Delay Comp On/Off Enables (On) or disables (Off) delay 

compensation for wireless audio 

input. (When On is selected, the 

audio in all E-E output is delayed by 

about 8 ms.)

TX --- Displays the name of the transmitter 

whose signals are being received on 

the channel selected by WRR CH 

SELECT.

TX Audio Peak ---/Peak Displays whether the AF level of the 

transmitter whose signals are being 

received on the channel selected by 

WRR CH SELECT are over peak.

TX Input Level ---/Mic/Line Displays whether the input level of 

the transmitter whose signals are 

being received on the channel 

selected by WRR CH SELECT is 

set to microphone (Mic) or line 

(Line).

TX ATT Level --- Sets the ATT level of the transmitter 

whose signals are being received on 

the channel selected by WRR CH 

SELECT. (The setting range varies 

depending on the transmitter.)

TX LCF Freq --- Sets the low cut filter frequency of 

the transmitter whose signals are 

being received on the channel 

selected by WRR CH SELECT. 

(The setting range varies depending 

on the transmitter.)

TX System Delay Auto/0.0ms to 8.0ms Specifies the amount of audio delay.

Auto: Automatically adjusts the 

amount of delay so that the 

delay in the audio received 

from the wireless transmitter is 

zero. 

0.0ms to 8.0ms: Sets the amount of 

anticipated wireless system 

delay, for cases in which 

several wireless systems are 

being used over a devices such 

as an audio mixer.
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Timecode

Makes settings related 
to timecode.

TC Out Auto/Generator Selects the source for timecode 

output.

Auto: During recording, output 

values generated by the 

timecode generator, and during 

playback output values 

obtained by the timecode 

reader.

Generator: Output values 

generated by the timecode 

generator during both recording 

and playback.

DF/NDF DF/NDF When the Country setting is other 

than PAL Area, selects drop-frame 

mode (DF) or non-drop-frame mode 

(NDF).

LTC UBIT Fix/Time Specifies the data recorded in LTC 

user bits. 

Fix: Record user-specified data.

Time: Record the current time.

Counter Display Counter/Duration Select the method used to reset the 

counter value displayed on the 

viewfinder screen. 

Counter: Continue to increment 

until the RESET button is 

pressed.

Duration: Reset each time that 

recording is started.

Essence Mark

Makes settings related 
to shot marks and clip 
index picture 
thumbnails.

Ret Shot Mark 1 On/Off Specify whether to input Shot 

Mark1 marks using the RET button 

on the lens.

Ret Shot Mark 2 On/Off Specify whether to input Shot 

Mark2 marks using the RET button 

on the lens.

MAINTENANCE

Menu items Sub-item Settings Description



Menu List122

C
h
a

p
te

r 6
  M

e
n
u

 a
n

d
 D

e
ta

ile
d

 S
e

ttin
g

s

Camera Config

Makes settings related 
to various camcorder 
operations.

Rec Tally Blink On/Off Turns warning flashes by the 

TALLY indicator on or off. The 

warnings alert you an almost 

exhausted battery pack or low 

remaining media capacity.

Rec Review 3sec/10sec/Clip Selects the recording review time.

Clip: Review all of the most 

recently recorded clip.

HD SDI Remote I/F Off/Chara/G-Tally/

R-Tally

Selects whether to use the function 

that enables recording control from 

this camcorder of an external device 

connected to the HD/SD SDI OUT 

connector (HD SDI output). When 

the function is used, also selects the 

indication that shows whether the 

external device is recording.

Off: Do not use the remote 

recording control function. 

Chara: Indicate by the remote 

device indication in the 

viewfinder screen. 

G-Tally: Indicate by the TALLY 

indicator in the viewfinder 

(green tally). 

R-Tally: Indicate by the REC 

indication (recording/Rec tally) 

on the viewfinder screen.

Color Bars Select ARIB/100%/75% Selects the color bar type.

RM Common 

Memory

On/Off Selects whether to share (On) or not 

share (Off) settings between times 

when a remote control unit is 

connected and times when the 

camcorder is used locally.

RM Rec Start RM/CAM/PARA For times when a remote control 

unit is connected, selects whether 

recording start/stop buttons are 

enabled on the camcorder or the 

remote control unit. 

RM: Remote control unit

CAM: Camcorder 

PARA: Both

Image Invert On/Off Turns the function that inverts 

images vertically on or off.
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Preset White

Makes settings related 
to white balance preset 
values.

Color Temp<P> 1500K to 3200K to 

50000K

Specifies the white balance preset 

value.

Color Temp 

Balance<P>

–99 to ±0 to +99 Specifies finer color temperature 

settings, for use when satisfactory 

video cannot be obtained with Color 

Temp<P>.

R Gain <P> –99 to ±0 to +99 Specifies the R gain preset value.

B Gain <P> –99 to ±0 to +99 Specifies the B gain preset value.

AWB Enable <P> On/Off Turns on and off execution of the 

AWB (auto white balance) function 

when the WHITE BAL switch is set 

to PRST.

White Filter

Makes settings related 
to filters.

ND Filter C.Temp On/Off Turns the function that assigns 

electrical CC filters to ND filters on 

or off.

ND FLT C.Temp<1> 3200K/4300K/5600K/

6300K

Selects the color temperature for 

when electrical CC filters are 

assigned to ND filters.

ND FLT C.Temp<2-

4>

3200K/4300K/5600K/

6300K

Selects the color temperature for 

when electrical CC filters are 

assigned to ND filters.

Electrical CC<A> 3200K/4300K/5600K/

6300K

Selects the color temperature for 

when the electrical CC filter 

switching function is assigned to an 

assignable switch.

Electrical CC<B> 3200K/4300K/5600K/

6300K

Selects the color temperature for 

when the electrical CC filter 

switching function is assigned to an 

assignable switch.

Electrical CC<C> 3200K/4300K/5600K/

6300K/-----

Selects the color temperature for 

when the electrical CC filter 

switching function is assigned to an 

assignable switch.

Select “----” if you do not want to 

use C.

Electrical CC<D> 3200K/4300K/5600K/

6300K/-----

Selects the color temperature for 

when the electrical CC filter 

switching function is assigned to an 

assignable switch.

Select “----” if you do not want to 

use D.
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DCC Adjust

Makes settings related 
to DCC (dynamic 
contrast control).

DCC Function Select DCC/Fix Enables or disables automatic knee 

point adjustment when the 

OUTPUT/DCC switch is set to 

CAM, DCC: ON.

DCC: Automatically adjust the 

knee point according to the 

luminance of the subject. 

Fix: Set the knee point to a fixed 

value.

DCC Dynamic 

Range

400%/450%/500%/

550%/600%

Specifies the dynamic range when 

the OUTPUT/DCC switch is set to 

CAM, DCC: ON.

DCC Point –99 to ±0 to +99 Adjusts the DCC minimum knee 

point.

DCC Gain –99 to ±0 to +99 Specifies gain with respect to the 

DCC detected value.

DCC Delay Time –99 to ±0 to +99 Specifies the DCC control speed 

(speed of reaction to changes in the 

video).

DCC Peak Filter –99 to ±0 to +99 Adjusts response sensitivity with 

respect to peaks in DCC detected 

values.
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Auto Iris2

Makes settings related 
to auto iris.

Iris Window 1/2/3/4/5/6/Var Selects the type of iris detection 

window. 

Var: Variable

Iris Window Ind On/Off Turns on or off the function that 

displays a frame marker for the auto 

iris detection window.

Iris Level –99 to ±0 to +99 Adjusts the level of the auto iris 

target value.

Iris APL Ratio –99 to ±0 to +99 Adjusts the mix ratio of auto iris 

detection peak value and average 

value.

Iris Var Width 40 to 500 to 999 Adjusts the width of the detection 

window when the setting of Iris 

Window is VAR.

Iris Var Height 70 to 500 to 999 Adjusts the height of the detection 

window when the setting of Iris 

Window is VAR.

Iris Var H Position –479 to 0 to +479 Specifies the horizontal position of 

the detection window when the 

setting of Iris Window is VAR.

Iris Var V Position –464 to 0 to +464 Specifies the vertical position of the 

detection window when the setting 

of Iris Window is VAR.

Iris Speed –99 to ±0 to +99 Specifies the control speed (speed of 

reaction to changes in the video). 

(Larger values specify quicker 

reaction times.)

Clip High Light On/Off Turns on or off the function that 

disregards highlights and forces a 

flatter reaction to high luminance.

Flicker Reduce

Makes settings related 
to flicker reduction.
Reduces the flicker that 
can occur when a 
subject is shot under a 
light source with a 
periodically varying 
brightness, such as 
fluorescent lights, due 
to the relationship with 
the camcorder’s 
recording frame rate.

Mode Auto/On/Off Enables or disables flicker 

reduction.

On: Always enabled.

Auto: Enabled when flicker is 

detected.

Off: Disabled

Frequency 60Hz/50Hz Set to the frequency of the lighting 

fixture that is causing the flicker. 

(The factory default setting is 50 Hz 

when the Country setting is

“PAL Area”, 60 Hz when it is other 

than “PAL Area”.)

Genlock

Makes settings related 
to genlock.

H Phase(HD) –999 to ±0 to +999 Specifies the H phase of HD output 

when genlock is enabled.

H Phase(SD) –99 to ±0 to +99 Specifies the H phase of SD output 

when genlock is enabled.

Reference Internal/Genlock Displays the type of reference signal 

used by the camcorder.
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ND Comp

Makes settings related 
to ND filter color 
compensation. 
Although the 
differences are very 
slight, each of the built-
in ND filters has 
different color 
characteristics. When 
you switch between ND 
filters, the white 
balance may be 
disturbed. You can 
correct for these slight 
color differences 
automatically by 
registering 
compensation values 
for each filter.

ND Offset Adjust On/Off ND filter color compensation 

function.

Clear ND Offset Execute/Cancel Clears ND filter color compensation 

values (execute by selecting 

Execute).

Lens

Executes auto flange 
back adjustment.

Auto FB Adjust Execute/Cancel Executes auto flange back 

adjustment, only for supported 

lenses (execute by selecting 

Execute).

Auto Shading

Executes auto black 
shading compensation.

Auto Black Shading Execute/Cancel Executes auto shading 

compensation (execute by selecting 

Execute).

Reset Black Shading Execute/Cancel Clears black shading compensation 

values (execute by selecting 

Execute).

Master Gain (TMP) –3dB/0dB/3dB/6dB/9dB/

12dB/18dB/24dB/30dB/

36dB/42dB

Specifies a temporary master gain 

value. (The value is the same as the 

value selected with the GAIN 

switch.)

Trigger Mode

Makes settings related 
to triggers for starting 
and stopping recording.

i.LINK Trigger 

Mode

Internal/Both/External Select Internal when recording start 

and stop operations target S×S 

memory cards only. Select External 

when they target only devices 

connected to the i.LINK (HDV/DV) 

or HD/SD SDI OUT connectors. 

Select Both when they target both 

memory cards and external devices.

Clock Set

Sets the internal clock.

Date/Time Sets the current date and time.

12H/24H 12H/24H Selects the 12-hour format (12H) or 

the 24-hour format (24H) for 

display of times.

Date Mode YYMMDD/MMDDYY/

DDMMYY

Selects the display format for dates. 

YYMMDD: Year, Month, Day

MMDDYY: Month, Day, Year

DDMMYY: Day, Month Year

Language

Selects the language for 
messages.

Language English/Chinese Selects the language for messages 

from English or Chinese.
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Hours Meter

Makes settings related 
to the digital hours 
meter.

Hours(Sys) Displays the cumulative hours of 

use (cannot be reset).

Hours(Reset) Displays the hours of use (can be 

reset).

Reset Execute/Cancel Resets Hours(Reset) to 0. 

(Execute by selecting Execute.)

Version

Displays the camcorder 
firmware version, and 
updates the firmware.

Version Displays the version of the 

camcorder’s firmware.

Version Up Execute/Cancel Updates the firmware (execute by 

selecting Execute).

FILE Menu

FILE

Menu items Sub-item Settings Description

All

Makes settings related 
to ALL file operations.

Display Mode Date&Time/Model 

Name

Selects the items to be displayed in 

the list box that appears when a file 

is saved or loaded.

All File Load Execute/Cancel Loads an ALL file (execute by 

selecting Execute).

All File Save Execute/Cancel Stores an ALL file (execute by 

selecting Execute).

File ID Assigns a name to a file. Names can 

be up to 16 characters in length.

All Preset Execute/Cancel Return all items to their preset 

values (execute by selecting 

Execute).

Store All Preset Execute/Cancel Store the current settings of all items 

as the preset values (execute by 

selecting Execute).

Clear All Preset Execute/Cancel Clear the preset values of all items 

(execute by selecting Execute).

3Sec Clr Preset On/Off Turns on or off the function that 

clears each preset value when the 

MENU CANCEL/PRST/ESCAPE 

switch is pushed up and held for 

three seconds on the CANCEL/

PRST side.
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Scene

Makes settings related 
to scene file operations.

s1 Standard File number and file ID

s2 Standard File number and file ID

s3 Standard File number and file ID

s4 Standard File number and file ID

s5 Standard File number and file ID

sStandard Standard settings

Display Mode Date&Time/Model 

Name

Selects the items to be displayed in 

the list box that appears when a file 

is saved or loaded.

Scene Recall Mem Execute/Cancel Loads a file from internal memory 

(execute by selecting Execute).

Scene Store Mem Execute/Cancel Stores a file in internal memory 

(execute by selecting Execute).

Scene Recall S×S Execute/Cancel Loads a file from an S×S memory 

card (execute by selecting Execute).

Scene Store S×S Execute/Cancel Stores a file to an S×S memory card 

(execute by selecting Execute).

File ID Assigns a name to a file. Names can 

be up to 16 characters in length.

Reference

Makes settings related 
to reference file 
operations.

Reference Store Execute/Cancel Stores the current settings of 

reference file items in the reference 

file that is maintained in internal 

memory (execute by selecting 

Execute).

Reference Clear Execute/Cancel Clear the reference file (execute by 

selecting Execute).

Reference Load Execute/Cancel Load a reference file from an S×S 

memory card (execute by selecting 

Execute).

Reference Save Execute/Cancel Store a reference file to an S×S 

memory card (execute by selecting 

Execute).

File ID Assigns a name to a file. Names can 

be up to 16 characters in length.

Scene White Data On/Off Selects whether to load (On) or not 

load (Off) white balance data when 

Scene >Scene Recall or Scene 

>Standard is executed.
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Lens

Makes settings related 
to lens file operations.

Display Mode Date&Time/Model 

Name

Selects the items to be displayed in 

the list box that appears when a file 

is saved or loaded.

Lens Recall Mem Execute/Cancel Loads a file from internal memory 

(execute by selecting Execute).

Lens Store Mem Execute/Cancel Stores a file in internal memory 

(execute by selecting Execute).

Lens Recall S×S Execute/Cancel Loads a file from an S×S memory 

card (execute by selecting Execute).

Lens Store S×S Execute/Cancel Stores a file to an S×S memory card 

(execute by selecting Execute).

File ID Assigns a name to the most recently 

loaded file. Names can be up to 16 

characters in length.

Source Displays the number of the selected 

file. 

Lens No Offset Execute/Cancel Clears a file (execute by selecting 

Execute).

Lens Auto Recall Off/On/S.Number When the installed lens supports 

serial communication, specifies 

whether to automatically load that 

reference file. 

Off: Do not use this function.

On: Load the reference for the 

model name and reflect the 

contents of the file. 

S.No: For lenses that support serial 

number communication, load 

the lens file that corresponds to 

the serial number and model 

name, and reflect the contents 

of that file. For lenses that do 

not support serial number 

communication, load the 

reference for the model name 

(in the same way as when On is 

selected).

Serial Number Displays the serial number of the 

installed lens (only for lenses that 

support serial communication).

Lens ID Displays the model name of the 

installed lens (only for lenses that 

support serial communication).

L Manufacturer Displays the name of the 

manufacturer of the installed lens 

(only for lenses that support serial 

communication).

M V Modulation –99 to ±0 to +99 Sets a vertical SAW shading 

compensation value in the lens file.

FILE

Menu items Sub-item Settings Description
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Lens

Makes settings related 
to lens file operations.

Lens Center H –40 to 0 to 40 Sets a center marker horizontal 

position in the lens file. 

Lens Center V –40 to 0 to 40 Sets a center marker vertical 

position in the lens file.

Lens R Flare –99 to ±0 to +99 Sets a R flare level in the lens file.

Lens G Flare –99 to ±0 to +99 Sets a G flare level in the lens file.

Lens B Flare –99 to ±0 to +99 Sets a B flare level in the lens file.

Lens W-R Offset –99 to ±0 to +99 Sets a R white balance 

compensation value in the lens file.

Lens W-B Offset –99 to ±0 to +99 Sets a B white balance 

compensation value in the lens file.

Shading Ch Sel Red/Green/Blue Selects the white shading 

compensation target.

L R/G/B H Saw –99 to ±0 to +99 Sets a horizontal SAW white 

shading compensation value in the 

lens file.

L R/G/B H Para –99 to ±0 to +99 Sets a horizontal parabola white 

shading compensation value in the 

lens file.

L R/G/B V Saw –99 to ±0 to +99 Sets a vertical SAW white shading 

compensation value in the lens file.

L R/G/B V Para –99 to ±0 to +99 Sets a vertical parabola white 

shading compensation value in the 

lens file.

FILE

Menu items Sub-item Settings Description
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Using the Assignable SW item of the OPERATION menu, you can assign user-specified functions to the 

ASSIGN. 0 to 3 switches, the ASSIGNABLE 4 and 5 switches, the COLOR TEMP. button, and the RET 

button on the lens. 

The following tables lists the functions that are assigned when the camcorder is shipped from the factory. 

Assigning Functions to Assignable Switches

Switch or button Function Assignable SW setting

ASSIGN. 0 switch No assignment Off

ASSIGN. 1 switch Execute EZ mode, according to the setting of 

OPERATION >TLCS.

EZ Mode

ASSIGN. 2 switch No assignment Off

ASSIGN. 3 switch No assignment Off

ASSIGNABLE 4 switch No assignment Off

ASSIGNABLE 5 switch No assignment Off

RET button During recording or playback: Write a shot mark.

In the other states: Conduct a recording review 

(if playback is allowed).

Lens RET

COLOR TEMP. button Adjust the white balance with the preset white 

balance value of 5600K. 

Color Temp SW 5600K

Functions that can be assigned to the ASSIGN. 0 switch

Assignable switch setting Function State when camcorder 

is next powered on

Off No assignment —

Marker Turn the display of all markers on or off. Setting retained

ATW Hold Hold the white balance setting in the ATW (auto-tracking 

white balance) mode

—

Picture Cache Turn the picture cache function on or off. Setting retained

Freeze Mix Execute the freeze mix function. —

Focus Mag Turn the focus magnification function on or off. Setting not retained

Zebra Turn zebra display on or off. Setting not retained

Shot Mark1 Write Shot Mark1. —

Shot Mark2 Write Shot Mark2. —

OK Mark Add or delete an OK mark. —
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Note

Immediately after you assign a function to the ASSIGN. 2 switch or you switch the recording format, the setting of the 

switch at that point may not match the camcorder’s internal state. After assigning a function, switch the ASSIGN. 2 

switch or power the camcorder off and on again.

Functions that can be assigned to the ASSIGN. 2 switch

Assignable switch setting Function

Off No assignment

Front Mic Switch between stereo and monaural when a stereo microphone is connected.

Marker Turn the display of all markers on or off.

Picture Cache Turn the picture cache function on or off.

Zebra Turn zebra display on or off.

Digital Extender Turn the screen magnification function on or off (only when the option for digital 

extender is installed).

Functions that can be assigned to the ASSIGN. 1 and 3 switches, the 
ASSIGNABLE 4 and 5 switches, and the COLOR TEMP. button

Assignable switch setting Function State when camcorder 

is next powered on

Off No assignment —

Front Mic Switch between stereo (On) and monaural (Off) when a 

stereo microphone is connected.

Setting retained

Marker Turn the display of all markers on or off. Setting retained

Last Clip Delete Delete the most recently recorded clip. —

ATW Turn ATW (auto tracing white balance) mode on or off. Setting not retained

ATW Hold Hold the white balance setting in the ATW mode. —

EZ Mode Execute EZ mode according to the setting of 

OPERATION >TLCS.

Setting retained

Turbo Gain Execute Turbo Gain according to the setting of 

OPERATION >Gain Switch >Gain Turbo.

Setting not retained

Rec Review Conduct a recording review. —

Rec Start or stop recording. —

Picture Cache Turn the picture cache function on or off. Setting retained

Freeze Mix Execute the freeze mix function. Setting not retained

Spotlight Turn the spotlight function in auto iris mode on or off. Setting retained

Backlight Turn the backlight function in auto iris mode on or off. Setting retained

EVF Mode Switch the viewfinder screen between B&W (On) and 

color (Off).

Setting retained

BRT Disp Turn the display of the brightness level on or off. Setting retained

Histogram Turn the histogram display on or off. Setting retained

Lens Info Switch the depth of field indication between off, 

displayed in meters, and displayed in feet.

Setting retained
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Zoom Tele/Wide When a lens that supports serial communication is 

installed, assign the Zoom Tele function to 

ASSIGNABLE 4, and assign the Zoom Wide function to 

ASSIGNABLE 5 (displayed only when <4> and <5> are 

set).

—

Zoom Wide/Tele When a lens that supports serial communication is 

installed, assign the Zoom Wide function to 

ASSIGNABLE 4, and assign the Zoom Tele function to 

ASSIGNABLE 5 (displayed only when <4> and <5> are 

set).

—

Manual Focus Assist Turn the manual focus assist function on or off. Setting retained

Focus Mag Turn the focus magnification function on or off. Setting not retained

Zebra Turn zebra display on or off. Setting not retained

Lens RET During recording or playback: Write a shot mark.

In the other states: Conduct a recording review 

(if playback is allowed).

—

Return Video Display return video signals. —

Shot Mark1 Write Shot Mark1. —

Shot Mark2 Write Shot Mark2. —

OK Mark Add or delete an OK mark. —

Color Temp SW 3200K Adjust the white balance with a 3200K preset value. Setting retained

Color Temp SW 4300K Adjust the white balance with a 4300K preset value. Setting retained

Color Temp SW 5600K Adjust the white balance with a 5600K preset value. Setting retained

Color Temp SW 6300K Adjust the white balance with a 6300K preset value. Setting retained

Electrical CC Function that switches the electrical CC filter (3200K/

4300K/5600K/6300K) applied to white balance 

adjustment values.

Each press of the switch or button switches in the order 

3200Kt4300t5600Kt6300K.

These can also be applied from a menu (apply with 

Electrical CC<A><B><C><D>).

Note

This function is not available when White Filter >ND 

Filter C.Temp in the Maintenance menu is set to On.

If you set ND Filter C.Temp to On after assigning the 

function, the assignable switch ceases to function. 

Setting retained

CC5600K Apply a 5600K electrical CC filter to white balance 

adjustment values.

Setting retained

Digital Extender Turn the screen magnification function on or off (only 

when the option for digital extender is installed).

Setting not retained

Assignable switch setting Function State when camcorder 

is next powered on
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Functions that can be assigned to the RET button on the lens

Assignable switch setting Function State when camcorder 

is next powered on

Off No assignment —

Lens RET During recording or playback: Write a shot mark. 

In the other states: Conduct a recording review (if 

playback is allowed).

—

Return Video Display return video signals. —

Rec Review Execute recording review. —

Shot Mark1 Write Shot Mark1. —

Shot Mark2 Write Shot Mark2. —

OK Mark Add or delete an OK mark. —

Focus Mag Turn the focus magnification function on or off. Setting not retained
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You can save setup menu settings in the 

camcorder’s internal memory and on S×S 

memory cards. This allows you to quickly recall 

an appropriate set of menu settings for the current 

situation.

Setting data is saved in the following categories.

ALL files: ALL files save the setting data of all 

menus. You can save up to 64 ALL files on 

an S×S memory card.

Note

Device specific data (shading, output levels, and 

other data that requires adjustment for the specific 

device) is not saved.

Scene files: Scene file save adjustments to 

PAINT menu items for the purpose of 

shooting a particular scene. You can save up 

to five scene files in the camcorder’s internal 

memory and up to 64 scene files on an S×S 

memory card.

Reference files: Reference files save the 

reference values that are set when you 

execute FILE >Scene > Standard in the setup 

menu. You can save one reference file in the 

camcorder’s internal memory and one on an 

S×S memory card.

Lens files: Lens files save the setting data used to 

compensate for lens characteristics, such as 

flare, white shading, white balance and 

center markers. You can save up to 32 lens 

files in the camcorder’s internal memory and 

up to 64 lens files on an S×S memory card.

The first settings stored in a file are called 

“preset” values.

Even after loading files to set up the camcorder, 

and overwriting original files with new settings, 

you can still recover preset values and reset files 

to their initial states (see page 136).

This section explains how to save setting data in 

an ALL file.

Before starting, insert a writable S×S memory 

card into a memory card slot.

See “Basic Setup Menu Operations” (page 94) for 

information about menu operations.

1 Select FILE >All in the setup menu. 

To assign a name to the data before saving 

it

Assign a name before proceeding to step 2.

For details, see “To assign names to files” 

(page 136).

2 Select All File Save >Execute.

An ALL file list box appears.

File numbers where “No File” is displayed 

are empty file numbers. File numbers with a 

file name or a date and time are the number 

of files that already contain data.

3 Turn the MENU knob to select the 

desired file number.

4 Press the MENU knob.

A confirmation message appears.

5 To execute the save, select [Execute], 

and then press the MENU knob.

To cancel the save, select [Cancel], and 

then press the MENU knob.

If you choose to execute the save, the 

ACCESS lamp lights. A completion message 

appears and the ACCESS lamp goes out 

when the data has been saved to the S×S 

memory card.

If an error message appears

One of the following error messages may appear 

during execution of the save, or as soon as you 

select [Execute]. In this case, the file is not saved 

to the S×S memory card. 

Chapter7 Saving and Loading User Setting Data

Saving and Loading 
Settings

Saving Setting Data
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To assign names to files

Assigning a name before you save data in an ALL 

file can make it easier to distinguish your files.

The following characters can be used in file 

names.

Alphanumeric characters (a–z, A–Z, 0–9) and 

special characters ( ! # $ % & ' ( ) * + , - . / : ; < = 

> ? @ [ \ ] ~)

1 Select FILE >All >File ID in the setup 

menu.

2 Turn the MENU knob to select a 

character, and then press the MENU 

knob.

3 Repeat step 3.

4 When you have finished entering 

characters, press the MENU knob to 

move the cursor to “SET”, and then 

press the MENU knob.

The specified name is displayed.

When you save the file (see page 135), the 

data will be saved under this name.

Note

When you load a file from an S×S memory card, 

the data saved in the camcorder’s internal 

memory is overwritten.

See “Basic Setup Menu Operations” (page 94) for 

information about menu operations.

1 Select FILE >All in the setup menu.

2 Select All File Load >Execute.

A list box of ALL files appears.

File numbers where “No File” is displayed 

are empty file numbers. File numbers with a 

file name or a date and time are the number 

of files that already contain data.

3 Turn the MENU knob to select the 

desired file number.

4 Press the MENU knob.

A confirmation message appears.

5 To execute the load, select [Execute], 

and then press the MENU knob.

To cancel the load, select [Cancel], and 

then press the MENU knob.

If you choose to execute the load, the 

ACCESS lamp lights. The ACCESS lamp 

goes out and a completion message appears 

when the data has been loaded from the S×S 

memory card.

If an error message appears

One of the following error messages may appear 

during execution of the load, or as soon as you 

select [Execute]. In this case, the file is not loaded 

from the S×S memory card.

See “Basic Setup Menu Operations” (page 94) for 

information about menu operations.

1 Select FILE >All in the setup menu.

2 Select [All Preset], and then press the 

MENU knob.

3 To execute the reset, select [Execute], 

and then press the MENU knob.

To cancel the reset, select [Cancel], and 

then press the MENU knob.

If you choose to execute the reset, all settings 

in the ALL file are reset to preset values.

Error message Problem What to do

NG:Cannot Save No recordable 

media is 

inserted.

Insert 

recordable 

media.

NG:Media Full The media is 

full.

Use media with 

free capacity 

remaining.

Loading Setting Data

Error message Problem What to do

NG:No Data • There is no 

readable 

media

• The specified 

file does not 

exist on the 

media

Insert the 

media that 

contains the file 

you want.

Resetting a File after Changing Its 
Contents



Saving and Loading Scene Files 137

C
h

a
p

te
r 7

  S
a
v
in

g
 a

n
d
 L

o
a

d
in

g
 U

s
e

r S
e

ttin
g

 D
a

ta

Scene files allow you to save the following types 

of data.

• Values set in the PAINT menu

• Shutter speeds set in standard mode or ECS 

mode

• White balance data

The data that is saved and loaded depends on the 

setting of FILE >Reference >Scene White Data 

in the setup menu.

To save a scene file to an S×S memory card, 

insert the card into a memory card slot and then 

proceed as follows.

See “Basic Setup Menu Operations” (page 94) for 

information about menu operations.

1 Select FILE >Scene in the setup menu.

To assign a name to the data before saving 

it

Assign a name before proceeding to step 2.

For details, see “To assign names to files” 

(page 136).

2 Select Scene Store Mem or Scene Store 

S×S.

Select Scene Store Mem if you want to save 

the data in the camcorder’s internal memory, 

and select Scene Store S×S if you want to 

save the data on an S×S memory card.

3 Press the MENU knob.

A list box of scene files appears.

File numbers where “No File” is displayed 

are empty file numbers

4 Select the file number under which you 

want to save the data, and then press the 

MENU knob.

A confirmation message appears.

5 To execute the save, select [Execute], 

and then press the MENU knob.

To cancel the save, select [Cancel], and 

then press the MENU knob.

If you selected Scene Store S×S in step 2, the 

ACCESS lamp lights when you execute the 

save.

When the data has been saved to the S×S 

memory card, a completion message appears 

and the ACCESS lamp goes out.

To load a scene file from an S×S memory card, 

insert the S×S memory card into a memory card 

slot, and then proceed as follows.

See “Basic Setup Menu Operations” (page 94) for 

information about menu operations.

1 Select FILE >Scene in the setup menu.

2 Select Scene Recall Mem or Scene 

Recall S×S.

Select Scene Recall Mem if you want to load 

the file from the camcorder’s internal 

memory, and select Scene Recall (S×S) if 

you want to load the file from an S×S 

memory card.

3 Press the MENU knob.

A list box of scene files appears. File 

numbers where “No File” is displayed are 

empty file numbers.

4 Select the desired file number, and then 

press the MENU knob.

A confirmation message appears.

5 To execute the load, select [Execute], 

and then press the MENU knob.

To cancel the load, select [Cancel], and 

then press the MENU knob.

If you selected Scene Recall S×S in step 2, 

the ACCESS lamp lights when you execute 

the load.

When the data has been loaded from the S×S 

memory card, a completion message appears 

and the ACCESS lamp goes out.

Saving and Loading 
Scene Files

Saving Scene Files

Loading Scene Files
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Use FILE >Lens (see page 129) in the setup menu 

to set the data in lens files.

You can set the following data and save it as a 

lens file.

See “Basic Setup Menu Operations” (page 94) for 

information about menu operations.

To save a lens file to an S×S memory card, insert 

the card into a memory card slot and then proceed 

as follows.

See “Basic Setup Menu Operations” (page 94) for 

information about menu operations.

1 Select FILE >Lens in the setup menu.

To assign a name to the data before saving 

it

Assign a name before proceeding to step 2.

For details, see “To assign names to files” 

(page 136).

2 Select Lens Store Mem or Lens Store 

S×S, and press the MENU knob.

Select Lens Store Mem if you want to save 

the data in the camcorder’s internal memory, 

and select Lens Store S×S if you want to save 

the data on an S×S memory card.

3 To execute the save, select [Execute], 

and then press the MENU knob.

To cancel the save, select [Cancel], and 

then press the MENU knob.

If you select [Execute], a list box of lens file 

number appears. File numbers where “No 

File” is displayed are empty file numbers.

4 Select the file number under which you 

want to save the data, and then press the 

MENU knob.

A confirmation message appears.

5 To execute the save, select [Execute], 

and then press the MENU knob.

To cancel the save, select [Cancel], and 

then press the MENU knob.

If you selected Lens Store S×S in step 2, the 

ACCESS lamp lights when you execute the 

save.

When the data has been saved to the S×S 

memory card, a completion message appears 

and the ACCESS lamp goes out.

To load a lens file from an S×S memory card, 

insert the S×S memory card into a memory card 

slot, and then proceed as follows.

See “Basic Setup Menu Operations” (page 94) for 

information about menu operations.

1 Select FILE >Lens in the setup menu.

2 Select Lens Recall Mem or Lens Recall 

S×S, and press the MENU knob.

Select Lens Recall Mem if you want to load 

the file from the camcorder’s internal 

memory, and select Lens Recall S×S if you 

want to load the file from an S×S memory 

card.

3 To execute the load, select [Execute], 

and then press the MENU knob.

Saving and Loading 
Lens Files

Setting Lens File Data

Setting data Sub-items

V modulation shading 

compensation values

M V Modulation

Center marker position Lens Center H

Lens Center V

Flare level Lens R Flare

Lens G Flare

Lens B Flare

White balance 

compensation value

Lens W-R Offset

Lens W-B Offset

White shading 

compensation value

L R/G/B H Saw

L R/G/B H Para

L R/G/B V Saw

L R/G/B V Para

Saving Lens Files Loading Lens Files
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To cancel the load, select [Cancel], and 

then press the MENU knob.

If you select [Execute], a list box of lens files 

appears. File numbers where “No File” is 

displayed are empty file numbers.

4 Select the desired file number, and then 

press the MENU knob.

A confirmation message appears.

5 To execute the load, select [Execute], 

and then press the MENU knob.

To cancel the load, select [Cancel], and 

then press the MENU knob.

If you selected Lens Recall S×S in step 2, the 

ACCESS lamp lights when you execute the 

load.

When the specified lens file has been loaded 

from the S×S memory card, a completion 

message appears and the ACCESS lamp goes 

out.

When you are using a lens that support serial 

communication, you can set up the camcorder by 

automatically loading the lens file that 

corresponds to the lens settings (Lens Auto Recall 

function).

To use the Lens Auto Recall function, set FILE 

>Lens >Lens Auto Recall in the setup menu to 

one of the following.

On: Load the lens file that corresponds to the 

model name.

Off: Do not use the Lens Auto Recall function.

Serial Number: Load the lens file that 

corresponds to the model name and serial 

number (when the lens supports 

communication of the serial number).

If the lens does not support communication of the 

serial number, both settings load the lens file that 

corresponds to the model name.

Loading Lens Files Automatically
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You can connect an RM-B150/B750 Remote Control Unit and operate this camcorder. For connection and 

operation of the RM-B150/B750, refer to the Supplement supplied in the CD-ROM (labeled “Manuals for 

Solid-State Memory Camcorder”).

Select the output signal and use an appropriate cable for the monitor to be connected.

Regardless of whether the signal is HD or SD, the 

same status information and menus can be 

displayed on the external monitor as those on the 

viewfinder screen.

Note

SD signals down-converted for output have the 

following restrictions:

Images of 50P/50i/25P are output as PAL signals, those 

of 59.94P/59.94i/29.97P are output as NTSC signals, and 

those of 23.98P are output as 2-3 pulled-down NTSC 

signals.

Chapter8 Connecting External Devices

Connecting External Monitors

HDMI cable (not supplied)

BNC cable (not supplied)

BNC cable (not supplied)
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HD/SD SDI OUT connector (BNC)

The HD/SD SDI OUT connector can be used to 

connect a device that supports SDI. The device 

type can be a monitor, switcher, or VTR or other 

recording device.

The output from this connector can be turned on 

and off with OPERATION >Input/Output >SDI 

Output in the setup menu (see page 98).

For connection, use a BNC cable (not supplied).

HDMI connector

The HDMI connector can be used to connect a 

device that supports HDMI. The device type can 

be a monitor or VTR or other recording device.

The output from this connector can be turned on 

and off with OPERATION >Input/Output 

>HDMI Output in the setup menu (see page 98).

For connection, use an HDMI cable (not 

supplied).

VIDEO OUT connector

The VIDEO OUT connector can be used to 

connect a device that supports analog composite 

signal. The device type can be a monitor or VTR 

or other recording device.

The analog composite signal output from this 

connector is the same as the NTSC or PAL 

encoded signal that is output from the HD/SD 

SDI OUT connector when the setting of output is 

SD signal (you can switch between NTSC and 

PAL with OPERATION >Format >Country in 

the setup menu (see page 96)).

To input the VIDEO OUT connector output 

signal to an external analog composite device, it 

may be necessary to change the input signal 

setting of that external device to be matched with 

the analog composite signal setting for the 

VIDEO OUT connector.

To input camcorder output audio to an external 

device such as a monitor or VTR or other 

recording device, connect the audio output of the 

AUDIO OUT connector to the audio input of that 

external device.

For connection, use a BNC cable (not supplied).

i.LINK (HDV/DV) connector

The i.LINK (HDV/DV) connector supports HDV 

and DV input/output. However, DV streams 

cannot be recorded on this camcorder.

This connector can be used to connect a device 

that supports i.LINK (HDV). The device type can 

be a monitor, read/write device such as VTR or 

HDD, or computer.

To input/output HDV signals

HDV input/output is supported when the video 

format is an HDV compatible format (SP 1440/

59.94i, SP 1440/50i, or SP 1440/23.98P), Input/

Output >Output&i.LINK in the OPERATION 

menu is set to [HD&HDV] or [SD&HDV], and 

Input/Output >i.LINK I/O is set to [Enable].

When the video format is SP 1440/23.98P, a 

59.94i HDV signal subjected to 2-3 pulldown 

processing is output.

To input/output DV signals

DV input/output is supported under either of the 

following conditions.

• Input/Output >i.LINK I/O in the OPERATION 

menu is set to [Enable] on SD mode.

• On HD mode, the video format is other than DV 

incompatible formats (HQ 1920/23.98P, HQ 

1440/23.98P, and HQ 1280/23.98P), Input/

Output >Output&i.LINK is set to [SD&DV], 

and Input/Output >i.LINK I/O is set to 

[Enable].
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The clips recorded on S×S memory cards with 

this camcorder can be controlled on a computer or 

edited using the optional nonlinear editing 

software.

For these purposes, the clips on an S×S memory 

card can be operated by directly loading the card 

in a computer or by connecting the camcorder or 

the optional SBAC-US10 S×S Memory Card 

USB Reader/Writer to the computer, using an 

USB cable as shown below.

Preparations

To use the ExpressCard slot of a computer

If the computer is equipped with an ExpressCard/

34 or ExpressCard/54 slot, you can directly insert 

the S×S memory card containing clips recorded 

with this camcorder and access to the files.

For the operating requirements for the computer, see 

“Using the CD-ROM” (page 12).

Note

The S×S Device Driver Software on the CD-ROM 

supplied with the camcorder must be installed on your 

computer. Before installation, be sure to read the 

enclosed S×S Device Driver Software End-User License 

Agreement.

For information on installation of the driver 

software, refer to the ReadMe on the supplied CD-

ROM.

For support information for the driver software, visit 

the following URL:

http://www.sony.net/S×S-Support/

With a Windows computer

Check that a Removable Disk appears in My 

Computer. This indicates normal status.

With a Macintosh computer

An icon is displayed on the menu bar.

To connect with a USB cable

When you connect the camcorder or the SBAC-

US10 S×S Memory Card USB Reader/Writer 

(optional) using a USB cable (not supplied), the 

memory card in the slot is acknowledged as an 

extended drive by the computer.

When two memory cards are mounted in this 

camcorder, they are acknowledged as two 

independent extended drives by the computer.

Notes

• When connecting the USB cable to the computer, be 

careful to check the form and direction of the USB 

connector.

• The camcorder does not work on the bus power from 

the computer. 

To connect a computer to the USB 
connector

Note

When a computer is connected to the USB connector of 

the camcorder and at the same time an optional 

PHU-60K/120K/120R Professional Hard Disk Unit 

(powered from a battery) is connected to the computer, 

battery exhaustion on the PHU-60K/120K/120R 

(indicated by a Battery End warning) disables the 

following.

Operating Clips with a 
Computer

S
xS

 P
R

O
   8

G
B

To the ExpressCard slot

S×S memory card 
Computer with S×S 
Device Driver 
Software installed

S
xS

 P
R

O
   8

G
B

USB cable 
(not supplied)

S×S memory card 
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• To guard the PHU-60K against access from the 

computer

• To disconnect the PHU-60K’s cable from the memory 

card slot or plug again the cable into the slot

• To turn on the tally indicator on the viewfinder screen 

to warn the operator

When you connect a computer to the USB 

connector with a USB cable (not supplied), the 

message “Connect USB Now?” is displayed to 

prompt you to confirm that you wish to enable the 

USB connection.

If you select “Cancel” or push the MENU 

CANCEL/PRST/ESCAPE down to the ESCAPE 

side or if you disconnect the USB cable, the 

message “Connect USB Now?” disappears.

If you select “Execute” and press the MENU 

knob, the USB connection is enabled and this 

camcorder is recognized as an extension drive. 

You can carry out the same operations by using 

the arrow buttons (J, j, K, k) (see page 21).

If the USB connection is enabled during 

recording/playback operation, the operation is 

stopped and the message “USB Connecting” 

appears on the viewfinder screen.

At this time, the output signal from the VIDEO 

OUT connector, HDMI connector, and HD/SD 

SDI OUT connector changes to a black signal.

Notes

• The camcorder cannot be operated for recording, 

playback, and so on while the message “USB 

Connecting” is displayed.

• When the computer accesses the media loaded in the 

camcorder, do not try to carry out the following 

operations.

- Operating the camcorder (turning the power on/off, 

switching the operation mode, etc.)

- Removing or loading a media from an active slot 

(being accessed from the computer)

- Removing or connecting the USB cable

Disabling the USB connection

To disable the USB connection, follow the same 

procedure as that for removing a device from the 

computer.

To enable the USB connection again, first 

disconnect the USB cable and then reconnect it. 

The message “Connect USB Now?” appears 

again.

Note

If you connect the camcorder to the computer using an 

i.LINK cable, you cannot use the computer to operate 

files stored in a recording media loaded in the memory 

card slot of this camcorder.

To remove an S×S memory card

Windows

1. Click on the icon of “Safely Remove 

Hardware” on the task bar of the computer.

2. Select “Safely remove S×S Memory Card - 

Drive(X:)” from the displayed menu.

3. Check that the Safe To Remove Hardware 

message appears then remove the card.

Macintosh

Drag the S×S memory card icon on the desktop to 

Trash.

If the S×S memory card icon is located on Finder, 

click on the eject icon on its side.

Note

Do not select “Card Power Off” from the S×S memory 

card icon displayed on the menu bar.

To use the XDCAM EX Clip Browsing 
Software

To copy clips to the local disk of a computer, the 

XDCAM EX Clip Browsing Software must be 

used.

Install the XDCAM EX Clip Browsing Software 

on the supplied CD-ROM to your computer.

Although the data regarding recorded materials 

are stored over multiple files and folders, you can 

easily handle the clips without considering such 

data and directory structure by using the XDCAM 

EX Clip Browsing Software.

Note

If you operate, e.g. copy the clips on the S×S memory 

card by using the Explorer (Windows) or Finder 

(Macintosh), the subsidiary data contained by the clips 
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may not be maintained. To avoid such a problem, use the 

XDCAM EX Clip Browsing Software.

For the operating requirements, see “XDCAM EX 

web sites” (page 12), and for installation and 

operations, refer to the User’s Guide contained in 

the CD-ROM. 

For support information on the XDCAM EX Clip 

Browsing Software, visit the web sites shown in 

“XDCAM EX web sites” (page 12) or on the cover 

page of the supplied CD-ROM.

To use a nonlinear editing system

For a nonlinear editing system, optional editing 

software that corresponds to the recording 

formats used with this camcorder is required.

Store the clips to be edited on the HDD of your 

computer in advance, using the supplied 

XDCAM EX Clip Browsing Software.

Some editing software may not operate properly. 

Be sure to confirm before use that it conforms to 

the recording formats used with this camcorder.

To use Final Cut Pro of Apple Inc.

It is necessary to convert the clips to files that can 

be edited with the Final Cut Pro, using XDCAM 

Transfer.

For information on XDCAM Transfer, visit the web 

sites shown in “XDCAM EX web sites” (page 12) or 

on the cover page of the supplied CD-ROM.

You can record the same images as those 

recorded on the memory card in this camcorder 

on an external device connected to the i.LINK 

(HDV/DV) connector, or record the playback 

picture of the external device on the memory card 

in the camcorder.

When you connect the camcorder to a non-linear 

editing system that supports HDV format, you 

can edit the images recorded on the memory card 

in the camcorder.

Notes

• When you set OPERATION >Input/Output 

>Output&i.LINK in the setup menu to [480P (570P)], 

no signal is output from the HD/SD SDI OUT 

connector.

• Use the i.LINK (HDV/DV) connector only for one-to-

one i.LINK connection.

• When you change a setting which affects output 

signals from the i.LINK (HDV/DV) connector, such as 

HD/SD, HD System Line, System Frequency, and Rec 

Format under OPERATION >Format in the setup 

menu or i.LINK I/O and Down Converter under 

OPERATION >Input/Output in the setup menu, 

disconnect the i.LINK cable and change the setting. 

Changing such a setting with the i.LINK cable 

connected may cause improper operation of the 

connected i.LINK device.

• The external signal input via the i.LINK connection 

that can be recorded on the camcorder is HDV streams 

only. You cannot record DV streams via the i.LINK 

connection.

The picture being shot with this camcorder is 

output as an HDV or DV stream via the i.LINK 

(HDV/DV) connector. It can be recorded on a 

connected HDV or DVCAM recorder in 

synchronization with a recording start/stop 

operation on this camcorder.

1 Perform the preparatory settings of the 

camcorder.

Connecting an External 
Device (i.LINK 
Connection)

Recording the Camera Picture on 
an External Device
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• Set OPERATION >Input/Output >Output 

& i.LINK in the setup menu (see page 98) 

to “HD & HDV” or “SD & HDV”.

HD & HDV or SD & HDV: To output an 

HDV stream in HD mode when the 

video format is set to an HDV 

compatible format (SP 1440/59.94i, 

SP 1440/50i, or SP 1440/23.94P)

SD & DV: To output a DV stream

• Set OPERATION >Input/Output >i.LINK 

I/O in the setup menu to [Enable].

• Set MAINTENANCE >Trigger Mode 

>i.LINK Trigger Mode in the setup menu 

(see page 126) to [Both] or [External].

Both: To perform recording both on the 

memory card in this camcorder and on 

the external device

External: To perform recording only on 

the external device

2 Set the external device to recording 

standby status.

For operations of the external device, refer to 

the operation manual of that device.

3 Start recording.

The external device starts recording in 

synchronization.

The status of the external device is displayed in 

the i.LINK status indication area (see page 31) on 

the viewfinder screen.

Notes

• Operation may be different depending on the type of 

external device.

• Although there is some time lag from which you start 

recording until the i.LINK status indication changes, 

the same pictures are recorded on the memory card in 

this camcorder and the external device if 

MAINTENANCE >Trigger Mode >i.LINK Trigger 

Mode is set to [Both].

• While you can record shot marks on the memory card 

during recording, they are not added to the pictures 

recorded on the external device.

You can transfer an HDV stream to a nonlinear 

editing system connected via the i.LINK (HDV/

DV) connector.

Notes

• The i.LINK (HDV/DV) connector of this camcorder is 

a 6-pin connector. Check the number of pins of the 

i.LINK connector on your computer and use an 

appropriate i.LINK cable.

• In searching pictures of this camcorder on the 

computer, it may take some time until the display is 

reflected on the computer.

• If the playback clip is short or the playback starting 

point is near the end of the clip, the i.LINK signal may 

be interrupted between the clip and the next clip. When 

you try to capture such a signal using the nonlinear 

editing system, a malfunction may occur, depending 

on the nonlinear editing software in use.

• If you specify a search speed other than 4, 15, or 24 

times normal with the nonlinear editing system, no 

i.LINK signal is fed out. In such a case, the picture on 

the LCD monitor may stay frozen.

• High-speed playback picture may not be displayed on 

the computer screen, depending on the nonlinear 

editing software in use.

Setting on this camcorder

Set OPERATION >Input/Output >i.LINK I/O in 

the setup menu to [Enable].

For operations of the nonlinear editing software, 

refer to the operation manual of the software.

The HDV stream input from a device connected 

via the i.LINK (HDV/DV) connector can be 

recorded on an S×S memory card in this 

camcorder.

The timecodes superimposed on the i.LINK input 

are recorded regardless of the settings of the 

camcorder.

Note

DV stream cannot be recorded.

1 Set the external signal to a format that 

can be recorded on the camcorder.

Select an HDV compatible format (SP 1440/

59.94i, SP 1440/50i, or SP 1440/23.94P) for 

the video format.

Indication Status of the external device

STBY In HDV recording standby

zREC In HDV recording

STBY In DV recording standby

REC In DV recording

HDV

HDV

DV

DV

Nonlinear Editing

Recording External Input Signals
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2 Make the following settings with 

OPERATION >Input/Output in the 

setup menu (see page 98).

• Set Output&i.LINK to [HD&HDV] or 

[SD&HDV].

• Set i.LINK I/O to [Enable].

• Set Source Select to [i.LINK].

The input video is displayed on the 

viewfinder screen or the monitor connected 

to the VIDEO OUT connector.

Audio signals are output through the built-in 

speakers, the headphones connected to the 

EARPHONE connector, and the speakers of 

the monitor connected to the VIDEO OUT 

connector.

3 Start the recording.

Notes

• An error is generated in the following cases. In such a 

case, cancel Recording mode.

- The video format of input signal does not match that 

specified on the camcorder.

- A copy-protected stream is being fed in.

• If the input to the camcorder becomes no signal during 

recording, the TALLY indicators, the tally indicator on 

the front of the viewfinder, and the REC indication 

(zREC) on the viewfinder screen flash, indicating that 

no signal is being recorded on the S×S memory card.

When an input signal is resumed, recording is 

restarted, incrementing the clip number on the memory 

card.
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Check the functions of the camcorder before 

setting out for a shooting session, preferably by 

recording and playing back video and audio 

signals.
Use a dust blower to clean the lens, the LCD 

screen, and mirror inside the viewfinder barrel.

Note

Never use organic solvents such as thinners.

The battery terminal of this unit (the connector for 

battery packs and AC adaptors) is a consumable 

part.

Power may not be supplied to the unit properly if 

the pins of the battery terminal are bent or 

deformed by shock or vibrations, or if they 

become corroded due to prolonged outdoor use.

Periodic inspections are recommended to keep 

the unit working properly and to prolong its 

usable lifetime.

Contact a Sony service or sales representative for 

more information about inspections.

Chapter9 Maintenance

Testing the Camcorder Maintenance

Cleaning the Viewfinder

Note about the Battery Terminal
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If a problem occurs when the camcorder is powered or is being operated, a warning is issued by various 

visible and audible indicators. These visible and audible indicators are:

• Warning message (“A” in the “Layout of the table of warning messages” below)

• WARNING indicator (“B”), warning sound from the speaker and earphones (“C”), tally/REC indication 

(“D”), and battery remaining indicator (“E”).

A warning message, and the REC indication appear on the viewfinder screen.

The volume of the warning sound can be adjusted with the ALARM knob. Set the ALARM knob to the 

minimum position to suppress the sound.

Layout of the table of warning messages

• The operation of the WARNING indicator, the tally/REC indication, and the battery indicator is 

represented by graphic symbols as follows.

: Continuous

: 1 flash/s

: 4 flashes/s

• The warning sounds are represented by graphic symbols as follows.

: Continuous beep

: 1 beep/s

Operation Warnings
A

WARNING indicator Warning sound Tally/REC Battery remaining

B C D E

Problem Operation in the recorder 

module

Action to take

M
e
d

ia
 N

e
a

r
 F

u
ll

WARNING indicator Warning sound Tally/REC Battery remaining

  —

Problem Operation in the recorder 

module

Action to take

Free space on the S×S 

memory card has 

become insufficient.

Recording continues. Replace it with another at the earliest opportunity.

M
e
d

ia
 F

u
ll

WARNING indicator Warning sound Tally/REC Battery remaining

  —

Problem Operation in the recorder 

module

Action to take

No space is left on the 

S×S memory card. 

Recording, clip 

copying and clip 

division cannot be 

performed.

Recording stops. Replace it with another.
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 N
e
a
r
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n
d

WARNING indicator Warning sound Tally/REC Battery remaining

  

Problem Operation in the recorder 

module

Action to take

The battery power will 

be exhausted soon.

Recording continues. Charge the battery pack at the earliest 

opportunity.

B
a
tt

e
ry

 E
n

d

WARNING indicator Warning sound Tally/REC Battery remaining

  

Problem Operation in the recorder 

module

Action to take

The battery pack is 

exhausted. Recording 

cannot be performed.

Recording stops. Connect a power source via the DC IN connector 

or stop operation to charge the battery pack.

T
e
m

p
e
ra

tu
re

 H
ig

h

WARNING indicator Warning sound Tally/REC Battery remaining

  —

Problem Operation in the recorder 

module

Action to take

The internal 

temperature has risen 

above a safe operation 

limit.

Recording continues. Suspend operation, turn off the power, and wait 

until the temperature falls.

V
o
lt

a
g

e 
L

o
w

WARNING indicator Warning sound Tally/REC Battery remaining

  

Problem Operation in the recorder 

module

Action to take

The DC IN voltage has 

become low (stage 1).

Recording continues. Check the power supply.

In
su

ff
ic

ie
n

t 
V

o
lt

a
g

e

WARNING indicator Warning sound Tally/REC Battery remaining

  

Problem Operation in the recorder 

module

Action to take

The DC IN voltage is 

too low (stage 2). 

Recording cannot be 

performed.

Recording stops. Connect other power source.

B
a

tt
e
r
y
 E

r
ro

r

P
le

a
se

 C
h

a
n

g
e
 B

a
tt

e
r
y. WARNING indicator Warning sound Tally/REC Battery remaining

— — — —

Problem Operation in the recorder 

module

Action to take

An error was detected 

with the battery pack.

Recording stops. Replace the battery pack with a normal one.
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P
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a
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 C
h

a
n

g
e.

WARNING indicator Warning sound Tally/REC Battery remaining

— — — —

Problem Operation in the recorder 

module

Action to take

The remaining power 

of the backup battery 

is insufficient.

Recording continues. Refer to a Sony service representative to replace 

the battery with a new one.

U
n

k
n

o
w

n
 M

e
d

ia
(A

)1
)

P
le

a
se

 C
h

a
n

g
e
.

WARNING indicator Warning sound Tally/REC Battery remaining

— — — —

Problem Operation in the recorder 

module

Action to take

A partitioned memory 

card or one that 

contains recorded clips 

exceeding the number 

permitted with this 

camcorder is loaded.

Recording continues. This card cannot be used with this camcorder. 

Remove it and load a compatible card.

R
ea

ch
e
d

 C
li

p
 N

u
m

b
e
r 

L
im

it

C
a
n

n
o
t 

R
e
c
o

r
d

 t
o
 M

ed
ia

(A
)1

) WARNING indicator Warning sound Tally/REC Battery remaining

— — — —

Problem Operation in the recorder 

module

Action to take

The maximum number 

of clips for a single 

memory card is 

reached. No more clip 

can be recorded on the 

card.

Recording stops. Replace it with another card.

M
e
d

ia
 E

rr
o
r

M
e
d

ia
(A

)1
)  N

e
e
d

s 
to

 b
e 

R
e
st

o
re

d WARNING indicator Warning sound Tally/REC Battery remaining

— — — —

Problem Operation in the recorder 

module

Action to take

An error occurred with 

the memory card. The 

card requires 

restoration.

Recording stops. Remove the card, load it again, and restore it.

M
ed

ia
 E

r
ro

r

C
a
n

n
o
t 

R
e
co

rd
 t

o
 M

e
d

ia
(A

)1
)

WARNING indicator Warning sound Tally/REC Battery remaining

— — — —

Problem Operation in the recorder 

module

Action to take

Recording cannot be 

done, as the memory 

card is defective.

Recording stops. As playback may be possible, it is recommended 

to replace it with another card after copying the 

clips, as required.
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C
a

n
n

o
t 

U
se

 M
ed

ia
(A

)1
) WARNING indicator Warning sound Tally/REC Battery remaining

— — — —

Problem Operation in the recorder 

module

Action to take

Neither recording nor 

playback can be done, 

as the memory card is 

defective.

Recording stops. It cannot be operated with this camcorder. 

Replace it with another card.

C
a

n
n

o
t 

U
se

 M
ed

ia
(A

)1
)

U
n

su
p

p
o

rt
e
d

 F
il

e
 S

y
st

e
m WARNING indicator Warning sound Tally/REC Battery remaining

— — — —

Problem Operation in the recorder 

module

Action to take

A card of a different 

file system was 

inserted.

Recording stops. It cannot be used with this camcorder. Replace it 

with another card.

V
id

eo
 F

o
r
m

a
t 

M
is

m
a
tc

h

WARNING indicator Warning sound Tally/REC Battery remaining

— — — —

Problem Operation in the recorder 

module

Action to take

The external signal 

input via the i.LINK 

connection cannot be 

recorded, as the Video 

Format setting is 

different from the 

signal format of the 

external input signal.

Recording stops. Change settings of OPERATION >Format in the 

setup menu to match it to that of the external 

signal.

C
o

p
y
 P

ro
te

c
te

d
 I

n
p

u
t

C
a

n
n

o
t 

R
ec

o
rd

WARNING indicator Warning sound Tally/REC Battery remaining

— — — —

Problem Operation in the recorder 

module

Action to take

The external signal 

input via the i.LINK 

connection cannot be 

recorded, as the stream 

is copy-protected.

Recording stops. Check the input signal.

D
V

C
A

M
 I

n
p

u
t

C
a
n

n
o
t 

R
e
co

rd

WARNING indicator Warning sound Tally/REC Battery remaining

— — — —

Problem Operation in the recorder 

module

Action to take

The external signal 

input via the i.LINK 

connection cannot be 

recorded, as it is a DV 

stream.

Recording stops. —
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y
b

a
c
k

 H
a
lt

e
d

WARNING indicator Warning sound Tally/REC Battery remaining

— — — —

Problem Operation in the recorder 

module

Action to take

An error occurred in 

reading data from the 

memory card, and 

playback cannot be 

continued.

Recording stops. If this frequently occurs, change the memory card 

after copying the clips, as required.

M
e
d

ia
(A

)1
)  E

r
ro

r

WARNING indicator Warning sound Tally/REC Battery remaining

— — — —

Problem Operation in the recorder 

module

Action to take

Recording cannot be 

done, as an error 

occurred with the 

memory card.

Recording stops. If this frequently occurs, change the memory 

card.

H
D

D
 A

2
)  B

a
tt

e
r
y

 N
ea

r 
E

n
d WARNING indicator Warning sound Tally/REC Battery remaining

—

Problem Operation in the recorder 

module

Action to take

The battery power of 

the connected HDD 

will be exhausted 

soon.

Recording continues. Change the battery at the earliest opportunity.

H
D

D
 A

2
)  B

a
tt

e
ry

 E
n

d

WARNING indicator Warning sound Tally/REC Battery remaining

—

Problem Operation in the recorder 

module

Action to take

The battery of the 

connected HDD is 

exhausted. Recording 

cannot be performed.

Recording stops. Stop operation to change the battery.
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) WARNING indicator Warning sound Tally/REC Battery remaining
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Problem Operation in the recorder 

module

Action to take

There is not enough 

capacity for copying.

Recording continues 

(disallowing copy).

Replace the card in slot A with another one.
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WARNING indicator Warning sound Tally/REC Battery remaining

— — — —

Problem Operation in the recorder 

module

Action to take

The card has already 

ten clips having the 

same name as that you 

tried to duplicate.

Recording continues 

(disallowing copy).

Replace the card in slot A with another one.
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WARNING indicator Warning sound Tally/REC Battery remaining
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Problem Operation in the recorder 

module

Action to take

There is not enough 

capacity for dividing a 

clip.

Recording continues 

(disallowing divide).
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n WARNING indicator Warning sound Tally/REC Battery remaining
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Problem Operation in the recorder 

module

Action to take

Will switch to other 

slot soon.

Recording continues. Make sure that a memory card is loaded in the 

other slot.
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WARNING indicator Warning sound Tally/REC Battery remaining
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Problem Operation in the recorder 

module

Action to take

There is no clip to be 

displayed.

Recording continues. —
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WARNING indicator Warning sound Tally/REC Battery remaining

— — — —

Problem Operation in the recorder 

module

Action to take

There is no clip with 

the OK mark.

Recording continues. —
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WARNING indicator Warning sound Tally/REC Battery remaining
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Problem Operation in the recorder 

module

Action to take

The card has already 

clips having the same 

name as that you tried 

to duplicate.

Recording continues 

(disallowing copy).

Replace the card in slot A with another one.
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WARNING indicator Warning sound Tally/REC Battery remaining

— — — —

Problem Operation in the recorder 

module

Action to take

The memory card 

comes to the end of its 

service life.

Recording stops. Make a backup copy and replace the card with 

another one as soon as possible. Recording/

playback may not be performed properly if you 

continue to use the card.

For details, refer to the operating instructions of 

the memory card.



Important Notes on Operation 155

A
p

p
e
n

d
ix

Use and storage

Do not subject the camcorder to severe shocks

The internal mechanism may be damaged or the 

body warped.

Do not cover the camcorder while operating

Putting a cloth, for example, over the camcorder 

can cause excessive internal heat build-up.

After use

Always turn off the POWER switch.

Before storing the camcorder for a long period

Remove the battery pack.

Shipping

• Remove the media before transporting the 

camcorder.

• If sending the camcorder by truck, ship, air or 

other transportation service, pack it in the 

shipping carton of the camcorder.

Care of the camcorder

Remove dust and dirt from the surfaces of the 

lenses or optical filters using a blower.

If the body of the camcorder is dirty, clean it with 

a soft, dry cloth. In extreme cases, use a cloth 

steeped in a little neutral detergent, then wipe dry. 

Do not use organic solvents such as alcohol or 

thinners, as these may cause discoloration or 

other damage to the finish of the camcorder.

In the event of operating problems

If you should experience problems with the 

camcorder, contact a Sony service representative.

Use and storage locations

Store in a level, ventilated place. Avoid using or 

storing the camcorder in the following places.

• In excessive heat or cold (operating temperature 

range: 0°C to +40°C (32°F to 104°F))

• Remember that in summer in warm climates the 

temperature inside a car with the windows 

closed can easily exceed 50°C (122°F).

• In damp or dusty locations

• Locations where the camcorder may be exposed 

to rain

• Locations subject to violent vibration

• Near strong magnetic fields

• Close to radio or TV transmitters producing 

strong electromagnetic fields.

• In direct sunlight or close to heaters for 

extended periods

To prevent electromagnetic interference from 

portable communications devices

The use of portable telephones and other 

communications devices near this camcorder can 

result in malfunctions and interference with audio 

and video signals.

It is recommended that the portable 

communications devices near this camcorder be 

powered off.

Note on laser beams

Laser beams may damage the CMOS image 

sensors.

If you shoot a scene that includes a laser beam, be 

careful not to let the laser beam be directed into 

the lens of the camcorder.

Fitting the zoom lens

It is important to fit the lens correctly, as 

otherwise damage may result. Be sure to refer to 

the section “Mounting and Adjusting the Lens” 

(page 41).

Viewfinder

Do not leave the camcorder with the eyepiece 

pointing directly at the sun.

The eyepiece lens can concentrate the sun’s rays 

and melt the interior of the viewfinder.

Appendix

Important Notes on 
Operation
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About the LCD panels

LCD panels are manufactured with extremely 

high-precision technology that yields effective 

pixel rates of 99.99% or higher. However, very 

rarely, one or more pixels may be permanently 

dark or permanently lit in white, red, blue, or 

green.

This phenomenon is not a malfunction. Such 

pixels have no effect on the recorded data, and the 

camcorder may be used with confidence even if 

they are present.

Phenomena specific to CMOS image 
sensors

The following phenomena that may appear in 

images are specific to CMOS (Complementary 

Metal Oxide Semiconductor) image sensors. 

They do not indicate malfunctions.

White flecks

Although the CMOS image sensors are produced 

with high-precision technologies, fine white 

flecks may be generated on the screen in rare 

cases, caused by cosmic rays, etc. This is related 

to the principle of CMOS image sensors and is 

not a malfunction.

The white flecks especially tend to be seen in the 

following cases:

• when operating at a high environmental 

temperature

• when you have raised the master gain 

(sensitivity)

• when operating in Slow-Shutter mode

The problem may be alleviated by executing 

automatic black balance adjustment.

Aliasing

When fine patterns, stripes, or lines are shot, they 

may appear jagged or flicker.

Flicker

If recording is made under lighting produced by 

discharge tubes, such as fluorescent, sodium, or 

mercury-vapor lamps, the screen may flicker, 

colors may vary, or horizontal stripes may appear 

distorted.

In such cases, set the flicker-reduction function to 

auto mode (see page 125).

If the frame rate selected for recording is close to 

the power-supply frequency, flicker may not be 

reduced sufficiently even if you activate the 

Flicker-Reduction function. In such cases, use the 

electronic shutter.

Focal plane

Owing to the characteristics of the pickup 

elements (CMOS image sensors) for reading 

video signals, subjects that quickly move across 

the screen may appear slightly skewed.

Flash band

The luminance at the top and bottom of the screen 

may change when shooting a flashlight beam or a 

light source that quickly flashes.

You can use the XDCAM EX Clip Browsing 

Software to correct clips that contain frames with 

flash bands.

Note on data compatibility with other XDCAM EX-

series products

When you use a PMW-EX1/EX3/EX30 to play 

materials recorded on the camcorder, any media 

in which clips of formats not supported by the 

PMW-EX1/EX3/EX30 have been recorded 

cannot be used.

Fragmentation

If pictures cannot be recorded/reproduced 

properly, try formatting the recording medium.

While repeating picture recording/playback with 

a certain recording medium for an extended 

period, files in the medium may be fragmented, 

disabling proper recording/storage. In such a 

case, make a backup of clips in the medium then 

perform formatting of the medium using 

OPERATION >Format Media (see page 97) in 

the setup menu.
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The camcorder’s internal clock is powered by a 

lithium battery. If the message “Back Up Battery 

End” appears in the viewfinder, this battery must 

be exchanged. Contact a Sony service 

representative.

Exchanging the Battery 
of the Internal Clock

Specifications

General

Power requirements

12 V DC (11 V to 17.0 V)

Power consumption

Approx. 18 W

Main unit (camcorder) + LCD viewfinder + auto 

focus lens + microphone

During recording, power source: battery pack

Notes

• Do not use a video light with power 

consumption of over 50 W.

• When connecting a device to the DC OUT 

connector, use one with current consumption 

of 0.5 A or more.

Operating temperature

0ºC to +40ºC (32ºF to 104ºF)

Storage temperature

–20ºC to +60ºC (–4ºF to 140ºF)

Recording/playback formats

Video

HD HQ Mode: MPEG-2 MP@HL, 35 Mbps/

VBR

1920 × 1080/59.94i, 50i, 29.97P, 25P, 

23.98P

1440 × 1080/59.94i, 50P, 29.97P, 25P, 

23.98P

1280 × 720/59.94P, 50P, 29.97P, 25P, 

23.98P

HD SP Mode: MPEG-2 MP@H-14, 25 Mbps/

CBR 

1440 × 1080 /59.94i, 50i 

(23.98P is converted to 59.94i in 2-3 pull-

down processing.)

SD Mode: DVCAM (when the optional CBK-

DV01 is installed)

720 × 480/59.94i

720 × 576/50i

720 × 480/29.97P

720 × 576/25P

Audio
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Viewfinder (supplied)

LPCM (16 bits, 48 kHz, HD: 4 channels, SD: 2 

channels)

Recording/playback time

With one SBP-32

SP mode: Approx.140 min.

HQ mode: Approx. 100 min.

DVCAM mode: Approx. 140 min.

Continuous operation time

With the BP-GL95

Approx. 310 min.

Mass

Main body only: 3.2 kg (7 lb 0.88 oz)

Dimensions

See page 160.

Supplied accessories

See page 159.

Camera Block

Pickup device

2/3-type, CMOS image sensor

Effective picture elements: 

1920 (H) × 1080 (V)

Format

3-chip RGB

Optical system

F1.4 prism system

ND filters

1: Clear

2: 1/4ND

3: 1/16ND

4: 1/64ND

Sensitivity

F12 (System frequency: 59.94i)

F13 (System frequency: 50i 

(2000lx, 89.9% reflection)

Minimum illumination

0.003 lx (F1.4, +42 dB, 64-frame accumulation)

Video S/N

56 dB (Noise Suppress Off)

59 dB (Noise Suppress On)

Horizontal resolution 

1000TV lines or more 

Gain

–3, 0, 3, 6, 9, 12, 18, 24, 30, 36, 42 dB, AGC

Shutter speed

59.94i/P, 50i/P: 1/60 to 1/2000 sec.

29.97P: 1/40 to 1/2000 sec.

25P: 1/33 to 1/2000 sec.

23.94P: 1/32 to 1/2000 sec.

Slow shutter

2 to 8, 16, 32, 64 frames

Audio Block

Sampling frequency

48 kHz

Quantization

16 bits

Headroom

20 dB (the factory default setting) 

(20, 18, 16, 12 dB)

Frequency response

MIC: 50 Hz to 20 kHz (within ±3 dB)

LINE: 20 Hz to 20 kHz (within ±3 dB)

WRR Analog: 50 Hz to 20 kHz (within ±3 dB)

WRR Digital: 20 Hz to 20 kHz (within ±3 dB)

Dynamic range

90 dB (typical)

Distortion

0.08% max. (with input level 40dBu)

Built-in speaker

Monaural

Output: 300 mW

Display

Screen size

8.8 cm diagonal (3.5-inch)

Aspect ratio

16:9

Picture elements

640 (H) × 3 × 480 (V) Sequence delta

Media Block

Card slots

Type: Express Card34

Number of slots: 2

Connector: Conforms to PCMCIA Express Card 

Standard

Writing rate
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Input/Output connectors

50 Mbps or more

Reading rate

50 Mbps or more

Inputs/Outputs

Signal inputs

AUDIO IN CH-1/CH-2: XLR type, 3-pin, 

female

–60 dBu/–4 dBu (0 dBu=0.775 Vrms)

MIC IN: XLR type, 5-pin, female

–60 dBu

GENLOCK IN: BNC type

1.0 Vp-p, 75 Ω, unbalanced

TC IN: BNC type

0.5 V to 18 Vp-p, 10 kΩ

Signal outputs

VIDEO OUT: BNC type

TC OUT: BNC type

HDMI: Type A, 19-pin

HD/SD SDI OUT 1/2: BNC type

AUDIO OUT: XLR type, 5-pin, male

0 dBu

TC OUT: BNC type

1.0 Vp-p, 75 Ω
EARPHONE (minijack)

8 Ω, –∞ to –18 dBs variable

Others

DC IN: XLR type, 4-pin, male

11 to 17 V DC

DC OUT: 4-pin

11 to 17 V DC, maximum rated current: 

0.5 A

LENS: 12-pin

Supplying power to the lens

11 to 17 V DC, maximum rated current: 

1.0 A

REMOTE: 8-pin

LIGHT: 2-pin

USB: 4-pin

i.LINK (HDV/DV): 6-pin, complies with 

IEEE1394

VF: 26-pin, rectangular, 20-pin round

For wireless receiver: 15-pin, DSUB

Lens Block (PMW-350K only)

Focal length

8 mm (11/32 inches) to 128 mm (5 1/8 inches) 

(equivalent to 31.5 mm (1 1/4 inches) to 

503 mm (19 7/8 inches) on 35 mm 

(1 7/16 inches) lens)

Zoom

Servo/Manual selectable

Zoom ratio

16×

Maximum relative aperture

1:1.9

Iris

Auto/Manual selectable

F1.9 to F16 and C (close)

Focus

Auto/Manual selectable

Ranges: 

800 mm (31 1/2 inches) to ∞ (Macro OFF)

50 mm (2 inches) to ∞ (Macro ON, Wide)

Filter thread

M82 mm, pitch 0.75 mm

Macro

ON/OFF switchable

Supplied Accessories

Viewfinder (1)

Shoulder strap (1)

Stereo microphone (1)

Windscreen (1)

Lens mount cap

Flange back adjustment chart

Auto focus lens (supplied with the PMW-350K) (1)

Operating Instructions

English version (1)

CD-ROM

- Utility Software for Solid-State Memory 

Camcorder and Recorder (XDCAM EX Clip 

Browsing Software, S×S Device Driver 

Software) (1)

- Manuals for Solid-State Memory Camcorder 

(PDF Operating Instructions and Supplement) 

(1)

S×S Device Driver Software End-User License 

Agreement (1)



Specifications160

A
p

p
e
n

d
ix

DVCAM Record and Playback Option

Power supply and related equipment

Lens, Viewfinder and Related Equipment

Note

The viewfinder able to use the BKW-401 is DXF-20W 

besides the supplied camcorder.

Equipment for remote control

Media

Audio equipment

Other peripheral devices

Equipment for maintenance and easier handling

Dimensions 

Design and specifications are subject to change 

without notice.

Recommended Additional 
Equipment

SD Record and Playback Key

CBK-DV01

AC Adaptor

AC-DN10/DN2B

Battery Pack

BP-GL95/GL65/L80S/L60S

Battery Charger

BC-M150/L500/L70

Lens

2/3-type bayonet mount lenses only

Viewfinder

DXF-20W/51

Viewfinder Rotation Bracket

BKW-401

Remote Control Unit

RM-B150/B750

S×S Memory Card

S×S PRO SBP-8 (8 GB)

S×S PRO SBP-16 (16 GB)

S×S PRO SBP-32 (32 GB)

S×S-1 SBS-32G1 (32 GB)

Hard Disk Unit

PHU-60K/120K/120R

Media Adaptor

MEAD-MS01

Microphone

ECM-678/674/673/680S

Microphone Holder

CAC-12 compatible

Wireless Microphone

DWR-S01D

WRR-855S/860A/861/862

Tripod adaptor

VCT-14/U14

Video Light

Ultralight (Anton Bauer)

Pad

CBK-SP01 DynaFit Shoulder Pad (soft type)

Hard Carrying Case

LC-H300

Soft Carrying Case

LC-DS300SFT

Maintenance Manual

(in mm (inches))
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Notes

• Always make a test recording, and verify that it was 

recorded successfully.

SONY WILL NOT BE LIABLE FOR DAMAGES 

OF ANY KIND INCLUDING, BUT NOT 

LIMITED TO, COMPENSATION OR 

REIMBURSEMENT ON ACCOUNT OF 

FAILURE OF THIS UNIT OR ITS RECORDING 

MEDIA, EXTERNAL STORAGE SYSTEMS OR 

ANY OTHER MEDIA OR STORAGE SYSTEMS 

TO RECORD CONTENT OF ANY TYPE.

• Always verify that the unit is operating properly 

before use. SONY WILL NOT BE LIABLE FOR 

DAMAGES OF ANY KIND INCLUDING, BUT 

NOT LIMITED TO, COMPENSATION OR 

REIMBURSEMENT ON ACCOUNT OF THE 

LOSS OF PRESENT OR PROSPECTIVE 

PROFITS DUE TO FAILURE OF THIS UNIT, 

EITHER DURING THE WARRANTY PERIOD 

OR AFTER EXPIRATION OF THE 

WARRANTY, OR FOR ANY OTHER REASON 

WHATSOEVER.
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Chart of Optional Components and Accessories

a) The PMW-350L requires a separately sold lens.

b) The carrying case is large enough to hold the camcorder with lens and microphone mounted. However, 

remove them if they protrude more than 25 cm (9 7/8 inches) from the front of the main unit.

ECM-680S/678/
674/673 
Microphone

CAC-12 
Microphone Holder

DXF-51 
Viewfinder

HD monitor/SD monitor

XDCAM HD series recorder
PDW-F1600/HD1500, PDW-F75

HDCAM series recorder
HDW-2000 series recorder, HDW-S280

WRR-855S UHF Synthesized Tuner Unit
WRR-860A/861/862 UHF Synthesized Diversity Tuner
DWR-S01D Digital Wireless Receiver

PMW-350 a)

RM-B150/B750
RCP-730/750/751/920/921
MSU-900/950/700
Remote Control Unit

VCT-14/U14 

Tripod adaptor

Tripod

LC-DS300 SFT b) 
Soft carrying case

AC-DN10/DN2B 
AC Adaptor

BC-L500 Battery 
Charger

BC-M150 
Battery 
Charger

BC-L70 
Battery 
Charger

BP-GL95/GL65/L80S/
L60S 
Battery Pack

SBP-8/16/32
SBS-32G1
S×S memory card

PHU-60K/120K/120R 
Professional Hard Disc Unit

LC-H300 
Hard carrying case

DXF-20W 
Viewfinder

CBK-DV01 SD Record and Playback Key

MEAD-MS01 Media Adaptor
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This section explains the specifications and 

features of i.LINK.

What is i.LINK?

i.LINK is a digital serial interface designed to 

integrate devices equipped with i.LINK 

connectors. i.LINK allows your device to:

• Perform two-way transmission and reception of 

data such as digital audio and digital video 

signals.

•  Control other i.LINK devices.

•  Easily connect multiple devices with a single 

i.LINK cable.

Your i.LINK device is capable of connecting to a 

wide range of digital AV devices for data transfer 

and other operations.

Other advantages include the following feature. 

When connected to multiple i.LINK devices, 

your i.LINK device can perform data transfer and 

other operations not only

with the directly connected devices but also with 

any of the devices that are connected to those 

devices. Therefore, you do not need to be 

concerned with device connection order.

However, depending on the features and 

specifications of the connected devices, you may 

need to use certain functions differently, and you 

may not be able to transfer data or perform certain 

operations.

i.LINK, a nickname for IEEE 1394 proposed by 

Sony, is a trademark supported by many 

companies worldwide.

IEEE 1394 is an international standard defined by 

IEEE, the Institute of Electrical and Electronics 

Engineers, Inc.

Note

The camcorder can be connected to one device 

with the i.LINK cable (DV cable). When you 

connect with an HDV or DV device that has two 

or more i.LINK connectors, refer to the

operating instructions supplied with the 

connected device.

About data transfer speed of i.LINK

i.LINK defines a maximum data transfer speed of 

approximately 100, 200 and 400 Mbps 1) that are 

described as S100, S200 and S400 respectively.

For i.LINK devices, a maximum data transfer 

speed that the device supports is identified on 

“Specifications” page of the operating 

instructions supplied with the device or near its 

i.LINK connector.

1) When connecting with the device that support 

different data transfer speed, the actual data transfer 

speed may be different from those described on the 

i.LINK connectors.

What is Mbps?

Mega bits per second. A measure of the rate at 

which data is transmitted per second. In case of 

100 Mbps, 100 Mega bits of data can be 

transmitted per second.

i.LINK operation with your camcorder

For details on operation when other equipment 

with i.LINK (HDV or DV) connector is 

connected, see page 144.

For details on connection with i.LINK cable and 

necessary software, refer to the operating 

instructions supplied with the connected device.

About the required i.LINK cable

Use the Sony 6-pin-to-4-pin or 6-pin-to-6-pin 

i.LINK cable to connect the i.LINK devices.

i.LINK and  are trademarks.

About i.LINK
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ANY USE OF THIS PRODUCT OTHER THAN 

CONSUMER PERSONAL USE IN ANY 

MANNER THAT COMPLIES WITH THE 

MPEG-2 STANDARD FOR ENCODING 

VIDEO INFORMATION FOR PACKAGED 

MEDIA IS EXPRESSLY PROHIBITED 

WITHOUT A LICENSE UNDER 

APPLICABLE PATENTS IN THE MPEG-2 

PATENT PORTFOLIO, WHICH LICENSE IS 

AVAILABLE FROM MPEG LA, L.L.C., 250 

STEELE STREET, SUITE 300, DENVER, 

COLORADO 80206.

“PACKAGED MEDIA” means any storage 

media storing MPEG-2 video information such as 

DVD movie which are sold/distributed to general 

consumers. Disc replicators or sellers of the 

PACKAGED MEDIA need to obtain licenses for 

their own business from MPEG LA. Please 

contact MPEG LA for any further information. 

MPEG LA. L.L.C., 250 STEELE STREET, 

SUITE 300, DENVER, COLORADO 80206

http://www.mpegla.com

MPEG-2 Video Patent 
Portfolio License
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A

AC power    34

ACCESS lamps    20, 23

Accessories (optional)    162

ALARM knob    17

Area setting    40

Arrow buttons (K, k, J, j)    21

ASSIGN. 0 switch    18

ASSIGN. 1/2/3 switches    17

ASSIGNABLE 4/5 switches    23

Assignable switches, assigning functions    131

ATW (Auto Tracing White Balance)    18

Audio control section    21

AUDIO IN CH1/CH2 connectors    24

AUDIO IN CH-1/CH-2/CH-3/CH-4 

switches    22

AUDIO IN selectors    24

Audio input system    43

Audio level

adjusting    60

adjusting playback level    17

meters    31

AUDIO OUT connector    24

AUDIO SELECT CH-1/CH-2 switches    22

AUTO W/B BAL switch    16

B

BACKLIGHT button    21

Battery

attachment shoe    14

of the internal clock, exchanging    157

pack    33

remaining    30

BKW-401    37

Black balance, adjusting    51

BRIGHT control    28

C

Clip(s)

batch copy    88

copying    87

cue up    83

deleting    73, 88

displaying properties    86

dividing    91

operating with a computer    142

operations    80

playing    72, 82

selecting    82

Clock setting    41

Color LCD    19

COLOR TEMP. button    17

Color temperature    30

Computer, connecting    142

Connection    140

computer    142

monitors    140

using i.LINK    144

using USB    142

CONTRAST control    28

Cover    19

D

Date, setting    41

DC IN connector    14

DC OUT 12V connector    14

DCC (Dynamic Contrast Control)    18

Depth of field    30

Diopter adjustment ring    27

DISPLAY switches    21, 28

E

EARPHONE jack    24

EJECT buttons    23

Electric color temperature filter    31

ESSENCE MARK button    22

EXPAND button    20

Expand thumbnail screen

displaying    88

to increase the number of divisions    89

Extender    29

External devices    140

control    31

External input    31

External power source    30

Eyecup    27

Index
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F

F FWD button/indicator    20

F REV button/indicator    20

FILTER selector    16

Fitting for optional microphone holder    15

Flange focal length, adjusting    26, 42

Focus

adjusting    58

adjustment mode    30

position    29

ring    26

FOCUS switch    26

Frame Rec    77

Framing shots    79

Freeze Mix    79

F-RUN/SET/R-RUN switch    21

G

GAIN selector    18

Gain value    31

GENLOCK IN connector    23

Green tally    29

H

HD/SD SDI OUT connector    24

HDMI output connector    23

Histogram    31

HOLD button    20

I

i.LINK    163

cable    163

connection    144

i.LINK (HDV/DV) connector    25

Index picture    81

changing    90

Initial value    95

Input source    31

Internal clock    41

Interval Rec    75

Iris

position    31

ring    26

IRIS switch    27

L

LCD panel    19

Lens

cable clamp    15

locking lever    15

mount    15

mount cap    15

mount securing rubber    15

mounting    41

LENS connector    15

Lens file(s)

loading    138

loading automatically    139

saving    138

setting data    138

LEVEL CH-1/CH-2/CH-3/CH-4 knobs    22

LIGHT connector    15

Light fitting shoe    14

LIGHT switch    14

M

MACRO switch    26

Maintenance    147

Media

remaining capacity    31

status    29

MENU button    21

MENU CANCEL/PRST/ESCAPE switch    18

MENU knob    16

MENU ON/OFF switch    18

MIC IN (+48 V) connector    15

MIC LEVEL control    16

Microphone holder    28

fitting    15

Microphone, connecting    43

MIRROR switch    28

MONITOR knob    17

MONITOR switches    17

Monitor, connecting    140

Monochrome LCD Panel    25

N

ND filter    16, 31

NEXT button    20

Nonlinear editing    144, 145

Number of system lines    30
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O

OK mark(s)    81, 86

adding    87

deleting    87

setting    73

Operation status    29

of i.LINK device    31

Optional components    162

OUTPUT/DCC switch    18

P

PEAKING control    28

Picture Cache    74

PLAY/PAUSE button/indicator    20

Plug    27

Power source voltage/battery remaining 

capacity    30

Power supply    33

POWER switch    14

Preset values, resetting    136

PRESET/REGEN/CLOCK switch    22

PREV button    20

PUSH AF button    26

PUSH AUTO button    27

R

REC START button    16

Recording

external input signals    145

from pre-stored video    74

on an external device    144

remaining time    70

review    72

time-lapse video    75

Recording mode    29

special settings indication    30

REMOTE connector    25

Reset    95, 136

RESET/RETURN button    20

RET button    27

S

S×S Device Driver Software    12

S×S memory card slots    23

S×S memory cards    67

ejecting    69

formatting    69

loading    68

restoring    70

selecting    69

Scene files

loading    137

saving    137

Search

with the expand thumbnail screen    83

with the shot mark thumbnail screen    83

SET button    21

Setup menu    92

basic operations    94

FILE menu    127

MAINTENANCE menu    115

menu list    96

OPERATION menu    96

PAINT menu    109

SHIFT button    22

Shooting    67

basic operations    71

stop motion animations    77

with Slow & Quick motion    78

Shot mark thumbnail screen    89

Shot mark(s)

adding    90

adding during playback    83

deleting    90

recording    73

Shoulder pad    15

adjusting the position    49

Shoulder strap fitting    14

Shoulder strap, using    48

Shutter

setting    55

speed    31

SHUTTER selector    16

Slot cover    23

SLOT SELECT button    23

Speaker    19

Specifications    157

Status information    65

STATUS ON/SEL/OFF switch    18

Status screens    65

ASSIGN SWITCH    65

AUDIO    65

BATTERY/MEDIA    66

CAMERA    65

VIDEO    65

STOP button    20
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Stopper    27

T

TALLY indicators    24

Tally indicators    28

TALLY switch    24, 28

TC IN connector    24

TC OUT connector    24

TCLS automatic adjustment    57

Testing    147

THUMBNAIL button    21

THUMBNAIL indicator    21

THUMBNAIL menu    84

operations    85

Thumbnail screen    80

displaying OK clip thumbnails only    85

displaying the all clips thumbnail    85

Thumbnail(s)

changing the screen type    85

operations    84

Time, setting    41

Timecode    31

setting    62

synchronizing    63

TLCS control mode    30

Tripod mount    15

Tripod, mounting    46

U

UHF portable tuner, attaching    45

USB connection    142

USB connector    23

User bits setting    63

User setting data

loading    136

saving    135

V

VF connector    15

Video format    30, 87

setting    50

Video level indication    31

Video light, connecting    47

VIDEO OUT connector    24

Viewfinder    27

adjusting focus    37

adjusting position    35

adjusting screen    37

adjusting the angle    36

attaching    35

attaching a 5-inch viewfinder    38

cable    28

cleaning    147

connectors    15

fitting shoe    15

positioning knob    15

positioning lever    15

positioning ring    15

raising up the barrel and eyepiece    36

screen display    29

Voltage capacity    30

W

WARNING indicator    20

Warnings    148

WHITE BAL switch    18

White balance memory    31

White balance, adjusting    52

Wireless microphone reception level    30

X

XDCAM EX Clip Browsing Software    12, 

143

XDCAM EX web sites    12

Z

ZEBRA switch    28

Zoom    58

control connector    26

position    29

power zoom lever    27

ring    26

ZOOM switch    26
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